
To flip a sprite
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Flip tools

(Click graphic to view example)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to flip.
3 In the Flip box, click the appropriate button to orient your sprite the way you want.



To rotate a sprite to preset angles
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Preset Rotation tools

(Click graphic to view example)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to rotate.
3 In the Rotate box, click the Rotate Right 90, Rotate Left 90, or Rotate 180 button.



To specify the angle of rotation
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Rotate tools

(Click graphic to view example)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to rotate.
3 In the Rotation box, select the current degree value and then type the value you want or click the 

arrows to select a new value. For example, if you want to rotate the current sprite 90 degrees, 
change the value to 90.

4 Click Apply.



To scale a sprite
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Scaling Tools

(Click graphic to view example)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to scale.
3 To maintain the sprite’s width with respect to its height as you scale it, select the Keep Aspect 

Ratio check box.
4 In the Width and Height boxes, type the number of pixels you want to indicate the height and 

width, or click the arrows to select a new number, then click Apply.

Note      In the Units list, you can choose either Pixels or Percent. If you choose Pixels, the current 
pixel value appears in the Width and Height boxes. If you choose Percent, the values in the Width 
and Height boxes change to 100, which is the default value.



To crop a sprite
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Crop tool

(Click graphic to view example)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to crop.
3 Click Crop/Extend in the left section of the tool palette.
4 Drag the cropping handles to the location you want. The bounding box is resized, but the scale of 

the sprite remains unchanged.



To align a sprite with another sprite
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Align tools

(Click graphic to view example)

The Align tool on the Arrange palette contains ten methods to align sprites: Tops, Bottoms, Left 
Sides, Right Sides, Upper Left Corners, Upper Right Corners, Lower Left Corners, Lower Right 
Corners, Centers Horizontally, and Centers Vertically.

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite that you want to align with another sprite.
3 Click the alignment method you want on the Align tool.
4 If a Microsoft Image Composer Hint dialog box appears, click OK.
5 Click the sprite you want the current sprite to be aligned with.

Tip      There is also an Abut tool to the right of Align. You can use Abut to join the edges of two 
sprites.



To align more than one sprite with another sprite
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Align tools

(Click graphic to view example)

The Align tool on the Arrange palette contains ten methods to align sprites: Tops, Bottoms, Left 
Sides, Right Sides, Upper Left Corners, Upper Right Corners, Lower Left Corners, Lower Right 
Corners, Centers Horizontally, and Centers Vertically.

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Press and hold SHIFT and click the sprites that you want to align with another sprite.
3 Click the alignment method you want on the Align tool.
4 If a Microsoft Image Composer Hint dialog box appears, click OK.
5 Click the sprite you want the current sprites to be aligned with.

Tip      There is also an Abut tool to the right of Align. You can use Abut to join the edges of two 
sprites.



Working with the Selection Model
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The Selection Model allows you to arrange a sprite or group of sprites, regardless of whether the 
Arrange palette is active.

When you want to apply any action to a sprite, you first must select it. The selected sprite is also 
known as the current sprite. The Selection Model is active on the current sprite.

No matter which tool palette is selected, the current sprite’s bounding box always appears with a 
small box, or handle, at each corner and in between corners.

When you drag one of these handles, you alter the scale or rotation of the current sprite. The pointer 
also changes when you move it over a handle.

For example:

Move the pointer over
this handle

The pointer changes
to this

Allowing you to do
this

Rotate a sprite

Broaden a sprite

Expand a sprite
vertically and/or

horizontally

Tip      To maintain the current sprite’s aspect ratio when you scale it, press SHIFT as you drag a corner 
handle.

Note      Operations that can be applied to a single sprite or selection set cannot be applied to groups.



To group sprites
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Group, Ungroup, Explode, and Flatten tools

Grouped sprites are treated as a single sprite by the functions that position or arrange a sprite within 
a composition, and you can arrange the layered order of sprites from front to back in the stack. 
Additionally, sprites that are already grouped can be placed in a larger group. Functions that alter the 
appearance of a sprite, however, cannot be used on a group.

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Press and hold SHIFT, and then click the sprites you want to group.
3 Click Group.

Tip      While similar, grouped sprites and selection sets have significant differences. Selection sets are
maintained until you click another sprite. Grouped sprites are maintained until you choose to separate
them with Ungroup.



To explode a group
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Group, Ungroup, Explode, and Flatten tools

Explode is like Ungroup, except that all levels of subgroups in the current group are ungrouped, 
leaving individual sprites in a selection set.

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click on the selection set, or group, of sprites you want to explode.
3 Click Explode.



To flatten a selection
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Group, Ungroup, Explode, and Flatten tools

Flatten creates a single raster image, or sprite, out of all the sprites in a group or selection set. You 
should remember, however, that once a selection set or group of sprites is flattened, you can only 
reverse the command if you click Undo before you proceed with any other actions in Microsoft Image 
Composer. Otherwise, this command is permanent.

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click on the selection set, or group, of sprites you want to flatten.
3 Click Flatten.



To change the order of the stack
{button ,AL("A_ARRA
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Order tools

(Click graphic to view examples)

1 Click Arrange on the toolbox to activate the Arrange palette.
2 Click the sprite you want to move within the stack.
3 In the Order tools, click the appropriate tool on the align graphic to move the position of the current

sprite in the stack.

Tip      You can move the pointer over Order tools to view ToolTips that identify what each one does.



To set home position
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Home tools

Set Home Position stores the screen position of the current sprite or group so that you can restore it 
with the Return to Home Position tool. A home position is stored with each sprite when it is created 
or loaded. When you click Set Home Position, you update the home position of the sprite or group.

· Move the sprite you want to the location in the composition you want, then click Set Home 
Position.

Tips
· You can store a single screen position with each sprite in your composition, but each time you click

Return to Home Position, the previously stored position for the current sprite is replaced by the 
current position.

· If you subsequently make a sprite part of a group, the screen position of the group is used instead 
of that of the sprite.

· You can store the individual screen positions of several sprites at once by first placing them in a 
selection set.

· You can lock a sprite's position in the composition by clicking Lock Position. The sprite will stay 
locked in place until you click Lock Position again to unlock it.



Arranging Sprites Overview
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Arrange palette

You can use the tools on the Arrange palette to crop, extend, scale, rotate, duplicate, flip, and align 
selected sprites. You can create selection sets to which you can apply effects as though they were 
individual sprites. You can also create groups. Grouped sprites are somewhat like selection sets in 
that you can move and position sprites as a single image. With groups, however, you cannot perform 
functions that alter the appearance of a sprite as you can with selection sets.



To ungroup sprites
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Group, Ungroup, Explode, and Flatten tools

Ungroup separates grouped sprites and places them in a selection set. If the group consists of 
smaller groups, only one level is ungrouped.

· Click the group of sprites you want to ungroup, and then click Ungroup.



To fit the bounding box
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Fit Bounding Box tool

(Click graphic to view example)

Fit Bounding Box automatically adjusts the size of the bounding box to fit tightly to the shape 
boundaries of the current sprite or selection set. The shape of a sprite is defined by its non-
transparent pixel.

When you perform a Fit Bounding Box operation on a single sprite, it tightens the bounding box 
around the sprite to include only the sprite's pixels. When you perform the operation on a selection set
of sprites, each is cropped to the size of its shape.

· Click the sprite or selection set on which you want to fit the size of the bounding box, and then click
Fit Bounding Box.



Before Flip Flipped Vertical Flipped Horizontal



Before Rotation Rotate Right 90 Rotate Left 90



Before Rotation Negative Rotation Positive Rotation



Before Scaling After Scaling



Before Crop After Crop
                            



Before Align After Align



Before Align Centered Vertically Bottoms Aligned



Order
1. Red Circle
2. Purple Square
3. Yellow Triangle

Order
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Order
1. Yellow Triangle
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Before Fit Bounding Box is
applied

After Fit Bounding Box is
applied



Paste command
Inserts the contents of the Clipboard in the upper left corner of the composition.



Cut command
Removes the selected sprite or sprites and places them on the Clipboard.



Copy command
Copies the selected sprite or sprites onto the Clipboard.



Duplicate command
Creates a copy of the current sprite or sprites and places them in front of the original sprite or sprites 
at a slight offset.



Delete command
Removes the selected sprite or sprites from the composition.



Undo command
Cancels the last command or effect. The command changes to Can’t Undo if you can’t undo the 
previous command or effect.



Select All command
Selects all the sprites in the composition.



Clear Selection command
Removes the selected status of all sprites in a composition so that there is no selected sprite.



Copy Channel Red command
Copies the red channel of the selected sprite to the Clipboard.



Copy Channel Green command
Copies the green channel of the selected sprite to the Clipboard.



Copy Channel Blue command
Copies the blue channel of the selected sprite to the Clipboard.



Copy Channel Alpha command
Copies the alpha channel of the selected sprite to the Clipboard.



Paste Channel Red command
Pastes the channel of the sprite that is on the Clipboard into the red channel of the currently selected 
sprite.



Paste Channel Green command
Pastes the channel of the sprite that is on the Clipboard into the green channel of the currently 
selected sprite.



Paste Channel Blue command
Pastes the channel of the sprite that is on the Clipboard into the blue channel of the currently selected
sprite.



Paste Channel Alpha command
Pastes the channel of the sprite that is on the Clipboard into the alpha channel of the currently 
selected sprite.



Broadcast Channel Red command
Replaces all color channels of the current sprite with the red channel of that sprite.



Broadcast Channel Green command
Replaces all color channels of the current sprite with the green channel of that sprite.



Broadcast Channel Blue command
Replaces all color channels of the current sprite with the blue channel of that sprite.



Broadcast Channel Alpha command
Replaces all color channels of the current sprite with the alpha channel of that sprite.



Properties command
Displays the Sprite Properties dialog box for the selected sprite or sprites. For single sprites, 
displays information about    the selected sprite. For multiple selections, displays information about the
temporary selection set. If no sprites are selected, displays the Composition Properties dialog box, 
which contains information about the composition.



New command
Creates a new composition in a new workspace window. If a composition is currently open, displays a
prompt asking if you want to save it. The composition guide defaults are applied to set the size and 
color of the new composition guide.



Open command
Opens an existing file. The file can be a Microsoft Image Composer composition file (.mic) or any of 
the other supported formats. If a composition is currently open, displays a prompt asking if you want 
to save it.



Close command
Closes the current composition and displays a prompt asking if you want to save the composition.



Save command
Saves the current composition to its current file name, location, and file format.



Save As command
Saves the current composition with the file name, location, and file format you specify.



Save Selection As command
Saves the currently selected sprite with the file name, location, and file format you specify. This 
command is available only for single sprites.



Save Copy As command
Saves the current composition to a particular file format and maintains the current composition in its 
current state. The title of the current composition does not change when this command is used.



Composition Properties command
Displays the Composition Properties dialog box, which shows the current composition’s color 
information and size in pixels, and the composition guide color. You can edit the composition’s size 
and modify the composition guide color. These modifications take effect when you click OK. You can 
click the name of any the sprites in the composition to see information on that sprite.



Select Scan Source command
Selects the default TWAIN source for the scanner you have selected.



Acquire Scan command
Acquires an image from the selected TWAIN source.



Print command
Displays the Print dialog box, which contains printing options and allows you to print the current 
composition or view.



Print Setup command
Changes paper size, paper source, page orientation, or properties for all printing operations.



Most Recently Used File command
Lists the compositions that were most recently saved with the last composition saved as first entry in 
the list.



Exit command
Closes Microsoft Image Composer and prompts you to save the current composition.



Send command
Sends a composition in an email message. Saves the current state of the composition to a temporary 
file using the options you set when the composition was last saved, including file type and other 
settings.



Save dialog boxes
For help on this dialog box, click the Image Composer-specific control you want help on and press F1.



Open dialog box
For help on this dialog box, click the Microsoft Image Composer specific control you want help on and
press F1.



Hint dialog box
Click OK and perform the action specified in this Hint dialog box.



Zoom In
Enlarges the composition view.



Zoom Out
Shrinks the composition view.



Actual Size
Resets the image in the active view    window to 100 percent of its original size.



Color Format
Displays the color palettes available for a composition. The list includes any custom color palettes 
available for the current composition.



Zoom Percent
Displays the range of zoom percentages for the composition view. At zoom percentages greater than 
100 percent, individual pixels become apparent, leading to a jagged appearance. Also, a sprite might 
appear to move out of the workspace view, requiring you to scroll to see some areas of the sprite. At 
zoom percentages less than 100 percent, differing opacities of border pixels make a sprite's edges 
appear smooth.



Toggle Palette View
Displays or hides the active tool palette.



Go To Composition Guide
Positions the composition guide in the top-left corner of the active view window.



Center On Selection
Repositions the selection in the center of the active view window.



Toolbar
Displays or hides the toolbar.



Toolbox
Displays or hides the toolbox.



Color Picker
Displays or hides the Color Picker dialog box, which enables you to select a color.



Status Bar
Displays or hides the status bar.



Arrange
Displays the Arrange tool palette.



Paint
Displays the Paint tool palette.



Text
Displays the Text tool palette.



Shapes
Displays the Shapes - Geometry tool palette.



Patterns and Fills
Displays the Patterns and Fills tool palette.



Warps and Filters
Displays the Warps and Filters tool palette.



Art Effects
Displays the Art Effects tool palette.



Color Tuning
Displays the Color Tuning - Color Shifting tool palette.



Zoom
Switches Microsoft Image Composer to zoom mode, so that you can enlarge or shrink the 
composition view.

To enlarge the composition view
· On the Tools menu, click Zoom, and then click anywhere in the view window.

To shrink the composition view
· On the Tools menu, click Zoom, and then hold down CTRL and click anywhere in the view window.



Pan
Switches Microsoft Image Composer to pan mode, so that you can reposition your work in the active 
view window.



Color Picker
Displays the Color Picker dialog box, which you use for setting the current color or creating a custom
color. The Color Picker has two tabbed dialogs: True Color or Custom Palette. The current tab is 
the tab most recently used.



Options
Displays the Options dialog box.



Color Swatch
Displays the Color Picker dialog box for setting the current color or creating a custom color. The 
Color Picker has two tabbed dialogs: True Color or Custom Palette. The current tab is the tab most 
recently used. You can drag and drop colors from the Color Swatch to and from smaller color 
swatches on the tool palettes.



View True Color
Displays a composition in True Color format.



View Balanced Ramp
Displays a composition in Balanced Ramp format.



View Grayscale
Displays a composition in Grayscale Ramp format.



View Black and White
Displays a composition in Black and White format.



View User-Defined Palette
Displays a composition in a custom palette format created by a user.



Zoom to 50%
Displays a composition as 50% of its actual size.



Toolbars
Displays the Toolbars dialog box which you can use to hide or display the Toolbar, Toolbox, Color 
Swatch, and Status Bar.



Repeat Last Plug-In command
Loads the plug-in you most recently loaded. This command is available only when a sprite is selected.



Impressionist command
Loads the Impressionist plug-in. This command is available only when a sprite is selected.



New Window command
Opens a new window with the same contents as the active window.



Cascade command
Arranges windows in a cascade formation so that the windows overlap one another with the title of 
each window showing.



Tile command
Arranges windows in a tile formation so that the windows are truncated.



Arrange Icons command
Arranges all window icons along bottom edge of current view window.



Most Recent Window command
Switches to the composition and makes it active.



Microsoft Image Composer Help Topics 
Displays the Microsoft Image Composer help dialog box, including tabs for Contents, Index, and 
Find.



Microsoft Image Composer Home Page
Connects to the Image Composer home page on the World Wide Web: 
http://www.microsoft.com/imagecomposer/.



Web Directory
Connects your web browser to the Microsoft Web directory: 
http://home.microsoft.com/lookup/services.asp.



Search the Web
Connects your web browser to the Microsoft Web Search page: 
http://www.msn.com/access/allinone.asp.



Web Tutorial
Connects your web browser to the Microsoft Web Tutorial page: 
http://home.microsoft.com/tutorial/default.html.



Microsoft Home Page
Connects your web browser to the Microsoft Home page: www.microsoft.com.



About Microsoft Image Composer
Displays information about your copy of Microsoft Image Composer, including the version number, 
and the copyright, legal, and licensing notices.



Select Font button
Displays the Font dialog box.



Text edit box
Allows you to type up to 80 characters. You can apply the characters to create a text sprite by clicking
the Apply button. The characters remain in the edit box until you replace or delete them. You can edit 
the text string in this box only.



Font Type box
Displays the name of the font chosen for a text sprite.



Font Size box
Displays the size of the font chosen for a text sprite.



Font Style box
Displays the style of the font chosen for a text sprite.



Font Preview box
Displays a sample of the text that is in the edit box in the chosen font.



Apply Button
Creates a text sprite consisting of the text in the edit box in the chosen font.



Bring to Front
Moves the current sprite to the top of the stack.



Send to Back
Moves the current sprite to the bottom of the stack.



Bring Forward
Moves the current sprite one level forward in the stack.



Send Backward
Moves the current sprite one level back in the stack.



Rotate Right 90
Rotates the current sprite 90 degrees to the right.



Rotate Left 90
Rotates the current sprite 90 degrees to the left.



Rotate 180
Rotates the current sprite 180 degrees, inverting it from its previous position.



Flip Horizontal
Flips the current sprite on a horizontal axis.



Flip Vertical
Flips the current sprite on a vertical axis.



Flip Both
Flips the current sprite both vertically and horizontally.



Group
Collects all currently selected sprites into a group. Grouped sprites are treated as a single sprite by 
the functions that position or arrange a sprite within a composition.



Ungroup
Separates grouped sprites and places them in a selection set. If the current group consists of smaller 
groups, only one group is ungrouped. You can ungroup another level each time Ungroup is selected.



Color Shifting
Displays controls for adjusting hue, saturation, brightness, and contrast.



Highlight/Shadow
Displays controls that you can use to alter the highlights, midtones, and shadows of the current sprite.



Dynamic Range
Displays controls that you can use to adjust the dynamic range of the current sprite’s pixels.



All channels
Specifies that all channels (red, green, and blue) are modified when altering the hue, saturation, 
brightness, or contrast properties of the current sprite.



Red channel
Specifies that the red channel is modified when altering the hue, saturation, brightness, or contrast 
properties of the current sprite.



Green channel
Specifies that the green channel is modified when altering the hue, saturation, brightness, or contrast 
properties of the current sprite.



Blue channel
Specifies that the blue channel is modified when altering the hue, saturation, brightness, or contrast 
properties of the current sprite.



Brightness box
Specifies the percentage of increase or decrease of brightness that can be applied to the current 
sprite.



Brightness slider
Adjusts the amount of brightness that can be applied to the current sprite.



Contrast slider
Adjusts the amount of contrast that can be applied to the current sprite.



Contrast box
Specifies the percentage of increase or decrease of contrast that can be applied to the current sprite.



Hue slider
Adjusts the amount of color hue that can be applied to the current sprite.



Hue box
Specifies the percentage of increase or decrease of color hue that can be applied to the current 
sprite.



Saturation slider
Adjusts the color saturation that can be applied to the current sprite.



Saturation box
Specifies the percentage of increase or decrease of color saturation that can be applied to the current
sprite.



All channels
Specifies that all channels (red, green, and blue) are modified when altering the shadows, midtones, 
and highlights of the current sprite.



Red channel
Specifies that the red channel is modified when altering the shadows, midtones, and highlights of the 
current sprite.



Green channel
Specifies that the green channel is modified when altering the shadows, midtones, and highlights of 
the current sprite.



Blue channel
Specifies that the blue channel is modified when altering the shadows, midtones, and highlights of the
current sprite.



Curves window
Displays a diagonal line or lines with shadow intensity, midtone intensity, and highlight intensity 
handles. Each handle can be dragged upward to increase intensity, or downward to decrease 
intensity.



High Output Range box
Displays the highest pixel intensity setting for the current sprite.



Low Output Range box
Displays the lowest pixel intensity setting for the current sprite.



Histogram window
Graphically displays the dynamic range settings of the current sprite. The horizontal axis represents 
the range of intensity from the lowest setting on the left side of the window, to the highest setting on 
the right side of the window. The vertical axis represents the number of pixels and their given intensity
levels.



Enlarge Histogram
Increases the vertical scale of the histogram.



Reduce Histogram
Reduces the vertical scale of the histogram.



Auto Maximize
Moves the vertical bars in the Histogram window to the borders of the histogram to take advantage 
of the dynamic range of the current sprite.



Apply
Applies all of the changes made on the Color Tuning tool palette, from the Color Shifting, 
Highlight/Shadow, and Dynamic Range groups, simultaneously to the selected sprite.



Reset
Resets all of the Color Shifting, Highlight/Shadow, or Dynamic Range setting to their original 
values and reverts the selected sprite to its original state.



Paintbrush Selection grid
Displays a set of standard paintbrushes. To design custom paintbrushes, double-click on a paintbrush
to open the Brush Designer dialog box.



Paintbrush size slider
Adjusts the size of the selected paintbrush. Move the slider left to decrease paintbrush size and right 
to increase paintbrush size.



Paintbrush size box
Displays the pixel size value of the current paintbrush. To change the value, select the current value 
and type a new number or click the arrows to set a new value.



Paintbrush display box
Displays the size and type of paintbrush selected.



Sticky check box
Maintains the current tool selection as you move from one sprite to the other.



Radius Factor (%) box
Specifies the percentage of pixels in the current sprite that will be scaled into the Mesa portion of a 
warp. To change the value, select the current value and type a new number or click the arrows to set 
a new value.



Warp Direction In option
Specifies a concave effect on the selected area of the current sprite.



Warp Direction Out option
Specifies a convex effect on the selected area of the current sprite.



Angle box
Specifies the value for the angle of twist in the selected area of the of the current sprite. To change 
the value, select the current value and type a new number or click the arrows to set a new value.



Value box
Specifies the percentage value of the current sprite that will be affected by the Spoke Inversion 
effect. For example, at a value of 33 percent, the effect will be applied to the inner third of the selected
portion of the current sprite before it is inverted. To change the value, select the current value and 
type a new number or click the arrows to set a new value.



Paintbrush button
Creates a paintbrush stroke effect as you drag the pointer.



Airbrush button
Creates an airbrush stroke effect as you drag the pointer.



Pencil button
Draws a pencil-like stroke as you drag the pointer.



Smear button
Smears the colors of the current sprite as you drag the pointer across it.



Impression button
Creates a smudged, impressionistic effect as you drag the pointer.



Erase button
Turns the current paintbrush into an eraser, turning the pixels transparent as you drag the pointer 
across the current sprite.



Tint button
Uses the current paintbrush to apply a translucent wash of the current color to the current sprite as 
you drag the pointer across it.



Colorize button
Uses the current paintbrush to apply the current color without affecting the dark and light intensity 
values of the current sprite.



Dodge and Burn button
Lightens or darkens the area of the current sprite when the current brush is dragged across it. When 
this button is selected, you can adjust the Dodge/Burn slider to set the lightness or darkness of the 
effect.



Contrast button
Adjusts the contrast of the area on the current sprite where the current paintbrush is dragged.



Rubber Stamp button
Copies the non-transparent pixels from one area to another using a fixed source area. The size of the 
source area is defined by the size of the current paintbrush.



Transfer button
Copies pixels from one area to another, while maintaining the relative offset of the source and 
destination areas.



Mesa button
Causes the pixels of the current sprite to appear to be wrapped around a truncated cone pointing out 
of or into the shape of the current brush.



Vortex button
Twists the pixels of the current sprite around the center of the current brush while maintaining the 
orientation of the pixels at its borders.



Spoke Inversion button
Inverts every spoke of an imaginary disk that just fits within the size of the current brush. The spoke is
inverted by flipping its center end to the outside and flipping its outside end toward the center.



Use Brush button
Specifies that a paintbrush will be used as a painting tool. This is the default setting. When Use 
Brush is selected, you can then click the paintbrush you want from the Paintbrush display grid to 
apply a paint effect.



Use Template button
Specifies that a template brush will be used as a painting tool. Sprites must measure 100 x 100 pixels
or less to be used as a paintbrush template.



Pick Template button
Allows you to choose a sprite as a template brush. When Pick Template is selected, you can select a
sprite to use as a template brush to apply a paint effect.



Over button
Specifies how paint strokes are applied to sprites. When this button is pressed, paint can be applied 
to all pixels within a sprite’s bounding box. When not pressed, paint can be applied only to the opaque
pixels within a sprite’s bounding box.



Continuous Strokes button
Specifies whether the paint stroke is rendered with a solid, even flow of paint or with a slow buildup. 
When depressed, Continuous Strokes delivers a smooth, solid paint stroke. When not depressed, 
paint strokes are applied unevenly.



New Brush button
Displays the Brush Designer dialog box.



Delete Brush button
Deletes the current brush.



Reset to Defaults button
Resets all settings to their default settings.



Outlines Overview
{button ,AL("filters 
ovr;color 
enhancements 
ovr;warps ovr;warp 
transforms ovr")} 
Related Topics

{button ,AL("
warps and 
filters ovr")} 
Overview

Outlines change the pixels inside of a sprite without altering the shape of its outline. You can apply 
any of these effects to one sprite or to a selection set of sprites.

      Click the Outline you want to learn more about.

Original sprite Edge Edge only

Recess Shadow Relief



Recess
{button ,AL("outlines
item")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

{button ,AL("outlines how")} 
How?

Original sprite Recess

Recess highlights the lower-right edges of the sprite and darkens the upper-left edges. The sprite 
looks recessed after you apply this effect.

Where to find this item
Recess is available on the Warps and Filters palette, in the Outlines group.

How to apply this item
Click the Recess picture to learn how to apply this item.

Tip
Put the sprite you want to recess on top of another sprite, and then apply a texture to it before 
applying Recess. The shape of the sprite appears as a recessed shape in the source image.



Relief
{button ,AL("outlines
item")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

{button ,AL("outlines how")} 
How?

Original sprite Relief

Relief highlights the upper-left edges of the sprite and darkens the lower-right edges, raising the 
sprite slightly above the picture plane.

Where to find this item
Relief is available on the Warps and Filters palette, in the Outlines group.

How to apply this item
Click the Relief picture to learn how to apply this item.



Shadow
{button ,AL("outlines
item")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

{button ,AL("outlines how")} 
How?

Original sprite Shadow

Shadow adds a drop shadow to the sprite, based on the sprite's silhouette.

Where to find this item
Shadow is available on the Warps and Filters palette, in the Outlines group.

How to apply this item
Click the Shadow picture to learn how to apply this item.

How to vary this item
Adjust the Offset X value to alter the shadow thrown by a light source directly left of the sprite.

Adjust the Offset Y value to alter the shadow thrown by a light source directly above the sprite.



To cast a shadow behind a sprite
{button ,AL("outlines
how;shadow 
effect")} Related 
Topics

{button ,AL("s
hadow 
effect")} 
Overview

Original sprite Default settings

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Outlines.
4 From the list, select Shadow.
5 Adjust the result by using the options on the palette.

To restore the default settings, click Default.
6 Click Apply.

Tip      To select a color quickly, right-click the Color Swatch and then click a color.



Edge
{button ,AL("outlines
item")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

{button ,AL("outlines how")} 
How?

Original sprite Edge 

Edge outlines the sprite in a color you specify, expanding the sprite by increasing the thickness of the 
edge of the sprite.

Where to find this item
Edge is available on the Warps and Filters palette, in the Outlines group.

How to apply this item
Click the Edge picture to learn how to apply this item.

How to vary this item
· Set the Opacity slider to a high value for a more solidly colored edge. A lower value creates a 

more transparent edge.
· Set the Thickness option to 1 for the thinnest edge or to a higher value for a thicker edge.
· Click the Color Swatch to open the Color Picker, and then select a color for the edge.



Edge Only
{button ,AL("outlines
item")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

{button ,AL("outlines how")} 
How?

Original sprite Edge Only

Edge Only outlines the sprite in a color you specify, and then erases the original image, leaving only 
the edge.

Where to find this item
Edge Only is available on the Warps and Filters palette, in the Outlines group.

How to apply this item
Click the Edge Only picture to learn how to apply this item.

How to vary this item
· Set the Opacity slider to a high value for a more solidly colored edge. A lower value creates a 

more transparent edge.
· Set the Thickness option to 1 for the thinnest edge or to a higher value for a thicker edge.
· Click the Color Swatch to open the Color Picker, and then select a color for the edge.



To apply an outline to a sprite
{button ,AL("outlines
how")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Outlines.
4 In the list, click the item you want.
5 Click Apply.



To place a border around a sprite
{button ,AL("outlines
how")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Outlines.
4 In the list, click Edge.
5 Adjust the thickness of the border line in the Thickness spinner box.
6 Click the Color Swatch to select the border line color from the Color Picker dialog box.
7 Adjust the Opacity slider to the desired setting.
8 Click Apply.



To create an outline of a sprite
{button ,AL("outlines
how")} Related 
Topics

{button ,AL("
outlines 
ovr")} 
Overview

1 Select a sprite.
Note      When you complete this procedure, the sprite you select will become transparent, with only
an outline of the sprite remaining.

2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Outlines.
4 In the list, click Edge Only.
5 Adjust the thickness of the outline in the Thickness box.
6 Click the Color Swatch to select the color of the outline from the Color Picker dialog box.
7 Adjust the Opacity slider to the desired setting.
8 Click Apply.



Filters Overview
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("
warps and 
filters ovr")} 
Overview

      Click the picture of the filter you want to learn about.
Filters change a sprite by performing a weighted average of the original value of each pixel with the 
original values of its neighboring pixels, and then applying the resulting values to the sprite.
You can apply any of these filters to one sprite or to a selection set of sprites.

Original sprite Soften Blur

Outline Sharpen Sharpen Lite



Soften
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("fi
lters ovr")} 
Overview

{button ,AL("filters how")} 
How?

Original sprite Soften

Soften slightly unfocuses the sprite by decreasing the contrast between neighboring pixels. You can 
increase the effect by applying it repeatedly.

Where to find this item
Soften is available on the Warps and Filters tool palette, in the Filters group.

How to apply this item
Click the Soften picture to learn how to apply this filter.

Tips
· You can achieve an even more unfocused result by using Blur.
· You can achieve the opposite effect by using the Sharpen or the Sharpen Lite.



Blur
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("
filters ovr")} 
Overview

{button ,AL("filters how")} 
How?

Original sprite Blur

Blur softens the edges of the pixels throughout the sprite, resulting in an unfocused look.

Where to find this item
Blur is available on the Warps and Filters tool palette, in the Filters group.

How to apply this item
Click the Blur picture to learn how to apply this item.

How to vary this item
In the Blur Options box, adjust the settings in the Horizontal and Vertical boxes. The settings 
specify the number of pixels by which the sprite expands on each side when you blur it. For example, 
a Vertical setting of 2 and a Horizontal setting of 3 expand the sprite by two pixels at the top and two
at the bottom, plus three pixels on the left and three on the right.

Higher settings cause more detail from the original sprite to be lost.



Sharpen
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("fi
lters ovr")} 
Overview

{button ,AL("filters how")} 
How?

Original sprite Sharpen

Sharpen makes the sprite look more distinct by increasing the contrast between neighboring pixels. 
You can intensify the effect by applying this filter repeatedly.

Where to find this item
Sharpen is available on the Warps and Filters tool palette, in the Filters group.

How to apply this item
Click the Sharpen picture to learn how to apply the item.

Tips
· Repeated applications of Sharpen can make a sprite look grainy. For a subtler result, try Sharpen 

Lite.
· You can achieve the opposite effect by using Soften.



Sharpen Lite
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("fi
lters ovr")} 
Overview

{button ,AL("filters how")} 
How?

Original sprite Sharpen Lite

Sharpen Lite makes the sprite look more distinct by subtly increasing the contrast between 
neighboring pixels. You can intensify the effect by applying this item repeatedly.

Where to find this item
Sharpen Lite is available on the Warps and Filters tool palette, in the Filters group.

How to apply this item
Click the Sharpen Lite picture to learn how to apply this filter.

Tips
· Sharpen Lite is a softer version of the Sharpen item.
· You can achieve the opposite effect by using Soften.



Outline
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("fi
lters ovr")} 
Overview

{button ,AL("filters how")} 
How?

Original sprite Outline

Outline creates outlines around the contrasting colors in the sprite and darkens the remaining pixel 
colors. This filter works best on sprites with solid areas of contrasting colors, but it can also produce 
interesting results on digitized or dithered sprites.

Where to find this item
Outline is available on the Warps and Filters tool palette, in the Filters group.

How to apply this item
Click the Outline picture to learn how to apply this item.



To apply a filter
{button ,AL("filters 
item")} Related 
Topics

{button ,AL("fi
lters ovr")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Filters.
4 In the list, click the filter you want.
5 Click Apply.



Warps and Filters Overview
{button ,AL("filters 
ovr;warps group 
ovr;color 
enhancement 
ovr;outlines 
ovr;warp transforms 
ovr")} Related 
Topics

{button ,AL("c
olor tuning 
palette 
ovr;shapes 
palette 
ovr;A_PAINT
_Paint_Tools
_Overview;A
_ARRANGE_
Arrange_Ove
rview;A_Over
view_of_Text
_Sprites;patt
erns and fills 
palette;art 
effects 
palette ovr")} 
Overview

Warps Warp Transforms Outlines

Filters Color Enhancement

      Click a picture to see more samples.
The Warps and Filters palette allows you to manipulate, enhance, and distort a sprite’s overall 
appearance. You can perform the following modifications to a sprite:
· Apply the color currently displayed in the Color Swatch to a sprite.
· Create grayscale (black and white) sprites.
· Enhance the clarity of a sprite.
· Create shadows for sprites.
· Outline a sprite.
· Blur or soften the appearance of a sprite.
· Distort sprites using warps.



To distort a sprite
{button ,AL("warps 
group how")} 
Related Topics

{button ,AL("
warps group 
ovr")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Warps.
4 In the list, click the warp you want.
5 Adjust the warp by using the Warp Options on the tool palette.
6 Click Apply.



To warp a sprite interactively
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("i
nteractive 
warps ovr")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, select Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, click the Perspective, Skew, Bilinear, Stardisk, Schmudge, Barrel or 

Bow picture. The name of the warp appears on the status bar.
6 Adjust the warp by dragging the bounding box until it is the shape you want.
7 Click Apply.



To schmudge a sprite
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("s
chmudge 
warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Schmudge.
6 Move the intersecting point of the bounding box by dragging the Schmudge cursor until the warp 

points are in the desired position.
7 Click Apply.



To add perspective to a sprite
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("
perspective 
warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Perspective.
6 Drag the cursor in any direction, anywhere in the workspace.

If necessary, drag again until the bounding box is the shape you want it.
7 Click Apply.



To warp a sprite using the Bilinear warp
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("
bilinear 
warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Bilinear.
6 Move the cursor toward the corner you want to move. A small square appears at the active corner 

of the bounding box.
7 Drag the cursor in any direction, anywhere in the workspace.

You can select and drag as many corner nodes as you want before you apply the warp.
8 When the bounding box is the shape you want, click Apply.



To skew a sprite
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("s
kew warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Skew.
6 Drag the cursor anywhere in the workspace to adjust the warp bounding box.

Tip      To move the top and bottom lines, drag the pointer vertically. To move the sides right or left, 
drag the pointer horizontally. If necessary, drag again until the sprite is the shape you want it.

7 Click Apply.



To warp a sprite into a bowed shape
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("b
ow warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Bow.
6 Drag the cursor anywhere in the workspace to adjust the warp bounding box.

Tip      Drag vertically to move the top and bottom center points of the bounding box up or down. 
Drag horizontally to move the side center points left or right. If necessary, drag again until the sprite
is the shape you want.

7 Click Apply.



To warp a sprite into a barrel shape
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("b
arrel warp")} 
Overview

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Barrel.
6 Drag the cursor vertically to move the top and bottom center points of the bounding box inward or 

outward.
If necessary, drag again until the sprite is the shape you want it.

7 Click Apply.



To warp a sprite into a mesa shape
{button ,AL("warps 
group how")} 
Related Topics

{button ,AL("
mesa warp")}
Overview

Original sprite Direction Out, radius
at 70%

Direction In, radius
at 70%

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warps.
4 In the list, select Mesa.
5 Adjust the warp by using the options on the tool palette.

To restore the default settings, click Default.
6 Click Apply.

Tips
· Click Warp Direction In for a concave warp. Click Warp Direction Out for a convex warp.
· Set the Radius Factor value to specify where you want the cone to be truncated in relation to its 

base. For example, a setting of 70 truncates the cone at the point where its radius is equal to 70 
percent of the radius of the cone's base, as shown in the samples.



To warp a sprite into a spherical shape
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("
stardisk 
warp")} 
Overview

Original sprite Sphere

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, click Stardisk.
6 Click Apply.

Notes
· The result depends on the shape of the original sprite:

Round or square sprites become spherical.
Oblong or rectangular sprites become ovoid.

· Compare this Stardisk variation with Bulge warp results. Stardisk produces a completely rounded
outline, while a bulged sprite expands only in the middle, retaining the original outline of the sprite.



To warp a sprite to a star shape
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("
stardisk 
warp")} 
Overview

Original sprite Star

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Stardisk.
6 Click anywhere on the workspace and then drag left to contract the corners of the bounding box.

If necessary, click and drag again to adjust the bounding box to the shape you want.
7 Click Apply.



To warp a sprite into a rounded rectangle
{button ,AL("interacti
ve warps how")} 
Related Topics

{button ,AL("
stardisk 
warp")} 
Overview

Original sprite Rounded rectangle

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 In the drop-down list, click Warp Transforms.
4 In the list, click Interactive Warps.
5 In the Interactive Warps list, select Stardisk.
6 Click anywhere on the workspace and then drag right to expand the corners of the bounding box.

If necessary, click and drag again to adjust the bounding box to the shape you want.
7 Click Apply.



Warps Overview
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps and 
filters ovr")} 
Overview

      Click the picture of the warp you want to learn about.
Warps change the shape of a sprite. You can apply warps to one sprite or to a set of selected sprites.

Original sprite Radial Sweep Bulge

Mesa Escher Spoke Inversion

Vortex



Warp Transforms Overview
{button ,AL("warp 
transforms item")} 
Related Topics

{button ,AL("
warps and 
filters ovr")} 
Overview

      Click the picture of the transform you want to learn about.
Warp Transforms change the shape of a sprite. You can only apply Warp Transforms to one sprite at a 
time.

Original sprite Rectangular

Wave Interactive Warps



Interactive Warps Overview
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("
warp 
transforms 
ovr")} 
Overview

      Click the picture of the interactive warp you want to learn about.
Interactive Warps change the shape of a sprite. Using an interactive warp, you can reshape a sprite by 
dragging its bounding box into any of the forms shown below.
You can apply an interactive warp to one sprite at a time.

Original sprite Perspective Bilinear

Skew Stardisk Schmudge

Barrel Bow



Bulge
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Bulge

Bulge causes the middle area of a sprite to swell, as if it were wrapped around a concave or convex 
hemisphere.

Where to find this item
Bulge is available on the Warps and Filters tool palette, in the Warps group.

How to apply this item
Click the Bulge picture to learn how to apply a warp.

How to vary the item
In the Warp Direction box, click In or Out to specify a concave or a convex warp, respectively.



Escher
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Escher

The Escher warp causes the center of the sprite to spread, crowding the area near its borders.

Where to find this item
Escher is available on the Warps and Filters tool palette, in the Warps group.

How to apply this item
Click the Escher picture to learn how to apply a warp.

How to vary the item
Set the value in the Spread box. The default setting of 150 percent causes the center pixel to grow to 
one-and-a-half times its original size. A setting of 100 percent has no effect. A setting of 50 percent 
squeezes the center of the sprite.



Mesa
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Mesa

Mesa causes the sprite to appear to be wrapped around a truncated cone pointing out of or into the 
picture plane.

Where to find this item
Mesa is available on the Warps and Filters tool palette, in the Warps group.

How to apply this item
Click the Mesa picture to learn how to apply a Mesa warp.



Vortex
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Vortex

Vortex twists the sprite around its center while maintaining the orientation of the pixels at its borders.

Where to find this item
Vortex is available on the Warps and Filters tool palette, in the Warps group.

How to apply item
Click the Vortex picture to learn how to apply a warp.

How to vary this item
In the Angle box, specify a positive value for the number of degrees of a clockwise twist, or a 
negative value for a counterclockwise twist.



Rectangular
{button ,AL("warp 
transforms 
item;rectangle vari")}
Related Topics

{button ,AL("
warp 
transforms 
ovr")} 
Overview

Original sprite Rectangular

Rectangular squeezes the sides of the sprite while expanding the center, or it squeezes the center 
while expanding the sides. Microsoft Image Composer uses a mathematical function to rearrange the 
pixels on each of the horizontal scanlines, and then on each of the vertical scanlines.

You can only apply the Rectangular warp to one sprite at a time.

Where to find this item
Rectangular is available on the Warps and Filters tool palette, in the Warp Transforms group.

How to apply this item
Click the Rectangular picture to learn how to apply this item.

How to vary this item
Use the rectangle options on the tool palette.

· Try experimenting with the X axis, Y axis or Both X and Y axes to vary the results for Sine, Cosine,
and Linear Knee.



Rectangular Warp Variations
{button ,AL("rectangl
e warp")} Related 
Topics

{button ,AL("
warp 
transforms 
ovr")} 
Overview

These samples show the results of applying the Rectangular warp at various typical settings. Click a 
picture to see how the options were set to achieve it.

Linear Knee warps

Sine warps

Cosine warps



Linear knee 70%, symmetrical, X axis only



Linear knee 70%, X axis only



Linear knee 70%, Symmetrical, Y axis only



Linear knee 70%, Symmetrical, X and Y axes



Sine function, Symmetrical, X axis only



Sine function, X axis only



Sine function, Symmetrical, Y axis only



Sine function, Symmetrical, X and Y axes



Cosine function, Symmetrical, X axis only



Cosine function, X axis only



Cosine function, Symmetrical, Y axis only



Cosine function, Symmetrical, X and Y axes



Radial Sweep
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Radial Sweep

Radial Sweep scales the center line of pixels to half the diameter of the sprite, and then sweeps the 
line around to form a disk.

Where to find this item
Radial Sweep is available on the Warps and Filters tool palette, in the Warps group.

How to apply this item
Click the Radial Sweep picture to learn how to apply this item.

How to vary this item
Set the Angle value to specify the angle of the sampling line. At the default value of zero, the line is 
horizontal. Positive angle values rotate the line clockwise, and negative values rotate the line 
counterclockwise.

Note      If you apply Radial Sweep to certain kinds of images — such as the one above — it samples 
a clear line at the center of the sprite and then sweeps it around, resulting in a blank hole in the 
middle.

Tip
Try using Angle to create a circular gradient. See Related Topics.



Spoke Inversion
{button ,AL("warps 
item")} Related 
Topics

{button ,AL("
warps group 
ovr")} 
Overview

{button ,AL("warps group 
how")} How?

Original sprite Spoke Inversion

Spoke Inversion inverts every spoke of an imaginary disk that just fits within the sprite. The spoke is 
inverted by flipping its center end to the outside and flipping its outside end toward the center.

Where to find this item
Spoke Inversion is available on the Warps and Filters tool palette, in the Warps group.

How to apply this item
Click the Spoke Inversion picture to learn how to apply this item.

How to vary the item
In the Value box, specify what percentage of the radii of the spokes you want sampled.

For example, at the default setting of 100 percent, each spoke is created from the whole length of the 
radius of the disk before it is inverted. At a setting of 33 percent, the spoke is sampled from the inner 
third of the disk radius and scaled to the full radius of the disk before it is inverted.



Wave
{button ,AL("warp 
transforms 
item;wave vari")} 
Related Topics

{button ,AL("
warp 
transforms 
ovr")} 
Overview

Original sprite Wave

Wave applies a sine wave profile to the image.

Compare Wave to the Rectangular Sine wave warp, which rearranges only the pixels on a scanline, 
while maintaining the overall outline of the image.

Where to find this item
Wave is available on the Warps and Filters tool palette, in the Warp Transforms group.

How to apply a item
Click the Wave picture to learn how to apply this item.

How to vary this item
Increase the Frequency % value to increase the number of waves generated in a sprite.

Increase the Amplitude % value to increase the height of the individual waves generated in a sprite.



Wave Warp Variations
{button ,AL("wave 
warp")} Related 
Topics

{button ,AL("
warp 
transforms 
ovr")} 
Overview

Original sprite Example 1 Example 2

Example 3 Example 4 Example 5

Example 6 Example 7



Example 1
Y axis only, non-symmetrical, defaults for Frequency and Amplitude.



Example 2
X axis only, non-symmetrical, defaults for Frequency and Amplitude.



Example 3
Both X and Y axes, non-symmetrical, defaults for Frequency and Amplitude.



Example 4
Both X and Y axes, Symmetrical, defaults for Frequency and Amplitude.



Example 5
X axis only, Symmetrical, defaults for Frequency and Amplitude.



Example 6
Both X and Y axes, Symmetrical, Frequency 50%, Amplitude 25%.



Example 7
Both X and Y axes, Symmetrical, Frequency 25%, Amplitude 100%.



Schmudge
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Schmudge

Schmudge balloons the center pixels of the sprite away from the middle, while maintaining the 
position of the pixels at the sprite's boundary. The result is three-dimensional, making the sprite look 
as if a strong wind were inflating it from behind.

Where to find this item
Schmudge is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the picture to learn how to apply this item.

Notes
· You can apply Schmudge repeatedly without degrading the sprite, but each time you do, you are 

actually readjusting the center point of the original sprite. If you want to increase the effect, reset 
the transform matrix around the warped sprite by cropping the bounding box. Then apply the warp 
again.

· The intersected box outline used by Schmudge represents a biquadratic patch. Nine points are 
used to describe the warp (as compared to the four points used by the Bilinear interactive warp). 
Schmudge lets you move one of these points. Two other biquadratic warps, Barrel and Bow, let 
you move four of the nine points.



Stardisk
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Sphere

Star Rounded Rectangle

Stardisk interactively transforms a sprite into a sphere, star, or rounded rectangle.

Where to find this item
Stardisk is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the Sphere, Star, or Rounded Rectangle picture to learn how to apply this item.

Note      You can apply Stardisk repeatedly without degrading the sprite, but each time you do, you 
are actually readjusting the center point of the original sprite. If you want to increase the effect, reset 
the transform matrix around the warped sprite by cropping the bounding box. Then apply Stardisk 
again.



Barrel
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Barrel In Barrel Out

Barrel distorts the sprite by bulging its sides. You can also distort the sprite into a pincushion shape 
by pinching its sides. In either case, the four corners of the sprite remain in place.

Where to find this item
Barrel is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the Barrel In or Barrel Out picture to learn how to apply this item.

Notes
· You can apply Barrel repeatedly without degrading the sprite, but each time you do, you are 

actually readjusting the center point of the original sprite. If you want to increase the effect, reset 
the transform matrix around the warped sprite by cropping the bounding box. Then apply Barrel 
again.

· The intersected box outline used by this warp represents a biquadratic patch. Nine points are used 
to describe the warp (as compared to the four points used by the Bilinear interactive warp). Barrel 
lets you move four of these points. Two other biquadratic warps, Schmudge and Bow, let you 
move one and four of the nine points, respectively.



Bow
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Bow

Bow distorts the sprite by shifting a central line of its pixels up, down, right, or left, resulting in a 
bowed effect. All four sides of the bounding box remain parallel, with a curved outline on two opposite 
sides of the sprite.

Where to find this item
Bow is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the Bow picture to learn how to apply this item.

Notes
· You can apply Bow repeatedly without degrading the sprite, but each time you do, you are actually 

readjusting the center point of the original sprite. If you want to increase the effect, reset the 
transform matrix around the warped sprite by cropping the bounding box. Then apply Bow again.

· The intersected box outline used by this warp represents a biquadratic patch. Nine points are used 
to describe the warp (as compared to the four points used by the Bilinear interactive warp). Bow 
lets you move four of these points. Two other biquadratic warps, Schmudge and Barrel, let you 
move one and four of the nine points, respectively.



Skew
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Skew

Skew tilts a sprite by shearing its opposing sides in opposite directions around its center.

Where to find this item
Skew is available on the Warps and Filters palette, in the Warp Transforms group. Click Interactive
Warps.

How to apply this item
Click the Skew picture to learn how to apply this item.

Note      The status bar displays the horizontal and vertical skew factors and (in parentheses) the 
accumulated skew factors for the sprite. The skew factor is expressed as a percentage of the width or
height or the sprite. For example, a 100% horizontal skew means that the top of the sprite is skewed 
to the right by one width of the sprite.



Perspective
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Perspective

Perspective applies two-point perspective to the selected sprite.

Where to find this item
Perspective is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the Perspective picture to learn how to apply this item.

Notes
· Perspective works by scaling the pixels of the sprite toward the vanishing points, resulting in true 

two-point perspective. For example, if you scale a picket fence so that it appears to go off in the 
distance, the spacing between its pickets is greater toward the front than toward the back.

· Compare this item with the similar Bilinear warp, in which the distance between the pickets 
remains constant.

· The status bar displays the current offsets of the horizontal and vertical vanishing points. The unit 
of measure used is either the width or the height of the sprite, whichever is larger. For example, a 
horizontal vanishing point of 2.0 lies to the right of the center of the image by two image widths 
(assuming the width of the sprite is greater than its height).



Bilinear
{button ,AL("interacti
ve warps item")} 
Related Topics

{button ,AL("i
nteractive 
warps 
ovr;warp 
transforms 
ovr")} 
Overview

{button ,AL("interactive warps
how")} How?

Original sprite Bilinear

Bilinear lets you remap the sprite to its bounding box, after first adjusting the position of one or more 
corners of the box.

Where to find this item
Bilinear is available on the Warps and Filters tool palette, in the Warp Transforms group. Click 
Interactive Warps.

How to apply this item
Click the Bilinear picture to learn how to apply this item.

Tips
· You can achieve a false perspective effect using the Bilinear warp, as shown in the picture here. 

Compare this example with the example for the Perspective interactive warp. See Related Topics.
· You can achieve a truer perspective transformation by applying the Bilinear warp and then a 

Rectangular Sine or Cosine warp for the X or Y axis only. See Related Topics for more about 
using the Rectangular interactive warp.



Art Effects Overview
{button ,AL("paint 
effect ovr;sketch 
ovr;graphic 
ovr;exotic ovr;utility 
ovr")} Related 
Topics

{button ,AL("s
hapes palette
ovr;color 
tuning palette
ovr;warps 
and filters 
ovr;patterns 
and fills 
palette ;A_PA
INT_Paint_To
ols_Overview
;A_ARRANG
E_Arrange_O
verview;A_O
verview_of_T
ext_Sprites")}
Overview

Paint effects Sketch effects Graphic effects

Exotic effects Utility effects

      Click a picture to see more samples.
With three or four clicks, Microsoft Image Composer's Art Effects can transform an ordinary composition 
into a compelling image. Whether your project needs a soft artistic treatment or an over-the-top neon-lit 
extravaganza, you’ll find exactly the look you want among the dozens of effects available on the Art 
Effects tool palette.
Art Effects are grouped by the media they emulate: Paint, Sketch, and Graphic. Also included are 
Exotic and Utility effects that can transform an image into gleaming chrome, rippled glass, cloth, stone, 
plaster, paper, or even plastic wrap.

You can apply Art Effects to a sprite or to a selection set of sprites. Art Effects work best with high-
quality scanned images that have a broad range of colors, light areas, and dark areas.

Art Effects transform a sprite by replacing or distorting its pixels. You can specify the proportion of a 
sprite's pixels that are changed by using the opacity slider on the Art Effects tool palette. With the 
other options on the tool palette, you can adjust the proportion of dark to light areas and the intensity 
of the effect you apply.

As you experiment, you can undo the most recent application of an effect by using the Undo 
command on the shortcut menu.



While the options for each effect give you almost infinite flexibility, combining effects can expand the 
possibilities even more.



To apply an Art effect
{button ,AL("art 
effects how")} 
Related Topics

{button ,AL("
art effects 
ovr")} 
Overview

1 Select one or more sprites.
2 In the toolbox, click Art Effects.
3 From the drop-down list, select the effects group you want.
4 From the list, select the item you want.
5 Adjust the effect by using the sliders on the tool palette.
6 Click Apply.

Notes
· To return options to their default settings, click Defaults. The Defaults button has no direct effect 

on a sprite.
· To restore a sprite to its former state after you click Apply, click Undo on the Edit menu or shortcut

menu. Undo affects only the most recent application of an Art Effect.



To apply texture to a sprite
{button ,AL("utility 
how;texture dialog 
box options")} 
Related Topics

{button ,AL("
texturizer 
effect")} 
Overview

1 Select one or more sprites.
2 In the toolbox, click Art Effects.
3 From the drop-down list, click Utility.
4 From the list, click Texturizer.
5 Adjust the Opacity slider to the desired setting.
6 Click Texture Controls.
7 From the Type drop-down list, select a texture option. Click OK.
8 Click Apply.



Texture Options
{button ,AL("texturiz
er effect")} Related 
Topics

{button ,AL("
utility ovr")} 
Overview

{button ,AL("texturizer 
how")} How?

Type
Select a texture from the list. The TIFF File... choice displays an Open dialog box, with which you can
specify your own texture file. Textures with dominant light and dark colors work best.

Light Position
Choose the position from which to light the sprite from the drop-down list.

Scaling
This control allows the surface texture to be scaled by a specified percentage. Move the Scaling % 
slider to the right to increase the size of the texture.

Relief
Move the Relief slider to the right for higher relief and depth of the texture.

Invert Texture
Select the Invert Texture check box to change from a relief effect to an engraved effect.



Glass Surface Options
{button ,AL("glass 
effect")} Related 
Topics

{button ,AL("
exotic ovr")} 
Overview

Type
Select from the list a glass surface type through which to view the sprite. The last choice, TIFF File..., 
displays an Open dialog box, with which you can specify your own glass surface file. Textures with 
dominant light and dark colors work best.

Scaling
This control allows the glass surface to be scaled by a specified percentage. Move the Scale slider to 
the right to make the surface pattern larger.

Invert Surface
Select the Invert Surface check box to change from a relief effect to an engraved effect.



To select the colors for an Art effect
{button ,AL("compos
ition guide 
how;A_conSelecting
_a_Current_Color")}
Related Topics

Most of the Art Effects don't change a sprite's original colors, but a few do. The effects that modify 
the color of a sprite frequently make use of the current color, shown in the Color Swatch, the current 
color of the composition guide, or both. Select these colors before you apply the effect.

Tips
· To maintain the original relationship of darks to midtones and highlights, choose a darker Color 

Swatch color and a lighter Composition Guide color.
· Media effects such as Charcoal and Photocopy work best with the Color Swatch set to black and

the Composition Guide set to white.



To change the color of the active composition guide
{button ,AL("compos
ition guide 
how;A_conSelecting
_a_Current_Color")}
Related Topics

1 In the File menu, click Composition Properties.
2 In the Composition Guide Color box, change the color channel values.
3 Click OK.

Composition Guide color is saved with each composition.

Tip      To find the values for the color you want, click the Color Swatch in the Composition Guide 
Color box.



To change the color of the default composition guide
{button ,AL("compos
ition guide 
how;A_conSelecting
_a_Current_Color")}
Related Topics

1 In the Tools menu, click Options, and then click the Composition Guide Defaults tab.
2 In the Color box, click on the Color Swatch and select a color.
3 Click OK.

The next time you create a new composition, the Composition Guide is displayed in the color you 
specified.

Note      Composition Guide color is saved with each composition. Therefore, changing the default 
Composition Guide color doesn't affect the color of existing compositions.



To convert a color sprite to grayscale
{button ,AL("color 
enhance how")} 
Related Topics

{button ,AL("l
uminance 
effect;contras
t effect")} 
Overview

Original sprite Luminance

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Color Enhancement.
4 From the list, click Luminance.
5 Click Apply.

Tip      Increase the contrast of the image to create more black-and-white look.



To create a hand-rendered effect
{button ,AL("accente
d edges 
effect;texturizer 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create that picture.
1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Accented Edges.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Texturizer.
7 Click Apply.

Tip      Try adjusting the options available for both Accented Edges and Texturizer to create 
variations of the examples pictured above.



Accented Edges settings
Edge Width:    2

Edge Brightness:    18

Smoothness:    5

Opacity:    100



Texture Control settings
Type:    Canvas

Light position:    Top Right

Scaling:    62

Relief:    4



To enhance the Paint Daubs effect
{button ,AL("paint 
daubs 
effect;texturizer 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create that picture.
1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Paint Daubs.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Texturizer.
7 Click Apply.

Tip      Try adjusting the options available for both Paint Daubs and Texturizer to create variations of 
the examples pictured above.



Paint Daubs settings
Brush Size:    9

Brush Type:    Simple

Sharpness:    23

Opacity    100



Texture Controls settings
Type:    Canvas

Light position:    Top Right

Scaling:    50

Relief:    3



To create a pencil sketch effect
{button ,AL("colored 
pencil effect;")} 
Related Topics

{button ,AL("
art effects 
ovr;color 
tuning 
overview")} 
Overview

Original sprite In process Result

      Click the process picture to view the specific option settings used to create that 
picture.

Note      Your sprite must first be converted to grayscale for this procedure to work properly. For 
information about how to convert your sprite to grayscale, see To convert a color sprite to grayscale.

1 Select one or more sprites.
2 In the toolbox, click Art Effects.
3 From the drop-down list, click Sketch.
4 From the list, click Colored Pencil.

Note      For best results, set Paper Brightness to its maximum value.

5 Click Apply.
6 In the toolbox, click Color Tuning.
7 Adjust the Contrast slider to the desired position.
8 Click Apply.

Tip      Try adjusting the options available for both Colored Pencil and Contrast to create variations of
the examples pictured above.



Colored Pencil settings
Pencil Width:    4

Stroke Pressure:    8

Paper Brightness:    42

Opacity:    100



To create a hand-colored effect
{button ,AL("luminan
ce effect;diffuse 
glow effect;")} 
Related Topics

{button ,AL("
art effects 
ovr;sprite to 
sprite ovr")} 
Overview

Original sprite In process Result

1 Select a sprite.
2 In the Edit menu, click Duplicate.
3 In the toolbox, click Art Effects and then click Utility from the drop-down list.
4 In the list, click Diffuse Glow.
5 Select the duplicate sprite and click Apply.
6 In the toolbox, click Warps and Filters and then click Color Enhancement from the drop-down 

list.
7 In the list, click Luminance.
8 Click Apply.

Note      Make sure that the sprite that you applied Diffuse Glow to is selected before you click 
Apply.

9 Select the grayscale sprite and place it on top of the full-color sprite.
Tip      For best results, send the grayscale sprite behind the full-color sprite by selecting the 
grayscale sprite, then click Send to Back from the Arrange menu.

10In the toolbox, click Patterns and Fills and then click Sprite to Sprite from the list.
Note      Make sure that Transfer Shape is displayed in the Sprite Texture Type drop-down list.

11Set the Opacity slider to 50 and click Apply.
You are prompted to click on the texture source sprite, which is the full-color sprite.

12Drag the full-color sprite away.



To create a cartoon-like pencil sketch
{button ,AL("photoco
py effect")} Related 
Topics

{button ,AL("
art effect 
ovr;dynamic 
range 
overview")} 
Overview

Original sprite Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Graphic.
3 From the list, click Photocopy.

Tip      For best results, apply Photocopy to the sprite twice.

4 Select the Color Swatch color and the Composition Guide color to be used.
5 Click Apply.
6 Adjust the dynamic range until you get the look you want.

Tip      Try adjusting the options available for Photocopy and the color of the Composition Guide to 
create variations of the examples pictured above.



Photocopy settings
Detail:    5

Darkness:    50



To enhance the Sponge effect
{button ,AL("texturiz
er effect;sponge 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Sponge.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Texturizer.
7 Click Texture Controls.
8 From the Type drop-down list, select a texture option.
9 Click Apply.

Tip      Try adjusting the options available for both Sponge and Texturizer to create variations of the 
examples pictured above.



Sponge settings
Brush Size:    2

Definition:    12

Smoothness:    5

Opacity:    100



Texturizer Control settings
Type:    Sandstone

Light Position:    Top Right

Scaling:    100

Relief:    10



To create an oil painting effect
{button ,AL("emboss
effect;fresco effect")}
Related Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Utility.
3 From the list, click Emboss.
4 Click Apply.
5 From the drop-down list, click Paint.
6 From the list, click Fresco.
7 Click Apply.

Tip      Try adjusting the options available for both Emboss and Fresco to create variations of the 
examples pictured above.



Emboss settings
Relief:    1

Light Position:    Top Right



Fresco settings
Brush Size:    1

Brush Detail:    10

Texture:    3



To create a rough-surface chalk effect
{button ,AL("colored 
pencil 
effect;texturizer 
effect;")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Sketch.
3 From the list, click Colored Pencil.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Texturizer.
7 Click Texture Controls.
8 From the Type drop-down list, select a texture option. Click OK.
9 Click Apply.

Tip      Try adjusting the options available for both Colored Pencil and Texturizer to create variations 
of the examples pictured above.



Colored Pencil settings
Pencil Width:    2

Stroke Pressure:    14

Paper Brightness:    50

Opacity:    100



Texture Control setting
Type:    Sandstone



To enhance the Embossed effect
{button ,AL("waterco
lor effect;emboss 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Watercolor.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Emboss.
7 Click Apply.

Tip      Try adjusting the options available for both Watercolor and Emboss to create variations of the 
examples pictured above.



Watercolor settings
Brush Detail:    9

Shadow Intensity:    1

Texture:    1

Opacity:    100



Emboss settings
Relief:    11

Light Position:    Top Right

Opacity:    100



To enhance the Dry Brush effect
{button ,AL("dry 
brush effect;emboss
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Dry Brush.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Emboss.
7 Click Apply.

Tip      Try adjusting the options available for both Dry Brush and Emboss to create variations of the 
examples pictured above.



Dry Brush settings
Brush Size:    2

Brush Detail:    8

Texture:    1

Opacity:    100



Emboss settings
Relief:    11

Light Position:    Top Right

Opacity:    100



To create an artistic paint effect
{button ,AL("accente
d edges effect;dry 
brush effect")} 
Related Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Accented Edges.
4 Click Apply.
5 From the list, click Dry Brush.
6 Click Apply.

Tip      Try adjusting the options available for both Accented Edges and Dry Brush to create 
variations of the examples pictured above.



Accented Edges settings
Edge Width:    4

Edge Brightness:    38

Smoothness:    5

Opacity:    100



Dry Brush settings
Brush Size:    2

Brush Detail:    8

Texture:    1

Opacity:    100



To create an antique photograph effect
{button ,AL("color 
over effect;film grain
effect")} Related 
Topics

{button ,AL("
art effects 
ovr;dynamic 
range 
overview")} 
Overview

Original sprite In process

In process Result

      Click the result picture to view the specific option settings used to create that picture.
1 Convert the sprite to grayscale if it isn't in black and white already. For more information about 

converting to grayscale, see To convert a color sprite to grayscale in help.
2 Set the color of the Color Swatch to brown sepia (Red 57, Green 22, Blue 1).
3 In the toolbox, click Warps and Filters.
4 From the drop-down list, click Color Enhancement.
5 From the list, click Color Over and set Color Opacity to 65.
6 Click Apply.
7 In the toolbox, click Color Tuning.
8 Click Dynamic Range.
9 Move the right bar to the middle of the Histogram window.
10Click Apply.
11 In the toolbox, click Art Effects.
12From the drop-down list, click Utility.
13From the list, click Film Grain.
14Click Apply.

Tip      Try adjusting the options available for Film Grain to create variations of the examples pictured 
above.



Film Grain settings
Grain:    2

Highlight Area:    1

Highlight Intensity:    10

Opacity:    100



To enhance the Watercolor effect
{button ,AL("sprayed
strokes 
effect;watercolor 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Paint.
3 From the list, click Sprayed Strokes.
4 Click Apply.
5 From the list, click Watercolor.
6 Click Apply.

Tip      Try adjusting the options available for both Sprayed Strokes and Watercolor to create 
variations of the examples pictured above.



Sprayed Strokes settings
Stroke Length:    8

Direction:    Right Diagonal

Radius:    20

Opacity:    100



Watercolor settings
Brush Detail:    9

Shadow Intensity:    1

Texture:    1

Opacity:    100



To enhance the Mosaic effect
{button ,AL("mosaic 
effect;emboss 
effect")} Related 
Topics

{button ,AL("
art effects 
ovr")} 
Overview

Original sprite In process Result

      Click a process or result picture to view the specific option settings used to create 
that picture.

1 In the toolbox, click Art Effects.
2 From the drop-down list, click Exotic.
3 From the list, click Mosaic.
4 Click Apply.
5 From the drop-down list, click Utility.
6 From the list, click Emboss.
7 Click Apply.

Tip      Try adjusting the options available for both Mosaic and Emboss to create variations of the 
examples pictured above.



Mosaic settings
Tile Size:    12

Grout Width:    3

Lighten Grout:    8

Opacity:    100



Emboss settings
Relief:    6

Light Position:    Top Right

Opacity:    100



From File command
Displays the Insert From File dialog box from which you can choose a file to insert into your current 
composition.



From PhotoCD command
Displays the Insert From PhotoCD dialog box from which you can choose a PhotoCD image to insert
into your current composition.



To copy a texture from one sprite to another
{button ,AL("sprite to
sprite how")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

1 Adjust the destination and source sprites so that they intersect or overlap each other. 
2 Click on the destination sprite.
3 In the toolbox click Patterns and Fills.
4 In the list, click Sprite to Sprite.
5 In the Sprite Texture Type list, click Transfer Shape.
6 Click Apply.
7 Click the source sprite.

You might be prompted with the Microsoft Image Composer Hint dialog box instructing you to click 
the source sprite automatically.

8 Drag the source sprite away from the destination sprite to view the results.

Note      If the opacity slider is set to 100, the destination sprite will seem to disappear after you 
perform this operation. This is because it is now identical with its background. Drag the textured sprite
away from the source sprite to see the destination sprite.

If the source sprite is directly underneath, and totally obscured by, the destination sprite, you must first
extend the bounding box of the source sprite beyond the perimeter of the destination sprite. Then you 
can select the source sprite. For information on extending a bounding box, see To crop a sprite.



To copy a texture with its transparent pixels to another sprite
{button ,AL("sprite to
sprite how")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

1 Adjust the destination and s  ource sprites   so that they intersect or overlap each other.
2 Click on the destination sprite.
3 In the toolbox click Patterns and Fills.
4 In the list, click Sprite to Sprite.
5 In the Sprite Texture Type drop-down list, click Transfer Full.
6 Click Apply.
7 Click on the source sprite.

You might be prompted with the Microsoft Image Composer Hint dialog box instructing you to click 
the source sprite automatically.

8 Drag the source sprite away from the destination sprite to view the results.

Note      If the source sprite is directly underneath, and totally obscured by, the destination sprite, you 
must first extend the bounding box of the source sprite beyond the perimeter of the destination sprite. 
Then you can select the source sprite. For information on extending a bounding box, see To crop a 
sprite.



To glue a texture to another sprite
{button ,AL("sprite to
sprite how")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

1 Adjust the destination and source sprites so that they intersect or overlap each other.
2 Click the destination sprite.
3 In the toolbox click Patterns and Fills.
4 In the list, click Sprite to Sprite.
5 In the Sprite Texture Type list, click Glue.
6 Click Apply.
7 Click the source sprite.

You might be prompted with the Microsoft Image Composer Hint dialog box instructing you to click 
the source sprite automatically.

8 Drag the source sprite away from the destination sprite to view the results.

Note      If the source sprite is directly underneath, and totally obscured by, the destination sprite, you 
must first extend the bounding box of the source sprite beyond the perimeter of the destination sprite. 
Then you can select the source sprite. For information on extending a bounding box, see To crop a 
sprite.



To snip a sprite
{button ,AL("sprite to
sprite how")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

1 Adjust the destination and source sprites so that they intersect or overlap each other.
2 Click the destination sprite.
3 In the toolbox click Patterns and Fills.
4 In the list, click Sprite to Sprite.
5 In the Sprite Texture Type list, click Snip.
6 Click Apply.

You might be prompted with the Microsoft Image Composer Hint dialog box instructing you to click 
the source sprite automatically.

7 Drag the source sprite away from the destination sprite to view the results.

Note      If the source sprite is directly underneath, and totally obscured by, the destination sprite, you 
must first extend the bounding box of the source sprite beyond the perimeter of the destination sprite. 
Then you can select the source sprite. For information on extending a bounding box, see To crop a 
sprite.



Color Enhancement Overview
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("
warps and 
filters ovr")} 
Overview

      Click the Color Enhancement you want to read about.
Color enhancements change a sprite by altering its original colors. You can apply any of these items to 
one sprite or to a selection set of sprites.

Original sprite Complement Color Luminance

Colorize Wash Tint

Color Atop Color Over



Color Atop
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Color Atop

Color Atop applies the Color Swatch’s current color to the colored pixels of the sprite. The clear 
pixels are not changed.

Where to find this item
Color Atop is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Color Atop picture to learn how to apply this item.

How to vary this item
Adjust the Color Opacity slider. If you set opacity below 100, the color builds up when you reapply 
this item.

Tip
· To apply color to all the pixels in a sprite, use Color Over.



Color Over
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Color Over

Color Over applies the Color Swatch’s current color to all the pixels in the sprite, including clear 
pixels.

Where to find this item
Color Over is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Color Over picture to learn how to apply this item.

How to vary this item
Adjust the Color Opacity slider. If you set opacity below 100, the color builds up as you reapply this 
item.

Tip
· To apply color only to the colored pixels in a sprite, use Color Atop. See Related Topics.



Tint
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Tint

Tint applies a transparent wash of the Color Swatch’s current color to the selected sprite.

Where to find this item
Tint is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Tint picture to learn how to apply this item.

How to vary this item
Adjust the Color Opacity slider.

Notes
· Tint is similar to Color Atop, except that Tint never exceeds the maximum opacity you set by 

using the Color Opacity slider.
· Tint is similar to Colorize, except that Tint modifies the existing colors, whereas Colorize changes

them. Also, Tint affects pure black or white pixels, whereas Colorize does not.



Colorize
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Colorize

Colorize applies the Color Swatch’s current color to the sprite without affecting its dark and light 
values. Colorize changes the color values of all the pixels, with the exception of pure black or white 
pixels.

Where to find this item
Colorize is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Colorize picture to learn how to apply this item.

How to vary this item
Adjust the Color Opacity slider.

Tip
· Colorize is especially good for coloring monochrome images.



To apply a color enhancement effect
{button ,AL("color 
enhancement 
item")} Related 
Topics

1 Select a sprite.
2 In the toolbox, click Warps and Filters.
3 From the drop-down list, click Color Enhancement.
4 In the list box, click the item you want to apply.
5 Click Apply.



Complement Color
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Complement Color

Complement Color changes all the colors in the sprite to their complements, resulting in a color 
negative.

Where to find this item
Complement Color is available on the Warps and Filters tool palette, in the Color Enhancement 
group.

How to apply this item
Click the Complement Color picture to learn how to apply an item.

Tip
· You can undo this item by repeating it.



Luminance
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

Original sprite Luminance

Luminance converts a color sprite to grayscale (shades of black and white).

Where to find this item
Luminance is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Luminance picture to learn how to apply this item.



Wash
{button ,AL("color 
enhancement 
item")} Related 
Topics

{button ,AL("c
olor 
enhancement
ovr")} 
Overview

{button ,AL("transparency 
how")} How?

Original sprite Wash

Wash makes the sprite translucent by increasing the transparency of the pixels. The result varies 
from translucent (as in the picture here) to totally invisible, depending on how you set the Wash 
Opacity slider.

Where to find this item
Wash is available on the Warps and Filters tool palette, in the Color Enhancement group.

How to apply this item
Click the Wash picture to learn how to apply this item.

How to vary this item
Adjust the Wash Opacity slider. The lower the setting, the more transparent the sprite becomes when
you click Apply. If you set opacity to 0, all the opaque pixels in the sprite are erased; the image 
becomes invisible.

Tips
· Wash makes the whole sprite translucent. To make only a part of the sprite translucent, use Erase 

on the Paint tool palette. See Related Topics.



Art Effects group list
Displays a list of five art effect groups: Paint, Sketch, Graphic, Exotic, and Utility. Select an item 
here to change options in the rest of the dialog box.



Effect list
Displays a list of effects available for the Art Effects group selected above.



Opacity slider
Adjusts the amount of opacity of the effect you want. Low opacity values create a more amorphous, 
transparent effect, retaining more of the sprite's original look. High opacity values create more 
detailed, defined effects. To decrease the amount of opacity, move the slider to the left then click 
Apply.



Opacity box
Specifies the opacity value of the effect you want. Low opacity values create a more amorphous, 
transparent effect, retaining more of the sprite's original look. High opacity values create more 
detailed, defined effects. To change the value, select the current value and type a number between 1 
and 100 or click the arrows to select a new value, and then click Apply.



Apply button
Applies all the changes that you have made without closing the current palette.



Defaults button
Resets the palette controls to their default values.



Brush Detail slider
Adjusts the amount of the brush detail of the Watercolor effect. Move the slider to alter brush detail, 
and then click Apply.



Shadow Intensity slider
Adjusts the intensity of the shadow of the current sprite. Move the slider to alter the shadow intensity, 
and then click Apply.



Texture slider
Adjusts the amount of Watercolor effect texture you can apply to the current sprite. Move the slider to
alter the amount of texture, and then click Apply.



Brush Detail box
Specifies the amount of Watercolor effect brush detail. Higher values create more brush detail. The 
default value is 9. To change the value, select the current value and type a number between 1 and 14 
or click the arrows to select a new value, and then click Apply.



Shadow Intensity box
Specifies the amount of Watercolor effect shadow intensity you can apply to the current sprite. 
Higher values create greater shadow intensity. The default value is 1. To change the value, select the 
current value and type a number between 0 and 10 or click the arrows to select a new value, and then
click Apply.



Texture box
Specifies the amount of texture you can apply with the Watercolor effect to the current sprite. Higher 
values create greater degrees of texture. The default value is 1. To change the value, select the 
current value and type a number between 1 and 3 or click the arrows to select a new value, and then 
click Apply.



Brush Size slider
Adjusts the brush size of the Underpainting effect. Move the slider to alter the brush size, and then 
click Apply.



Brush Size box
Specifies the brush size of the Underpainting effect. Higher values create larger brushes. To change 
the value, select the current value and type a new number or click the arrows to set a new value, and 
then click Apply.



Texture Coverage slider
Adjusts the amount of texture coverage of the Underpainting effect. Move the slider to alter the 
amount of coverage, and then click Apply.



Texture Coverage box
Specifies the Underpainting effect texture coverage. Higher values increase the area of texture 
coverage. The default setting is 16. To change the value, select the current value and type a number 
between 0 and 40 or click the arrows to select a new value, and then click Apply.



Texture Controls button
Displays the Texture Controls dialog box, which contains the Type, Light Position, Scaling, Relief, 
and Invert Texture controls.



Stroke Size slider
Adjusts the width of a Palette Knife stroke effect. Move the slider to alter the width of the stroke size, 
and then click Apply.



Stroke Size box
Specifies the width of the Palette Knife stroke effect. The higher the value, the broader the stroke 
size. The maximum value is 50; the default value is 25. To change the value, select the current value 
and type a number between 1 and 50 or click the arrows to select a new value, and then click Apply.



Stroke Detail slider
Adjusts the detail of the Palette Knife stroke effect. Move the slider to alter the detail of the stroke, 
and then click Apply.



Stroke Detail box
Specifies the detail of the Palette Knife stroke effect. Higher values create more detailed palette knife
strokes. The maximum value is 3, which is also the default value. To change the value, select the 
current value and type a number between 1 and 3 or click the arrows to select a new value, and then 
click Apply.



Softness slider
Adjusts the softness of the Palette Knife stroke effect. Move the slider to alter the softness of the 
effect, and then click Apply.



Softness box
Specifies the softness of the Palette Knife stroke effect. Higher values create the appearance of 
softer, less detailed palette knife strokes. The maximum value is 10; the default value is 0. To change 
the value, select the current value and type a number between 0 and 10 or click the arrows to select a
new value, and then click Apply.



Brush Size slider
Adjusts the detail of the Dry Brush effect. Move the slider to alter the brush size, and then click 
Apply.



Brush Size box
Specifies the Dry Brush effect brush size. Higher values create larger, less detailed brush strokes. 
The default value is 2. To change the value, select the current value and type a number between 0 
and 10 or click the arrows to select a new value, and then click Apply.



Brush Detail slider
Adjusts the amount of detail in the Dry Brush paint strokes. Move the slider to alter the amount of 
detail, the click Apply.



Brush Detail box
Specifies the Dry Brush effect brush detail. Higher values create greater brush stroke detail. The 
default value is 8. To change the value, select the current value and type a number between 0 and 10 
or click the arrows to select a new value, and then click Apply.



Texture slider
Adjusts the amount of Dry Brush effect texture that you can apply to the current sprite. Move the 
slider to alter the amount of texture, and then click Apply.



Texture box
Specifies the amount of Dry Brush effect texture you can apply to the current sprite. Higher values 
create rougher textures. The default value is 1. To change the value, select the current value and type
a number between 1 and 3 or click the arrows to select a new value, and then click Apply.



Spray Radius slider
Adjusts the radius of the Spatter effect. Move the slider to alter the size of the spray radius, and then 
click Apply.



Spray Radius box
Specifies the size of the spray radius. A higher value creates a wider radius for the effect. The default 
value is 10. To change the value, select the current value and type a number between 0 and 25 or 
click the arrows to select a new value, and then click Apply.



Smoothness slider
Adjusts the smoothness of the Spatter effect. Move the slider to alter the smoothness, and then click 
Apply.



Smoothness box
Specifies the amount of smoothness for the Spatter effect. Higher values create a smoother effect. 
The default value is 5. To change the value, select the current value and type a number between 1 
and 15 or click the arrows to select a new value, and then click Apply.



Stroke Width slider
Adjusts the width of the brush stroke of the Sumi-e (pronounced sue-me-ay) effect. Move the slider to
alter the width of the brush stroke, and then click Apply.



Stroke Width box
Specifies the brush stroke width of the Sumi-e (pronounced sue-me-ay) effect. Higher values create 
broader the brush stroke widths. The default value is 10. To change the value, select the current value
and type a number between 3 and 15 or click the arrows to select a new value, and then click Apply.



Stroke Pressure slider
Adjusts the brush stroke pressure of the Sumi-e (pronounced sue-me-ay) effect. Dragging the slider 
to the left makes the brush strokes appear coarser. Move the slider to alter the stoke pressure, and 
then click Apply.



Stroke Pressure box
Specifies the brush stroke pressure of the Sumi-e (pronounced sue-me-ay) effect. Higher values 
create strokes that appear to have been applied with greater pressure. The default value is 2. To 
change the value, select the current value and type a number between 0 and 15 or click the arrows to
select a new value, and then click Apply.



Contrast slider
Adjusts the contrast of the Sumi-e (pronounced sue-me-ay) effect. Dragging the slider to the left 
reduces contrast, while dragging it to the right increases it. Move the slider to alter the contrast, and 
then click Apply.



Contrast box
Specifies the contrast value of the Sumi-e (pronounced sue-me-ay) effect. Higher values create 
greater contrast. The default value is 16. To change the value, select the current value and type a 
number between 0 and 40 or click the arrows to select a new value, and then click Apply.



Fiber Length slider
Adjusts the appearance of the fiber of the Water Paper effect. Moving the slider to the left creates the
appearance of longer fibers. Move the slider to alter fiber length, and then click Apply.



Fiber Length box
Specifies the appearance of the fiber of the Water Paper effect. Higher values create the appearance
of longer fibers. The default value is 15. To change the value, select the current value and type a 
number between 3 and 50 or click the arrows to select a new value, and then click Apply.



Brightness slider
Adjusts the brightness of the Water Paper effect. Dragging the slider to the right creates a brighter 
effect. Move the slider to alter the brightness of the effect, and then click Apply.



Brightness box
Specifies the brightness value of the Water Paper effect. Higher values create brighter effects. The 
default value is 60. To change the value, select the current value and type a number between 0 and 
100 or click the arrows to select a new value, and then click Apply.



Contrast slider
Adjusts the contrast of the Water Paper effect. Dragging the slider to the right creates greater 
contrast. Move the slider to alter contrast, and then click Apply.



Contrast box
Specifies the contrast value of the Water Paper effect. Higher values create greater contrast. The 
default value is 80. To change the value, select the current value and type a number between 0 and 
100 or click the arrows to select a new value, and then click Apply.



Edge Width slider
Adjusts the width of the edges of the Accented Edges effect. Dragging the slider to the right creates 
wider edges. Move the slider to alter edge width, and then click Apply.



Edge Width box
Specifies the edge width of the Accented Edges effect. Higher values create broader edges on the 
current sprite. The default value is 2. To change the value, select the current value and type a number
between 1 and 14 or click the arrows to select a new value, and then click Apply.



Edge Brightness slider
Adjusts the edge brightness of the Accented Edges effect. Dragging the slider to the right creates 
brighter edges. Move the slider to alter the edge brightness, and then click Apply.



Edge Brightness box
Specifies the edge width of the Accented Edges effect. Higher values create brighter edges. The 
default value is 38. To change the value, select the current value and type a number between 0 and 
50 or click the arrows to select a new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Accented Edges effect. Dragging the slider to the right makes 
the effect appear smoother and less detailed. Move the slider to alter the smoothness of the current 
sprite, and then click Apply.



Smoothness box
Specifies the overall smoothness of the Accented Edges effect. Higher values create smoother 
effects. The default value is 5. To change the value, select the current value and type a number 
between 1 and 15 or click the arrows to select a new value, and then click Apply.



Brush Size slider
Adjusts the brush size of the Paint Daubs effect. Move the slider to alter the brush size, and then 
click Apply.



Brush Size box
Specifies the brush size of the Paint Daubs effect. Higher values create larger brush sizes. The 
default value is 8. To change the value, select the current value and type a number between 1 and 50 
or click the arrows to select a new value, and then click Apply.



Brush Type list
Displays the brush type options for the Paint Daubs effect. Click the brush type you want from the 
list.



Sharpness slider
Adjusts the amount of detail for the Paint Daubs effect. Move the slider to alter the sharpness, and 
then click Apply.



Sharpness box
Specifies the degree of detail for the Paint Daubs effect. Higher values create more detail. The 
default value is 7. To change the value, select the current value and type a number between 0 and 40 
or click the arrows to select a new value, and then click Apply.



Brush Size slider
Adjusts the size of the brush, or sponge, of the Sponge effect. Move the slider to alter the brush size, 
and then click Apply.



Brush Size box
Specifies the size of the brush, or sponge, of the Sponge effect. Higher values create larger brush 
sizes. The default value is 2. To change the value, select the current value and type a number 
between 0 and 10 or click the arrows to select a new value, and then click Apply.



Definition slider
Adjusts the definition of the textured portions of the current sprite. Move the slider to alter the Sponge
effect definition, and then click Apply.



Definition box
Specifies the degree of definition of the textured portions of the current sprite. Higher values create a 
higher degree of definition. The default value is 12. To change the value, select the current value and 
type a number between 0 and 25 or click the arrows to select a new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Sponge effect. Dragging the slider to the right increases the 
smoothness of the overall effect. Move the slider to alter the smoothness of the current sprite, and 
then click Apply.



Smoothness box
Specifies the overall smoothness of the Sponge effect. Higher values create smoother effects. The 
default value is 5. To change the value, select the current value and type a number between 1 and 15 
or click the arrows to select a new value, and then click Apply.



Stroke Length slider
Adjusts the length of the Sprayed Stroke effect. Dragging the slider to the right creates the 
appearance of longer brush strokes. Move the slider to alter the length of the stroke on the current 
sprite, and then click Apply.



Stroke Length box
Specifies the length of the Sprayed Stroke effect. Higher values create the appearance of longer 
brush strokes. The default value is 12. To change the value, select the current value and type a 
number between 0 and 20 or click the arrows to select a new value, and then click Apply.



Stroke Direction list
Displays a list of stroke direction options for the Sprayed Stroke effect. Click the stroke direction 
effect you want from the list.



Spray Radius slider
Adjusts the radius of the Sprayed Stroke effect. Move the slider to alter the effect, and then click 
Apply.



Spray Radius box
Specifies the radius of the Spray Radius effect. A higher value creates a larger radius in which the 
effect is applied. The default value is 7. To change the value, select the current value and type a 
number between 0 and 25 or click the arrows to select a new value, and then click Apply.



Balance slider
Adjusts the proportions of the areas affected by the Black Intensity and White Intensity sliders. 
Move the slider to alter the balance of the Black and White intensity values, and then click Apply.



Balance box
Specifies the proportions of the areas affected by the Black Intensity and White Intensity sliders. 
Higher values increase the area affected by the Black Intensity and White Intensity sliders. The 
default value is 5. To change the value, select the current value and type a number between 0 and 10 
or click the arrows to select a new value, and then click Apply.



Black Intensity slider
Adjusts the black intensity of the current sprite. Move the slider to alter the black intensity, and then 
click Apply.



Black Intensity box
Specifies the degree of black intensity on the current sprite. Higher values increase the degree of 
black intensity. The default value is 6. To change the value, select the current value and type a 
number between 0 and 10 or click the arrows to select a new value, and then click Apply.



White Intensity slider
Adjusts the white intensity of the current sprite. Move the slider to alter the white intensity, and then 
click Apply.



White Intensity box
Specifies the degree of white intensity on the current sprite. Higher values increase the degree of 
white intensity. The default value is 2. To change the value, select the current value and type a 
number between 0 and 10 or click the arrows to select a new value, and then click Apply.



Brush Size slider
Adjusts the brush size and degree of coarseness of the Fresco effect. Move the slider to alter the 
brush size, and then click Apply.



Brush Size box
Specifies the size of the brush and degree of coarseness of the Fresco effect. Higher values create 
larger brushes. The default value is 2. To change the value, select the current value and type a 
number between 0 and 10 or click the arrows to select a new value, and then click Apply.



Brush Detail slider
Adjusts the amount of the brush detail of the Fresco effect. Move the slider to alter the brush detail, 
and then click Apply.



Brush Detail box
Specifies the amount of brush detail of the Fresco effect. Higher values create greater detail. The 
default value is 8. To change the value, select the current value and type a number between 0 and 10 
or click the arrows to select a new value, and then click Apply.



Texture slider
Adjusts the amount of texture you can apply to the current sprite. Move the slider to alter the amount 
of texture, and then click Apply.



Texture box
Specifies the amount of texture you can apply to the current sprite. Higher values create more texture.
The default value is 1. To change the value, select the current value and type a number between 1 
and 3 or click the arrows to select a new value, and then click Apply.



Charcoal Area slider
Adjusts the amount and definition of charcoal sketch strokes within the current sprite. Move the slider 
to alter the qualities of the charcoal sketch strokes, and then click Apply.



Charcoal Area box
Specifies the amount and definition of charcoal sketch strokes within the current sprite. Higher values 
create sketch strokes with more definition. The default value is 6. To change the value, select the 
current value and type a number between 0 and 20 or click the arrows to select a new value, and then
click Apply.



Chalk Area slider
Adjusts the width and definition of the chalk effect, which traces an outline of the current sprite. Move 
the slider to alter those qualities, and then click Apply



Chalk Area box
Specifies the width and definition of the chalk effect, which traces an outline of the current sprite. 
Higher values create an effect with greater detail and definition. The default value is 6. To change the 
value, select the current value and type a number between 0 and 20 or click the arrows to select a 
new value, and then click Apply.



Stroke Pressure slider
Adjusts the stroke pressure of the Chalk And Charcoal effect. Move the slider to alter the darkness 
and definition of the stroke, and then click Apply



Stroke Pressure box
Specifies the amount of stroke pressure of the Chalk And Charcoal effect. Higher values create 
strokes that appear to be applied with greater pressure. The default value is 1. To change the value, 
select the current value and type a number between 0 and 5 or click the arrows to select a new value,
and then click Apply.



Stroke Length slider
Adjusts the length of the pen stroke of the Graphic Pen effect. Moving the slider to the right creates 
longer strokes. Move the slider to alter the length of the stroke on the current sprite, and then click 
Apply.



Stroke Length box
Specifies the length of the pen stroke of the Graphic Pen effect. Higher values create longer strokes. 
The default value is 15, which is also the maximum value. To change the value, select the current 
value and type a number between 1 and 15 or click the arrows to select a new value, and then click 
Apply.



Stroke Direction list
Displays a list of stroke direction options for the Graphic Pen effect. Click the stroke direction effect 
you want from the list.



Light/Dark Balance slider
Lightens or darkens the Graphic Pen effect. Move the slider to the left to lighten the effect, or move 
the slider to the right to darken the effect, and then click Apply.



Light/Dark Balance box
Specifies the balance between the lightness and darkness controls of the Graphic Pen effect. Higher 
values darken the effect. The default value is 50; the maximum value is 100. Values below 50 lighten 
the effect; values above 50 darken the effect. To change the value, select the current value and type a
number between 1 and 100 or click the arrows to select a new value, and then click Apply.



Charcoal Thickness slider
Determines the amount of thickness to apply the Charcoal effect with. Move the slider to the right to 
increase charcoal thickness or left to decrease it, and then click Apply.



Charcoal Thickness box
Specifies the degree of thickness to apply the Charcoal effect with. The default value is 1; the 
maximum value is 7. To change the value, select the current value and type a number between 1 and 
7 or click the arrows to select a new value, and then click Apply.



Detail slider
Adjusts the degree of detail with which the Charcoal effect is applied. Move the slider to alter the 
degree of detail, and then click Apply.



Detail box
Specifies the degree of detail with which the Charcoal effect is applied. The default value is 5, which 
is the maximum value. To change the value, select the current value and type a number between 0 
and 5 or click the arrows to select a new value, and then click Apply.



Light/Dark Balance slider
Lightens or darkens the Charcoal effect. Move the slider to the left to lighten the effect or move the 
slider to the right to darken the effect, and then click Apply.



Light/Dark Balance box
Specifies the balance between the lightness and darkness controls of the Charcoal effect. Higher 
values darken the effect. The default value is 50, the maximum value is 100. Values below 50 lightens
the effect; values above 50 darkens the effect. To change the value, select the current value and type 
a number between 0 and 100 or click the arrows to select a new value, and then click Apply.



Pencil Width slider
Adjusts the width of the pencil stroke for the Colored Pencil effect. Move the slider to alter the width, 
then slick Apply.



Pencil Width box
Specifies the width of the pencil stroke for the Colored Pencil effect. Higher values create broader 
strokes. The default value is 4. To change the value, select the current value and type a number 
between 1 and 24 or click the arrows to select a new value, and then click Apply.



Stroke Pressure slider
Adjusts the pencil stroke pressure. Move the slider to alter Stroke Pressure, and then click Apply.



Stroke Pressure box
Specifies the pencil stroke pressure. Higher values create strokes that appear to be applied with 
greater pressure. The default value is 8. To change the value, select the current value and type a 
number between 0 and 15 or click the arrows to select a new value, and then click Apply.



Paper Brightness slider
Adjusts the shade of gray background paper for the Colored Pencil effect. Move the slider to alter the
brightness of the background paper, and then click Apply.



Paper Brightness box
Specifies the degree of brightness of the gray background paper for the Colored Pencil effect. Higher
values create darker shades of gray. The default value is 25. To change the value, select the current 
value and type a number between 0 and 50 or click the arrows to select a new value, and then click 
Apply.



Stroke Length slider
Adjusts the stroke length of the Rough Pastels effect. Dragging the slider to the right creates longer 
strokes. Move the slider to alter the length of the stroke on the current sprite, and then click Apply.



Stroke Length box
Specifies the stroke length value of the Rough Pastels effect. Higher values create longer pastel 
strokes. The default value is 6. To change the value, select the current value and type a number 
between 0 and 40 or click the arrows to select a new value, and then click Apply.



Stroke Detail slider
Adjusts the stroke detail of the Rough Pastels effect. Move the slider to alter the stroke detail, and 
then click Apply.



Stroke Detail box
Specifies the stroke detail value of the Rough Pastels effect. Higher values create longer pastel 
strokes. The maximum value is 20; the default value is 4. To change the value, select the current 
value and type a number between 1 and 20 or click the arrows to select a new value, and then click 
Apply.



Foreground Level slider
Adjusts the Foreground Level of the Conté Crayon effect. This effect redraws the opaque pixels of 
the current spite with a highly-textured crayon effect using the current color in the Color Picker. Move
the slider to alter the color coverage level, and then click Apply.



Foreground Level box
Specifies the Foreground Level value of the Conté Crayon effect. This effect redraws the opaque 
pixels of the current spite with a highly-textured crayon effect using the current color in the Color 
Picker. Higher values create heavier color coverage. The maximum value is 15; the default value is 
11. Higher Foreground Level values create heavier color coverage. To change the value, select the 
current value and type a number between 1 and 15 or click the arrows to select a new value, and then
click Apply.



Background Level slider
Adjusts the Background Level of the Conté Crayon effect. This effect redraws the opaque pixels of 
the current spite with a highly-textured crayon effect using the current color in the Composition 
Guide. Move the slider to alter the color coverage level, and then click Apply.



Background Level box
Specifies the Background Level value of the Conté Crayon effect. This effect redraws the opaque 
pixels of the current spite with a highly-textured crayon effect using the current color in the 
Composition Guide. Higher values create heavier color coverage. The maximum value is 15; the 
default value is 7. Higher Background Level values create heavier color coverage. To change the 
value, select the current value and type a number between 1 and 15 or click the arrows to select a 
new value, and then click Apply.



Stroke Length slider
Adjusts the stroke length of the Crosshatch effect. Move the slider to alter the stroke length, and then
click Apply.



Stroke Length box
Specifies the stroke length value of the Crosshatch effect. Higher values create longer strokes. The 
maximum value is 50; the default value is 9. To change the value, select the current value and type a 
number between 3 and 50 or click the arrows to select a new value, and then click Apply.



Sharpness slider
Adjusts the sharpness and detail of the Crosshatch effect. Move the slider to alter the sharpness, 
and then click Apply.



Sharpness box
Specifies the sharpness value of the Crosshatch effect. Higher values create a sharper, more 
detailed effect. The maximum value is 20; the default value is 6. To change the value, select the 
current value and type a number between 0 and 20 or click the arrows to select a new value, and then
click Apply.



Strength slider
Adjusts the strength of the Crosshatch effect by adjusting the number of times the effect is applied in 
succession. Move the slider to alter the number of times the effect is applied, and then click Apply.



Strength box
Specifies the number of times the Crosshatch effect is applied in succession, which strengthens the 
effect. A higher value creates a stronger effect. The maximum value is 3; the default value is 1. To 
change the value, select the current value and type a number between 1 and 3 or click the arrows to 
select a new value, and then click Apply.



Direction Balance slider
Adjusts the proportion of right diagonal strokes with left diagonal strokes. Move the slider to alter the 
balance, and then click Apply.



Direction Balance box
Specifies the middle value between right diagonal strokes with left diagonal strokes. Higher values 
affect larger areas of the current sprite. The default value is 500. To change the value, select the 
current value and type a number between 0 and 100 or click the arrows to select a new value, and 
then click Apply.



Stroke Length slider
Adjusts the stroke length of the Angled Strokes effect. Move the slider to alter the stroke length, and 
then click Apply.



Stroke Length box
Specifies the stroke length value of the Angled Strokes effect. Higher values create longer strokes. 
The maximum value is 50; the default value is 15. To change the value, select the current value and 
type a number between 3 and 50 or click the arrows to select a new value, and then click Apply.



Sharpness slider
Adjusts the sharpness and detail of the Angled Strokes effect. Move the slider to alter the sharpness,
and then click Apply.



Sharpness box
Specifies the sharpness value of the Angled Strokes effect. Low values create a soft effect. Higher 
values create sharper, more detailed effects. The maximum value is 10; the default value is 3. To 
change the value, select the current value and type a number between 0 and 10 or click the arrows to
select a new value, and then click Apply.



Stroke Length slider
Adjusts the stroke length of the Smudge Stick effect. Move the slider to alter the smudge stroke 
length, and then click Apply.



Stroke Length box
Specifies the stroke length value of the Smudge Stick effect. Higher values create longer smudge 
strokes. The maximum value is 10; the default value is 2. To change the value, select the current 
value and type a number between 0 and 10 or click the arrows to select a new value, and then click 
Apply.



Highlight Area slider
Adjusts the area of highlight of the Smudge Stick effect. Move the slider to alter the highlight area, 
and then click Apply.



Highlight Area box
Specifies the highlight area value of the Smudge Stick effect. Higher values create larger areas of 
brightness. The maximum value is 20; the default value is 0. To change the value, select the current 
value and type a number between 0 and 20 or click the arrows to select a new value, and then click 
Apply.



Highlight Intensity slider
Adjusts how much of the brightened sprite is blended into the original sprite. Move the slider to the left
to increase the transparency of the brightened sprite, so that more of the original sprite shows 
through. To have less of the original sprite shows through, move the slider toward the right to increase
the opacity of the brightened sprite. When you are done, click Apply.



Highlight Intensity box
Specifies how much of the brightened sprite is blended into the original sprite. Higher values increase 
the opacity of the brightened sprite (less of the original sprite shows through), and lower values 
increase the transparency of the brightened sprite (more of the original sprite shows through). To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Stroke Length slider
Adjusts the stroke length of the Ink Outlines effect. Move the slider to alter the stroke length, and 
then click Apply.



Stroke Length box
Specifies the stroke length value of the Ink Outlines effect. Higher values create longer strokes. The 
maximum value is 50; the default value is 4. To change the value, select the current value and type a 
number between 1 and 50 or click the arrows to select a new value, and then click Apply.



Dark Intensity slider
Adjusts the darkness of the darker tones in the Ink Outlines effect. Move the slider to alter the 
intensity of the dark tones, and then click Apply.



Dark Intensity box
Specifies the value of the dark tones in the Ink Outlines effect. Higher values create darker dark 
tones. The maximum value is 50; the default value is 20. To change the value, select the current value
and type a number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Light Intensity slider
Adjusts the lightness of the lighter tones in the Ink Outlines effect. Move the slider to alter the 
intensity of the light tones, and then click Apply.



Light Intensity box
Specifies the value of the light tones in the Ink Outlines effect. Higher values create lighter light 
tones. The maximum value is 50; the default value is 10. To change the value, select the current value
and type a number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Image Balance slider
Adjusts the background color in proportion to the white foreground. Move the Image Balance slider to
the right for deeper background color; move it to the left for more foreground white. When you are 
done, click Apply.



Image Balance box
Specifies the proportion value of background color to the white foreground. The default value is 25. 
Values from 26 to 50 deepen the background color, while values from 0 to 24 brighten the foreground.
To change the value, select the current value and type a number between 0 and 50 or click the arrows
to select a new value, and then click Apply.



Graininess slider
Adjusts the graininess of the Note Paper effect. Move the slider to alter the graininess of the paper, 
and then click Apply.



Graininess box
Specifies the graininess value of the Note Paper effect. The default value is 10. To change the value, 
select the current value and type a number between 0 and 20 or click the arrows to select a new 
value, and then click Apply.



Relief slider
Adjusts the amount of relief (contrast due to texture) in the Note Paper effect. Move the slider to alter 
the amount of relief, and then click Apply.



Relief box
Specifies the relief value (the amount of contrast due to texture) in the Note Paper effect. The default 
value is 11. To change the value, select the current value and type a number between 0 and 25 or 
click the arrows to select a new value, and then click Apply.



No. of Levels slider
Adjusts the level of detail and color in the Cutout effect. Move the slider to alter the number of levels 
of color and detail, and then click Apply.



No. of Levels box
Specifies the number of levels of detail and color in the Cutout effect. The default value is 4. To 
change the value, select the current value and type a number between 2 and 8 or click the arrows to 
select a new value, and then click Apply.



Edge Simplicity slider
Adjusts the level of edge simplicity in the Cutout effect. Less edge simplicity means less detail in the 
Cutout effect. Move the slider to alter the level of edge simplicity, and then click Apply.



Edge Simplicity box
Specifies the level of edge simplicity in the Cutout effect. Higher values create more simplicity and 
less detail. The default value is 4. To change the value, select the current value and type a number 
between 0 and 10 or click the arrows to select a new value, and then click Apply.



Edge Fidelity slider
Adjusts the level of edge fidelity in the Cutout effect. This effect determines how closely the effect 
follows the original contours of the current sprite. Move the slider to alter the level of edge fidelity, and 
then click Apply.



Edge Fidelity box
Specifies the level of edge fidelity in the Cutout effect. Higher values create edge contours that 
closely resemble those of the original sprite. The default value is 2. To change the value, select the 
current value and type a number between 1 and 3 or click the arrows to select a new value, and then 
click Apply.



Cell Size slider
Adjusts the size of the individual “pieces,” or cells, in the Stained Glass effect. Move the slider to alter
the cell size, and then click Apply.



Cell Size box
Specifies the size value of the individual pieces, or cells, in the Stained Glass effect. The default 
value is 10. To change the value, select the current value and type a number between 1 and 50 or 
click the arrows to select a new value, and then click Apply.



Border Thickness slider
Adjusts the thickness of the cell borders in the Stained Glass effect. Move the slider to alter the cell 
border thickness, and then click Apply.



Border Thickness box
Specifies the border thickness value of the individual pieces, or cells, in the Stained Glass effect. The
default value is 4. To change the value, select the current value and type a number between 1 and 20 
or click the arrows to select a new value, and then click Apply.



Light Intensity slider
Adjusts the intensity of the back light that shines through the stained glass in the Stained Glass 
effect. Move the slider to alter the light’s intensity, and then click Apply.



Light Intensity box
Specifies the intensity value of the back light of the Stained Glass effect. The default value is 3. To 
change the value, select the current value and type a number between 0 and 10 or click the arrows to
select a new value, and then click Apply.



Size slider
Adjusts the size of the screen in the Halftone Screen effect. An example of a halftone screen effect is
the simulated dot pattern of a photograph that has been screened for reproduction in a newspaper or 
magazine. Move the slider to alter the size of the Halftone Screen effect, and then click Apply.



Size box
Specifies the size value of the Halftone Screen effect. An example of a halftone screen effect is the 
simulated dot pattern of a photograph that has been screened for reproduction in a newspaper or 
magazine. The default value is 1. To change the value, select the current value and type a number 
between 1 and 12 or click the arrows to select a new value, and then click Apply.



Screen Type list
Displays a list of halftone screen effect options: Circle, Dot, or Line. On the list, click the Screen 
Type option you want, and then click Apply.



Contrast slider
Adjusts the contrast between light and dark halftones. Move the Contrast slider to the right to 
increase the contrast, and then click Apply.



Contrast box
Specifies the contrast value between light and dark halftones. Higher contrast values create brighter 
highlights and darker dark tones. The default value is 5. To change the value, select the current value 
and type a number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Square Size slider
Adjusts the size of the square pattern of the Patchwork effect. Move the Square Size slider to alter 
the size of the pattern, and then click Apply.



Square Size box
Specifies the size value of the Square Size effect. Higher values create larger square patterns on the 
current sprite. The default value is 4. To change the value, select the current value and type a number
between 0 and 10 or click the arrows to select a new value, and then click Apply.



Relief slider
Adjusts the amount of relief (contrast due to the projection of the patchwork pattern) in the Patchwork
effect. Move the slider to alter the amount of relief, and then click Apply.



Relief box
Specifies the relief value (the amount of contrast due to the projection of the patchwork pattern) in the
Note Paper effect. The default value is 8. To change the value, select the current value and type a 
number between 0 and 25 or click the arrows to select a new value, and then click Apply.



Light/Dark Balance slider
Lightens or darkens the Stamp effect. This effect makes the current sprite appear to have been 
stamped with a rubber or wooden stamp. Move the slider to the left to lighten the effect and provide 
less detail. Move the slider to the right to give a darker, heavier, more detailed effect. When you are 
done, click Apply.



Light/Dark Balance box
Specifies the balance between the values of lightness and darkness of the Stamp effect. This effect 
makes the current sprite appear to have been stamped with a rubber or wooden stamp. The default 
value is 25. Values below 25 lighten the effect and provide less detail. Values above 25 darken and 
provide more detail. To change the value, select the current value and type a number between 0 and 
50 or click the arrows to select a new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Stamp effect. Move the slider to the right for smoother, less 
defined contours. To alter the smoothness of the current sprite, move the slider and click Apply.



Smoothness box
Specifies the smoothness value of the Stamp effect. A low value creates a more detailed effect. A 
high value creates smooth, rounded contours. The default value is 5. To change the value, select the 
current value and type a number between 1 and 50 or click the arrows to select a new value, and then
click Apply.



Detail slider
Adjusts the amount of detail and halftones of the Photocopy effect. Move the slider to alter the 
amount of detail and halftones, and then click Apply.



Detail box
Specifies the value for detail and halftone definition for the Photocopy effect. Higher values create 
more detail and a broader range of halftones. The default value is 7. To change the value, select the 
current value and type a number between 1 and 24 or click the arrows to select a new value, and then
click Apply.



Darkness slider
Adjusts the proportion of dark halftones to light halftones. Move the slider to the right to create darker,
denser-looking halftones, and then click Apply.



Darkness box
Specifies the Darkness value of the Photocopy effect. Higher values create darker, denser-looking 
halftones. The default value is 8. To change the value, select the current value and type a number 
between 1 and 50 or click the arrows to select a new value, and then click Apply.



Edge Thickness slider
Adjusts the edge thickness of the Poster Edges effect, which reduces the number of color shades in 
the sprite and adds dark lines along the edges. Move the slider to alter the proportions, and then click 
Apply.



Edge Thickness box
Specifies the Edge Thickness value of the Poster Edges effect, which reduces the number of color 
shades in the sprite and adds dark lines along the edges. The default value is 2. To change the value,
select the current value and type a number between 0 and 10 or click the arrows to select a new 
value, and then click Apply.



Edge Intensity slider
Adjusts the intensity of the dark lines that are applied to the edges and ridges of the current sprite 
with the Poster Edges effect. Move the slider to alter the edge intensity, and then click Apply.



Edge Intensity box
Specifies the Edge Intensity value of the Poster Edges effect. This value determines the degree of 
intensity of the dark lines that are applied to the edges and ridges of the current sprite. The default 
value is 1. To change the value, select the current value and type a number between 0 and 10 or click
the arrows to select a new value, and then click Apply.



Posterization slider
Adjusts the number of colors or halftones applied to the current sprite with the Poster Edges effect. 
Move the slider to the right to increase the colors and halftones, and then click Apply.



Posterization box
Specifies the Posterization value of the Poster Edges effect. Higher values apply more color and 
halftones to the current sprite when the Poster Edges effect is applied. The default value is 2. To 
change the value, select the current value and type a number between 0 and 6 or click the arrows to 
select a new value, and then click Apply.



Density slider
Adjusts the stippling density of the Reticulation effect. Move the slider to the right for denser 
stippling, and then click Apply.



Density box
Specifies the stippling density value of the Reticulation effect. Higher values create a denser 
stippling effect. The default value is 12. To change the value, select the current value and type a 
number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Black Level slider
Adjusts the amount of dark areas on the current sprite, which is then covered with the appearance of 
dense clumps of emulsion that occurs with the Reticulation effect. Move the slider to adjust the 
amount of dark area, and then click Apply.



Black Level box
Specifies the Black Level value of the Reticulation effect. Higher values create more dark areas with
the appearance of dense clumps of emulsion. The default value is 40. To change the value, select the
current value and type a number between 0 and 50 or click the arrows to select a new value, and then
click Apply.



White Level slider
Adjusts the light areas of the current sprite, which is then covered with the appearance of stippling 
that occurs with the Reticulation effect. Move the slider to adjust the amount of light area, and then 
click Apply.



White Level box
Specifies the White Level value of the Reticulation effect. Higher values create more light areas with
the appearance of stippling. The default value is 5. To change the value, select the current value and 
type a number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Image Balance slider
Adjusts the proportion of foreground prominence to background. Move the slider toward the right to 
cause the sprite to appear as foreground. Move it to the left to cause the sprite to appear as 
background. When you are done, click Apply.



Image Balance box
Specifies the proportion value of foreground prominence to background. The default value is 25. 
Values from 26 to 50 cause the current sprite to appear as foreground; values from 1 to 24 cause the 
current sprite to appear as background. To change the value, select the current value and type a 
number between 0 and 50 or click the arrows to select a new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Torn Edges effect. Move the slider to the right for a smoother 
appearance, and then click Apply.



Smoothness box
Specifies the smoothness value of the Torn Edges effect. A low value creates a more detailed effect. 
A high value creates smooth, rounded contours. The default value is 11. To change the value, select 
the current value and type a number between 1 and 15 or click the arrows to select a new value, and 
then click Apply.



Contrast slider
Adjusts the amount of contrast between light and dark tones. Move the slider to the right to increase 
the contrast, and then click Apply.



Contrast box
Specifies the contrast value between light and dark tones. Higher contrast values create brighter 
highlights and darker dark tones. The default value is 17. To change the value, select the current 
value and type a number between 1 and 25 or click the arrows to select a new value, and then click 
Apply.



Detail slider
Adjusts the amount of detail applied with the Chrome effect. Higher values create a more intricate, 
shimmering effect. Move the slider to alter the amount of detail, and then click Apply.



Detail box
Specifies the degree of detail applied with the Chrome effect. The default value is 4. To change the 
value, select the current value and type a number between 0 and 10 or click the arrows to select a 
new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Chrome effect. Move the slider to alter the appearance of 
smoothness, and then click Apply.



Smoothness box
Specifies the smoothness value of the Chrome effect. A low value creates a more detailed effect. A 
high value creates smooth, rounded contours. The default value is 7. To change the value, select the 
current value and type a number between 0 and 10 or click the arrows to select a new value, and then
click Apply.



Distortion slider
Adjusts the degree of distortion applied with the selected glass surface of the Glass effect. Move the 
slider to the right to increase the amount of distortion caused by the selected glass surface, and then 
click Apply.



Distortion box
Specifies the value of the degree of distortion applied with the selected glass surface of the Glass 
effect. Higher values create greater levels of distortion. The default value is 5. To change the value, 
select the current value and type a number between 0 and 20 or click the arrows to select a new 
value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the selected glass surface of the Glass effect. Move the slider to 
alter the appearance of smoothness, and then click Apply.



Smoothness box
Specifies the smoothness value of the selected glass surface of the Glass effect. A low value creates 
a more detailed effect. A high value creates a smoother, less detailed effect. The default value is 3. To 
change the value, select the current value and type a number between 1 and 15 or click the arrows to
select a new value, and then click Apply.



Surface Controls button
Displays the Glass Surface Controls dialog box, which contains the Type, Scaling, and Invert 
Surface controls.



Type list
Displays a list of glass surface options: Blocks, Canvas, Frosted, Tiny Lens, or TIFF File. Click the 
glass surface type you want.



Scaling (%) slider
Adjusts the scale, or size, of the selected glass type. Move the slider to alter the scaling of the 
selected glass type, and then click Apply.



Scaling (%) box
Specifies the percentage of glass type scaling you can apply to the current sprite. Higher scaling 
values create larger effects. The default value is 100. To change the value, select the current value 
and type a number between 50 and 200 or click the arrows to select a new value, and then click 
Apply.



Invert Surface check box
When selected, this option inverts the effect of the selected glass surface option.



Detail slider
Adjusts the amount of detail of surface modulations of the Bas Relief effect. Move the slider to adjust 
the amount of detail visible with the effect, and then click Apply.



Detail box
Specifies the degree of detail of surface modulations applied with the Bas Relief effect. To change 
the value, select the current value and type a new number or click the arrows to set a new value, and 
then click Apply.



Light Position list
Displays a list of options that determine the position of a hypothetical light source, which determines 
where highlights and shadows appear on the current sprite. In the Light Position list, click the light 
position of your choice, and then click Apply.



Smoothness slider
Adjusts the overall smoothness of the surface of the Bas Relief effect. Move the slider to alter the 
appearance of smoothness, and then click Apply.



Smoothness box
Specifies the smoothness value of the surface of the Bas Relief effect. A low value creates a more 
textured, detailed effect. A high value creates a smoother, less detailed effect. To change the value, 
select the current value and type a new number or click the arrows to set a new value, and then click 
Apply.



Edge Width slider
Adjusts the width of the edges of the current sprite when the Glowing Edges effect is applied. The 
edges appear in bright, glowing colors. Move the slider to adjust the edge width, and then click Apply.



Edge Width box
Specifies the current edge width value of the Glowing Edges effect. Higher values create broader, 
glowing edges. To change the value, select the current value and type a new number or click the 
arrows to set a new value, and then click Apply.



Edge Brightness slider
Adjusts the brightness of the edges of the current sprite when the Glowing Edges effect is applied. 
Move the slider to adjust the edge brightness, and then click Apply.



Edge Brightness box
Specifies the current edge brightness value of the Glowing Edges effect. Higher values create 
broader glowing edges. To change the value, select the current value and type a new number or click 
the arrows to set a new value, and then click Apply.



Smoothness slider
Adjusts the overall smoothness and degree of detail of the Glowing Edges effect. To alter the 
smoothness and detail of the current sprite, move the slider and click Apply.



Smoothness box
Specifies the smoothness value of the Glowing Edges effect. A low value creates a more detailed 
effect. A high value creates smooth, rounded contours. To change the value, select the current value 
and type a new number or click the arrows to set a new value, and then click Apply.



Image Balance slider
Adjusts the proportion of low areas to high areas within the three-dimensional Plaster effect. Move 
the slider to the right for more low areas; move it to the left for more high areas. When you are done, 
click Apply.



Image Balance box
Specifies the proportion value of low areas to high areas within the three-dimensional Plaster effect. 
Higher values increase the proportion of low areas to high areas, while lower values increase the 
proportion of high areas to low areas. To change the value, select the current value and type a new 
number or click the arrows to set a new value, and then click Apply.



Light Position list
Displays a list of options that determine the position of a hypothetical light source, which determines 
where highlights and shadows appear on the current sprite when the Plaster effect is applied. In the 
Light Position list, click the light position of your choice, and then click Apply



Smoothness slider
Adjusts the overall smoothness and degree of detail of the Plaster effect. To alter the smoothness 
and detail of the current sprite, move the slider and click Apply.



Smoothness box
Specifies the smoothness value of the Plaster effect. A low value creates a more detailed effect. A 
high value creates smooth, rounded contours. To change the value, select the current value and type 
a new number or click the arrows to set a new value, and then click Apply.



Tile Size slider
Adjusts the size of the tiles applied to the current sprite by means of the Mosaic effect. Move the 
slider to alter the tile size, and then click Apply.



Tile Size box
Specifies the tile size value of the Mosaic effect. Higher values create the appearance of larger tiles. 
To change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Grout Width slider
Adjusts the amount of space between the tiles when the Mosaic effect is applied to the current sprite. 
Move the slider to alter the grout width, and then click Apply.



Grout Width box
Specifies the grout width value of the Mosaic effect. Higher values create the appearance of wider 
grout lines. To change the value, select the current value and type a new number or click the arrows 
to set a new value, and then click Apply.



Lighten Grout slider
Adjusts the brightness of the space between the tiles when the Mosaic effect is applied to the current 
sprite. Move the slider to alter the brightness of the grout, and then click Apply.



Lighten Grout box
Specifies the grout lightness value of the Mosaic effect. Higher values create the appearance of 
lighter grout lines. To change the value, select the current value and type a new number or click the 
arrows to set a new value, and then click Apply.



Ripple Size slider
Adjusts the size of the ripples when the Ripple effect is applied to the current sprite. This effect adds 
randomly-spaced ripples to the sprite's surface, making the sprite appear as if it were under water. 
Move the slider to alter the size of the ripples, and then click Apply.



Ripple Size box
Specifies the size value of the ripples when the Ripple effect is applied to the current sprite. This 
effect adds randomly-spaced ripples to the sprite's surface, making the sprite appear as if it were 
under water. Higher values create the appearance of larger ripples. To change the value, select the 
current value and type a new number or click the arrows to set a new value, and then click Apply.



Ripple Magnitude slider
Adjusts the amount of distortion to the current sprite when the Ripple effect is applied. This effect 
adds randomly spaced ripples to the sprite's surface, making the sprite appear as if it were under 
water. Move the slider to alter the degree of distortion, and then click Apply.



Ripple Magnitude box
Specifies the distortion value of the current sprite when the Ripple effect is applied. This effect adds 
randomly spaced ripples to the sprite's surface, making the sprite appear as if it were under water. 
Higher values create more ripples, which further distorts the appearance of the sprite. To change the 
value, select the current value and type a new number or click the arrows to set a new value, and 
then click Apply.



Highlight Strength slider
Adjusts the intensity of reflected light on the current sprite when the Plastic Wrap effect is applied. 
This effect makes the sprite appear as though it is coated with shiny, clear plastic wrap. Move the 
slider to alter the intensity of reflected highlights, and then click Apply.



Highlight Strength box
Specifies the highlight value of the Plastic Wrap effect. This effect makes the sprite appear as though
it is coated with shiny, clear plastic wrap. To change the value, select the current value and type a 
new number or click the arrows to set a new value, and then click Apply.



Detail slider
Adjusts the degree of detail and quantity of highlights to the current sprite when the Plastic Wrap 
effect is applied. This effect makes the sprite appear as though it is coated with shiny, clear plastic 
wrap. Move the slider to alter the quantity of reflected highlights, and then click Apply.



Detail box
Specifies the detail and highlight value when the Plastic Wrap effect is applied to the current sprite. 
This effect makes the sprite appear as though it is coated with shiny, clear plastic wrap. To change the
value, select the current value and type a new number or click the arrows to set a new value, and 
then click Apply.



Smoothness slider
Adjusts the overall smoothness of the Plastic Wrap effect. This effect makes the sprite appear as 
though it is coated with shiny, clear plastic wrap. Move the slider to the right for smoother, less defined
contours. To alter the smoothness of the current sprite, move the slider and click Apply.



Smoothness box
Specifies the smoothness value of the Plastic Wrap effect. This effect makes the sprite appear as 
though it is coated with shiny, clear plastic wrap. Higher values create a less detailed, smoother 
highlight effect. To change the value, select the current value and type a new number or click the 
arrows to set a new value, and then click Apply.



Crack Spacing slider
Adjusts the spacing between the cracks that appear when the Craquelure effect is applied to the 
current sprite. This effect makes the sprite appear to have been painted onto a high-relief plaster 
surface, producing a fine network of cracks that follow the contours of the sprite. Move the slider to 
alter the size of the spaces between the cracks, and then click Apply.



Crack Spacing box
Specifies the value that determines the amount of spacing between the cracks when the Craquelure 
effect is applied to the current sprite. This effect makes the sprite appear to have been painted onto a 
high-relief plaster surface, producing a fine network of cracks that follow the contours of the sprite. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Crack Depth slider
Adjusts the depth of the cracks that appear when the Craquelure effect is applied to the current 
sprite. This effect makes the sprite appear to have been painted onto a high-relief plaster surface, 
producing a fine network of cracks that follow the contours of the sprite. Move the slider to alter the 
depth of the cracks, and then click Apply.



Crack Depth box
Specifies the value that determines the depth of the cracks that appear when the Craquelure effect is
applied to the current sprite. This effect makes the sprite appear to have been painted onto a high-
relief plaster surface, producing a fine network of cracks that follow the contours of the sprite. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Crack Brightness slider
Adjusts the brightness of the cracks that appear when the Craquelure effect is applied to the current 
sprite. This effect makes the sprite appear to have been painted onto a high-relief plaster surface, 
producing a fine network of cracks that follow the contours of the sprite. Move the slider to alter the 
brightness of the cracks, and then click Apply.



Crack Brightness box
Specifies the value that determines the brightness of the cracks that appear when the Craquelure 
effect is applied to the current sprite. This effect makes the sprite appear to have been painted onto a 
high-relief plaster surface, producing a fine network of cracks that follow the contours of the sprite. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Relief slider
Adjusts the degree of relief (contrast due to texture) applied to the current sprite with the Emboss 
effect. This effect makes the sprite appear as though its surface elements have been raised and lit 
from a specific direction, giving it a three-dimensional appearance. Move the slider to alter the degree
of relief, and then click Apply.



Relief box
Specifies the value that determined the degree of relief (contrast due to texture) applied to the current
sprite with the Emboss effect. This effect makes the sprite appear as though its surface elements 
have been raised and lit from a specific direction, giving it a three-dimensional appearance. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Light Position list
Displays a list of options that determine the position of a hypothetical light source, which determines 
where highlights and shadows appear on the current sprite. In the Light Position list, click the light 
position of your choice, and then click Apply.



Texture Controls button
Displays the Texture Controls dialog box, which contains the Type, Light Position, Scaling, Relief, 
and Invert Texture controls.



Type list
Displays a list of texture options: Brick, Burlap, Canvas, Sandstone, and TIFF File. Click to select 
the texture option you want. When you are finished changing your options, click OK.



Light Position list
Displays a list of options that determine the position of a hypothetical light source, which determines 
where highlights and shadows appear on the current sprite. In the Light Position list, click the light 
position of your choice. When you are finished changing your options, click OK.



Scaling (%) slider
Adjusts the scale, or size, of the texture effect in the Type list. Move the slider to alter the scaling of 
the current texture. When you are finished changing your options, click OK.



Scaling (%) box
Specifies the percentage of scaling of the texture in the Type list that you can apply to the current 
sprite. Higher scaling values create larger effects. To change the value, select the current value and 
type a new number or click the arrows to set a new value. When you are finished changing your 
options, click OK.



Relief slider
Adjusts the amount of relief (contrast due to texture) applied in the Texturizer effect. Move the slider 
to alter the amount of relief. When you are finished changing your options, click OK.



Relief box
Specifies the relief value (amount of contrast due to texture) applied in the Texturizer effect. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value. When you are finished changing your options, click OK.



Invert Texture
When selected, this option inverts the effect of the texture selected in the Type list option. When you 
are finished changing your options, click OK.



Graininess slider
Adjusts the graininess of the Grain effect. This effect provides a wide variety of grain types that you 
can apply to the current sprite. Move the slider to alter the degree of graininess, and then click Apply.



Graininess box
Specifies the graininess value of the Grain effect. This effect provides a wide variety of grain types 
that you can apply to the current sprite. To change the value, select the current value and type a new 
number or click the arrows to set a new value, and then click Apply.



Grain Type list
Displays a list of grain type options: Regular, Soft, Sprinkles, Clumped, Contrasty, Enlarged, 
Stippled, Horizontal, Vertical, and Speckle.



Contrast slider
Adjusts the contrast of the Grain effect. Move the slider to the to increase or decrease the amount of 
contrast, and then click Apply.



Contrast box
Specifies the contrast value of the Grain effect. Higher values create brighter highlights and darker 
dark tones. To change the value, select the current value and type a new number or click the arrows 
to set a new value, and then click Apply.



Grain slider
Adjusts the degree of graininess to the Film Grain effect. This effect adds a film grain-like texture to 
the current sprite. Move the slider to alter the degree of graininess, and then click Apply.



Grain box
Specifies the Grain value of the Film Grain effect. This effect adds a film grain-like texture to the 
current sprite. Higher values creates a coarser grain density. To change the value, select the current 
value and type a new number or click the arrows to set a new value, and then click Apply.



Highlight Area slider
Adjusts the volume of highlight of the Film Grain effect. Move the slider to alter the amount of 
highlight area, and then click Apply.



Highlight Area box
Specifies the highlight area value of the Film Grain effect. This effect adds a film grain-like texture to 
the selected sprite. Higher values create larger areas of highlight. To change the value, select the 
current value and type a new number or click the arrows to set a new value, and then click Apply.



Highlight Intensity slider
Adjusts the intensity of the highlights of the Film Grain effect. This effect adds a film grain-like texture
to the selected sprite. Move the slider to alter the intensity of the highlights, and then click Apply.



Highlight Intensity box
Specifies the value of the degree of highlight intensity of the Film Grain effect. This effect adds a film 
grain-like texture to the selected sprite. Higher values create brighter, more intense highlights. To 
change the value, select the current value and type a new number or click the arrows to set a new 
value, and then click Apply.



Graininess slider
Adjusts the degree of graininess applied with the Diffuse Glow effect. This effect makes the current 
sprite look as if it were viewed through a soft diffusion filter. Move the slider to alter the degree of 
graininess, and then click Apply.



Graininess box
Specifies the graininess value applied with the Diffuse Glow effect. This effect makes the current 
sprite look as if it were viewed through a soft diffusion filter. To change the value, select the current 
value and type a new number or click the arrows to set a new value, and then click Apply.



Glow Amount slider
Adjusts the amount of diffused glow applied with the Diffuse Glow effect. This effect makes the 
current sprite look as if it were viewed through a soft diffusion filter. Move the slider to alter the 
amount of glow, and then click Apply.



Glow Amount box
Specifies the diffused glow value applied with the Diffuse Glow effect. This effect makes the current 
sprite look as if it were viewed through a soft diffusion filter. To change the value, select the current 
value and type a new number or click the arrows to set a new value, and then click Apply.



Clear Amount slider
Adjusts the amount of diffused highlights applied with the Diffuse Glow effect. This effect makes the 
current sprite look as if it were viewed through a soft diffusion filter. Move the slider to alter the 
quantity of diffused highlights, and then click Apply.



Clear Amount box
Specifies the diffused highlight value applied with the Diffuse Glow effect. This effect makes the 
current sprite look as if it were viewed through a soft diffusion filter. Higher values result in less 
diffused highlights, while a setting of 1 replaces all color pixels with white. To change the value, select 
the current value and type a new number or click the arrows to set a new value, and then click Apply.



Glow Size slider
Adjusts the type and degree of glow applied with Neon Glow effect. This effect can be used to create 
neon lighting effects or to give an object the appearance that it is radiating both light and heat. Moving
the slider to the right creates glows on the outside of dark objects and on the inside of light objects, 
while moving the slider to the left creates glows on the inside of dark objects and the outside of light 
objects. Move the slider to alter the type and degree of glow, and then click Apply.



Glow Size box
Specifies a positive or negative value applied with the Neon Glow effect. Positive values create glows
on the outside of dark objects and on the inside of light objects, while negative values create glows on
the inside of dark objects and the outside of light objects. The greater the setting (positive or 
negative), the larger the glow effect. To change the value, select the current value and type a new 
number or click the arrows to set a new value, and then click Apply.



Glow Brightness slider
Adjusts the intensity of the glow that is applied with the Neon Glow effect. This effect adds various 
types of glows to the objects in a selection. It can be used to create neon lighting effects or to give an 
object the appearance that it is radiating light and heat. Move the slider to alter the intensity of the 
glow, and then click Apply.



Glow Brightness box
Specifies the value of the brightness or intensity of the glow applied with the Neon Glow effect. This 
effect adds various types of glows to the objects in a selection. It can be used to create neon lighting 
effects or to give an object the appearance that it is radiating light and heat. To change the value, 
select the current value and type a new number or click the arrows to set a new value, and then click 
Apply.



Glow Color button
Displays the Color Picker dialog box.



OK
Closes this dialog box and saves any changes you have made.



Cancel
Closes this dialog box without saving any changes you have made.



Fit Bounding Box
Automatically sizes the bounding box to the extent of the shape of the current sprite. Under some 
circumstances, the bounding box becomes larger that the shape of a sprite, leaving a margin of clear 
pixels. Click Fit Bounding Box to reduce the bounding box to contain the shape of the current sprite 
without a margin of clear pixels.



Crop/Extend
Increases or decreases the size of the current bounding box; does not affect the size of the opaque 
area of the current sprite. Reducing the bounding box lets you crop a portion of the sprite. Extending 
the bounding box lets you add a margin of clear pixels to the current sprite.



Units box
Specifies units of measurement displayed in the Height and Width boxes. Select one of these 
options:

· Pixels. This is the default unit of measurement. The Pixel option displays the size of the current 
bounding box in units of pixels.

· Percent. 100 is displayed in the Width or Height box. If you then change the size of the current 
bounding box, the box displays the percentage of change.



Width box
Displays the width of the current sprite’s bounding box. The method of measurement is determined by
the option selected in the Units box.



Height box
Displays the height of the current sprite’s bounding box. The method of measurement is determined 
by the option selected in the Units box.



Keep Aspect Ratio check box
When selected, this option maintains the ratio of height to width of the current sprite when you change
the size of the current sprite.



Rotation box
Specifies the number of degrees that you can rotate the current sprite. To change the value, either 
select the current value in the box and type a new value or click the arrows to increase or decrease 
the value. When you are done, click Apply.



Rotate
Displays controls to rotate a sprite at preset angles: right 90 degrees, left 90 degrees, and 180 
degrees (the black triangle is provided as a visual reference to indicate the starting position of the 
current sprite). Click the appropriate Rotate control to rotate the current sprite at a preset angle.



Flip
Displays controls with which you can flip a sprite: up, down, right, or left (the black triangle is provided
as a visual reference to indicate the starting position of the current sprite). Click the appropriate Flip 
control to flip the current sprite to the position you want.



Group
Collects all currently selected sprites into a group. Grouped sprites are treated as a single sprite by 
the functions that position or arrange a sprite within a composition.



Ungroup
Separates grouped sprites and places them in a selection set. If the current group consists of smaller 
groups, only one group is ungrouped. You can ungroup another level each time Ungroup is clicked.



Explode
Separates grouped sprites and places them in a selection set (like Ungroup), except that all levels of 
subgroups in a current group are ungrouped, leaving all of the individual sprites in a selection set.



Flatten Selection
Permanently converts all elements of a group or selection set into a single sprite, which then 
becomes the current sprite.



Set Home Position
Stores the position of the current sprite or group in the composition. After moving the sprite or group, 
you can restore the sprite or group to its original set position by clicking Return to Home Position.



Return to Home Position
Restores the current sprite or group to the position in the composition recorded with Set Home 
Position. If Set Home Position has not been applied to the current sprite or group, it is restored to 
the position at which it was created or the position at which it was loaded from disk.



Lock Position
Locks or unlocks the position of the current sprite. You cannot reposition a locked sprite until you 
unlock it by clicking Lock Position while the locked sprite is current.



Abut
Abuts (joins) the edges of two sprites: the current sprite and the target sprite.



Order
Displays a set of six controls with which you can change the level of the current sprite or group in the 
stack. The controls are Send Forward, Send Backward, Before, Behind, Bring to Front, and Send
to Back.



Align
Displays a set of controls that you can use to align two or more sprites. Methods of alignment include 
Tops, Bottoms, Left Sides, Right Sides, Centers Vertically, Centers Horizontally, Upper Left 
Corners, Upper Right Corners, Lower Left Corners, and Lower Right Corners.



Texture tools list
Lets you select the tool or set of tools with which you can add or edit a sprite’s texture.



Opacity slider
Adjusts the amount of opacity of the effect you want. Low opacity values create a more transparent 
effect, retaining more of the sprite's original look. High opacity values create more detailed, defined 
effects. You can move the slider to the left to decrease the amount of opacity, then click Apply.



Opacity box
Specifies the opacity value of the effect you want. Low opacity values create a more transparent 
effect, retaining more of the sprite's original look. High opacity values create more detailed, defined 
effects. To change the value, select the current value and type a number, or click the arrows to select 
a new value, then click Apply.



Color chip box, upper left
Displays one of the four colors of the Gradient Ramp. To adjust the color, you can click the chip box 
to display the Color Picker.



Color chip box, upper right
Displays one of the four colors of the Gradient Ramp. To adjust the color, you can click the chip box 
to display the Color Picker.



Color chip box, lower right
Displays one of the four colors of the Gradient Ramp. To adjust the color, you can click the chip box 
to display the Color Picker.



Color chip box, lower left
Displays one of the four colors of the Gradient Ramp. To adjust the color, you can click the chip box 
to display the Color Picker.



Gradient Ramp display box
Displays the color gradient blending of the four colors displayed in each of the color chip boxes at 
each corner of this box.



Ramp Name list
Displays a list of color ramps. Besides the color ramps that are shipped with Microsoft Image 
Composer, you can create your own. To change the current ramp, click the ramp you want on the 
Ramp Name list, then click Apply.



Sprite Texture Type list
Displays a list of textures that you can apply to a sprite. To change the texture of the current sprite, 
click the texture type you want on the Sprite Texture Type list, then click Apply.



Threshold
Specifies the threshold level for the Color Map or Intensity Map options on the Sprite Texture Type 
list. The value in the Threshold box determines the threshold at which the range of intensity affects 
the colors. After you have set the Threshold value, click Apply.

Threshold works this way: the color pixels in the current sprite that are above the current value are 
brightened by the intensities of the overlapping pixels of the source sprite. Those pixels in the current 
sprite that are below the current value are darkened by the corresponding pixels in the source sprite.

For example: if you set the Threshold value to 255, all color pixels in the current sprite are below the 
threshold and are darkened by the intensity values in the source sprite.



Intertile X
Specifies the horizontal spacing of the Tile effect. The value represents the number of pixels. For 
example, if the value in the Intertile X box is 60, space between tiled sprites is 60 pixels. To change 
the value, select the current value and type a number or click the arrows to select a new value, then 
click Apply.



Intertile Y
Specifies the vertical spacing of the Tile effect. The value represents the number of pixels between 
tiled sprites. For example, if the value in the Intertile Y box is 60, space between tiled sprites is 60 
pixels. To change the value, select the current value and type a number or click the arrows to select a 
new value, then click Apply.



Patterns list
Displays the Pattern options that you can use to fill a sprite. To choose a pattern, click the one you 
want on the list.



Height box
Specifies the pixel height of the Checkerboard orStripes pattern. To change the value, select the 
current value and type a number or click the arrows to select a new value, then click Apply.



Width box
Specifies the pixel height of the Checkerboard or Stripes pattern. To change the value, select the 
current value and type a number or click the arrows to select a new value, then click Apply.



Spacing box
Specifies the number of pixels between stripes. To change the value, select the current value and 
type a number or click the arrows to select a new value, then click Apply.



Save Ramp
Stores a custom ramp in the Ramp Name list. To save a custom ramp, select the current name in the 
Ramp Name list and type the name you want, then click Save.



Delete Ramp
Deletes a ramp in the Ramp Name list. To delete a ramp, select the ramp you want to delete in the 
Ramp Name list and then click Delete.



Pattern Preview
Displays an example of the current pattern on the Patterns list. To view a different pattern, click the 
Patterns list and then click the pattern you want.
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The Patterns and Fills palette contains tools for:

· Filling a sprite with color.
· Using one sprite to change the shape or appearance of another sprite.
· Filling a sprite with a pattern.
· Creating a negative outline copy of a sprite.

Click a picture for more information about any of the Patterns and Fills groups.
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Patterns and Fills palette with Gradient Ramp options

The Gradient Ramp fills the opaque pixels of a sprite with color.

With the Gradient Ramp, you can create a graded blend of up to four colors, which you can then 
apply to the opaque channels of a sprite. Microsoft Image Composer provides several example ramps
for you to use.

Note      The gradient ramp samples provided with Image Composer can be edited. You can change 
the name and colors of these ramps. You can also delete these ramps.

Blue Green 45% Gold Grayscale Down

Grayscale Left Grayscale Right Grayscale Up

Night Sky Red Green Blue Red Green Blue
Yellow

Red to Blue 45% Sunrise Tie Dye



Tile Bottom Left Tile Bottom Right Tile Top Left

Tile Top Right

Where to Find the Gradient Ramp
Gradient Ramp is available on the Patterns and Fills palette.

How to Apply a Gradient Ramp
Click a picture to learn more about that gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.

Note      You can apply a gradient ramp to one sprite at a time. You can't apply a gradient ramp to a 
group or a selection set.



Blue Green 45% Ramp
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The Blue Green 45% ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Blue Green 45% ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Gold Ramp
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The Gold ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Gold ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Grayscale Down Ramp
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The Grayscale Down ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Grayscale Down ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Grayscale Left Ramp
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The Grayscale Left ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Grayscale Left ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Grayscale Right Ramp
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Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Grayscale Right ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Grayscale Right ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Grayscale Up Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Grayscale Up ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Grayscale Up ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Night Sky Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Night Sky ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Night Sky ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Red Blue Green Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Red Blue Green ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Red Blue Green ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Red Blue Green Yellow Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Red Blue Green Yellow ramp replaces the opaque pixels of the selected sprite with the ramp 
color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Red Blue Green Yellow ramp is available on the Patterns and Fills palette, in the Gradient 
Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Red to Blue 45% Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Red to Blue 45% ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Red to Blue 45% ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Sunrise Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Sunrise ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Sunrise ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Tie Dye Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Tie Dye ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Tie Dye ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Tile Bottom Left Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Tile Bottom Left ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Tile Bottom Left ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Tile Bottom Right Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Tile Bottom Right ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Tile Bottom Right ramp is available on the Patterns and Fills palette, in the Gradient Ramp 
group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Tile Top Left Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Tile Top Left ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Tile Top Left ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Tile Top Right Ramp
{button ,AL("gradient
ramp item")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

{button ,AL("gradient ramp 
how")} How?

Original sprite Ramp applied at
100% opacity

Original sprite Ramp applied at 50%
opacity

The Tile Top Right ramp replaces the opaque pixels of the selected sprite with the ramp color.

Note      The gradient ramp samples provided with Microsoft Image Composer can be edited. You can 
change the name and colors of these ramps.

Where to Find the Gradient Ramp
The Tile Top Right ramp is available on the Patterns and Fills palette, in the Gradient Ramp group.

How to Apply a Gradient Ramp
Click the picture to learn how to apply the gradient ramp.

How to Adjust the Result
You can change the colors in the ramp by changing the color of one or more of the swatches at the 
corners.



Sprite to Sprite Overview
{button ,AL("patterns
and fills ovr")} 
Related Topics

{button ,AL("
patterns and 
fills palette")} 
Overview

The items in the Sprite to Sprite group use one sprite (a source sprite) to change the shape or 
appearance of another sprite (a destination sprite).

      Click the item you want to read about.
· Transfer Shape, Transfer Full, and Glue replace the destination sprite's pixels with the pixels of 

the source sprite where the two intersect.

Transfer Shape Transfer Full Glue

· Snip deletes the destination sprite's opaque pixels where they intersect with the pixels of the 
source sprite.

Snip

· Tile copies multiple instances of a source sprite's opaque pixels over the shape of the destination 
sprite.

Tile

· The Map items copy the colors, intensity, saturation, or transparency of the source sprite to the 
destination sprite.

Intensity Map Color Map



Transparency Map Saturation Map

You can vary the opacity of the result by using the Opacity slider before you click Apply.

Notes
· Only one sprite at a time can be a source sprite.
· You can use multiple destination sprites at the same time, as long as they are in a selection set, 

not in a group.
· Except for Tile, a Sprite to Sprite item can work only if the source sprite and the destination 

sprites intersect.
· The stack order of the source and destination sprites does not affect the results.
· If the source sprite is directly underneath, and totally obscured by, the destination sprite, you must 

first extend the bounding box of the source sprite beyond the perimeter of the destination sprite. 
Then you can select the source sprite. For information on extending a bounding box, see To Crop a
Sprite.



Transfer Shape
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Destination sprite Source sprite

Position source and
apply Texture

Result: destination
sprite

Transfer Shape replaces a destination sprite's opaque pixels with those of an intersecting source 
sprite, where the two sprites intersect. The destination sprite's transparent pixels are not changed. 
Only the opaque pixels of the source sprite are used.

Where to Find this Item
This tool is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

Tips
· You can feather the edges of the destination sprite by applying the Blur effect before you use 

Transfer Shape. The extent of the feathering depends on the amount of Blur you apply.
· You can use more than one destination sprite at a time, but only one source sprite.



Transfer Full
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Destination sprite Source sprite

Position source and
apply Texture Full

Result: destination
sprite

Transfer Full replaces a destination sprite's opaque pixels with the pixels of a source sprite, where 
the two sprites intersect. Both the opaque and the transparent pixels of the source sprite are copied 
onto the destination sprite. The transparent pixels of the destination sprite are not changed.

Where to Find this Item
This tool is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

Tip      Compare this tool to the Transfer Shape and Glue tools.



Glue
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Destination sprite Source sprite

Position source and
apply Glue

Result: destination
sprite

Glue replaces a destination sprite's pixels with the opaque pixels of a source sprite, where the two 
sprites intersect. Both the opaque and the transparent pixels of the destination sprite are changed.

Where to Find this Item
This tool is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

Tips
· Instead of using Glue, you can permanently combine two or more sprites into a single sprite by 

grouping them and then using the Flatten Group command on the Arrange menu. (You cannot 
separate a group of sprites once you have flattened it.)



Snip
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Destination sprite Source sprite

Position source and
apply Snip

Result: destination
sprite

Snip deletes the destination sprite's opaque pixels where they intersect the opaque pixels of the 
source sprite.

Where to Find this Item
Snip is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click any picture to learn how to use this item.

Tip      You can manually delete a sprite's opaque pixels by using Erase on the Paint palette.



Intensity Map
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Source sprite Destination sprite

Position source and
apply Intensity Map 

Result: destination
sprite

Intensity Map copies the intensity values of a source sprite to the destination sprite. The original 
colors of the destination sprite remain unchanged.

For example, if a source sprite is a gray ramp from black to white and the destination sprite is a 
rainbow, the rainbow colors are ramped from dark to light, picking up the intensity of the gray ramp on
the source sprite. If the destination sprite is a solid red square, the result is a ramp of dark to light 
reds.

Where to Find this Item
Intensity Map is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

How to Vary the Results
Use the Threshold box to specify the threshold (from 0 to 255) at which the source sprite's range of 
intensity affects the destination sprite's colors. The color pixels in the destination sprite that are above
the threshold value are brightened by the intersecting pixels of the source sprite. Those pixels that are
below the threshold value are darkened by the intersecting pixels in the source sprite. If you set the 
threshold to 255, all the color pixels in the destination sprite are below the threshold and are darkened
by the intensity values in the source sprite.



Color Map
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Source sprite Destination sprite

Position source and
apply Color Map

Result: destination
sprite

Color Map copies the color values of a source sprite to the opaque pixels of a destination sprite. The 
intensity values of the destination sprite are unchanged.

For example, if a source sprite is a gray ramp from black to white and the destination sprite is a 
rainbow, the rainbow colors are ramped to grays, picking up the colors of the gray ramp on the source
sprite.

Where to Find this Item
Color Map is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

How to Vary the Results
Use the Threshold box to specify the threshold (from 0 to 255) at which the source sprite's range of 
intensity affects the destination sprite's colors.

The color pixels in the destination sprite that are above the threshold value are brightened by the 
intersecting pixels of the source sprite. Those pixels that are below the threshold value are darkened 
by the intersecting pixels in the source sprite. If you set the threshold to 255, all the color pixels in the 
destination sprite are below the threshold and are darkened by the intensity values in the source 
sprite.



Transparency Map
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Source sprite Destination sprite 

Position source and
apply Transparency

Map 

Result: destination
sprite

Transparency Map changes the transparency of the destination sprite based on the intensity of the 
source sprite.

For example, if the source sprite is a gray ramp from black to white, the destination sprite is 
transparent where the source is black and grows increasingly opaque toward the white end of the 
source ramp.

Where to Find this Item
Transparency Map is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.



Saturation Map
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Source sprite Destination sprite 

Position source and
apply Saturation

Map 

Result: destination
sprite

Saturation Map changes the saturation of the destination sprite based on the intensity of the source 
sprite.

White source pixels produce full saturation, while darker pixels reduce the saturation toward gray.

Therefore, if the source sprite is a gray ramp from white to black, the destination sprite retains its 
original saturation at the white end, gradually desaturating toward the black end of the ramp.

Where to Find this Item
Saturation Map is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.



Tile
{button ,AL("sprite to
sprite item ")} 
Related Topics

{button ,AL("s
prite to sprite 
ovr")} 
Overview

{button ,AL("sprite to sprite 
how")} How?

Destination sprite Source sprite Tiled destination
sprite

Tile applies repeated copies of a source sprite to the opaque pixels of a destination sprite.

Where to Find this Item
Tile is available on the Patterns and Fills palette, in the Sprite to Sprite group.

How to Use this Item
Click the picture to learn how to use this item.

How to Vary the Results
Use Intertile X and Intertile Y to vary the spacing of the tiled sprites on the destination sprite. The 
default settings (0,0) place the tiles with all their edges touching. A higher X value adds space 
between the sides of the tiles. A higher Y value adds space between the tops and bottoms of the tiles.

Tip      With Tile, the source and destination sprites do not need to intersect. However, the origin of the
tile pattern is based on the position of the source sprite, so for the greatest accuracy, position the 
source sprite where you want the first tile in the pattern.



Patterns Overview
{button ,AL("patterns
and fills ovr ")} 
Related Topics

{button ,AL("
patterns and 
fills palette")} 
Overview

      Click on the pattern you want to read more about.

Color Array Grayscale Array Color Bars

Hue vs. Blackness Hue vs. Whiteness Color Noise

Gray Noise Checkerboard Stripes

The Patterns group replaces a sprite's opaque pixels with the pattern you select. You can also select 
the color for some of the patterns; other patterns use a fixed palette of colors or grays.

You specify the opacity of the pattern before you apply it to the destination sprite.

At lower opacity settings, the pattern blends lightly with the sprite's opaque pixels; details within the 
outline of the original image show through. At an opacity setting of 100%, the pattern replaces all the 
opaque pixels in the sprite. Details within the original image are no longer visible, although the outline 
of the sprite remains.

You can apply a pattern to one sprite at a time.



Color Array
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Color Array at 100%
opacity

Original sprite Color Array at 50%
opacity

Color Array covers the selected sprite with a 16 x 16 array of ramped colored squares separated by 
transparent lines.

Where to Find this Item
Color Array is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.

Tip      The Color Array pattern is a good test image for warps.



Grayscale Array
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Grayscale Array at
100% opacity

Original sprite Grayscale Array at
50% opacity

Grayscale Array covers the selected sprite with a 16 x 16 array of ramped gray squares separated 
by transparent lines.

Where to Find this Item
Grayscale Array is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.



Color Bars
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Color Bars at 100%
opacity

Original sprite Color Bars at 50%
opacity

Color Bars replaces the opaque pixels of the selected sprite with the CBS-standard video color-bars 
pattern. This consists of eight vertical bars of color: the three primary colors, the three secondary 
colors, and black and white. The bars are created at 75 percent brightness, to avoid over-saturating 
broadcast video devices. They are arranged, left to right, in decreasing NTSC, National Television 
Standards Committee, luminance.

Where to Find this Item
Color Bars is available on the Patterns and Fills palette, in the Patterns group. 

How to Apply the Item
Click the picture to learn how to apply this item.



Hue vs. Blackness
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Hue vs. Blackness
at 100% opacity

Original sprite Hue vs. Blackness
at 50% opacity

Hue vs. Blackness replaces the opaque pixels of the selected sprite with a ramp of colors. The hues 
in the ramp vary horizontally and increase in blackness vertically. The hues at the top of the ramp are 
pure, while those at the bottom are completely black.

Where to Find this Item
Hue vs. Blackness is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.



Hue vs. Whiteness
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Hue vs. Whiteness
at 100% opacity

Original sprite Hue vs. Whiteness
at 50% opacity

Hue vs. Whiteness replaces the opaque pixels of the selected sprite with a ramp of colors. The hues 
in the ramp vary horizontally and increase in whiteness vertically. The hues at the top of the ramp are 
pure, while those at the bottom are completely white.

Where to Find this Item
Hue vs. Whiteness is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.



Color Noise
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original Pattern Color Noise at 100%
opacity

Original Pattern Color Noise at 50%
opacity

Color Noise replaces the opaque pixels of the selected sprite with random color pixels.

Where to Find this Item
Color Noise is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.

Tip      You can use the noise pattern to add a speckled quality to a digitized image that has become 
overly smooth from editing. Set the Opacity slider to a low value.



Gray Noise
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Gray Noise at 100%
opacity

Original sprite Gray Noise at 50%
opacity

Gray Noise replaces the opaque pixels of the selected sprite with random gray pixels.

Where to Find this Item
Gray Noise is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.



Checkerboard
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Checkerboard at
100% opacity

Original sprite Checkerboard at
50% opacity

Checkerboard replaces the opaque pixels of a selected sprite with a checkered pattern of 
transparent and opaque tiles. You can specify the color and size of the opaque tiles.

Where to Find this Item
Checkerboard is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.

Tip      You can use Complement Shape to reverse the tiles on the checkerboard.



Stripes
{button ,AL("patterns
item ")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

{button ,AL("patterns how")} 
How?

Original sprite Stripes at 100%
opacity

Original sprite Stripes at 50%
opacity

Stripes replaces the opaque pixels of a selected sprite with alternating transparent and opaque 
horizontal stripes. You can specify the color, width, and spacing of the opaque stripes.

Where to Find this Item
Stripes is available on the Patterns and Fills palette, in the Patterns group.

How to Apply the Item
Click the picture to learn how to apply this item.

Tip      The Stripes pattern applies horizontal stripes, by default.



Complement Shape
{button ,AL("patterns
and fills ovr ")} 
Related Topics

{button ,AL("
patterns and 
fills palette")} 
Overview

{button ,AL("complement 
shape how")} How?

Original sprite Complement Shape

Complement Shape creates a reverse copy of the source sprite. The new sprite consists of an 
opaque image of the destination sprite's transparent pixels. The source sprite is unchanged.

The resulting sprite contains:

· Opaque pixels of the Color Picker's current color where the source sprite was transparent.
· Transparent pixels where the source sprite was opaque.

Where to Find this Item
Complement Shape is available on the Patterns and Fills palette.

How to Apply this Item
Click the picture to learn how to use Complement Shape.

Tip      Complement Shape works best on sprites that have distinct transparent areas. Using 
Complement Shape on a sprite with no transparent pixels results in a copy consisting of a 
completely solid sprite.



Current Color Fill
{button ,AL("patterns
and fills ovr")} 
Related Topics

{button ,AL("
patterns and 
fills palette")} 
Overview

{button ,AL("current color fill 
how")} How?

Original sprite Current Color Fill

Current Color Fill allows you to change the current color of a sprite to a color you select from the 
Color Picker dialog box.

Where to Find this Item
Current Color Fill is available on the Patterns and Fills palette.

How to Apply this Item
Click the picture to learn how to use Current Color Fill.



To apply a gradient ramp to a sprite
{button ,AL("gradient
ramp how")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Gradient Ramp.
3 In the Ramp Name list, click the ramp you want, or create a new ramp by using the color patches 

at the corners of the color ramp.
4 Move the Opacity slider to the opacity value you want.
5 Click Apply.

Note      You can apply a gradient ramp to one sprite at a time. You can't apply a gradient ramp to a 
group or a selection set.



 To save a custom gradient ramp
{button ,AL("gradient
ramp how")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Gradient Ramp.
3 Create your own custom gradient ramp.
4 In the ramp list, type a name for the custom ramp.
5 Click Save.

Note      Microsoft Image Composer can save up to 20 custom ramps.



 To delete a gradient ramp from the ramp list
{button ,AL("gradient
ramp how")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Gradient Ramp.
3 In the Ramp Name list, click a ramp name.
4 Click Delete.
Note      Deleting a gradient ramp from the Ramp Name list permanently removes the ramp from 
Microsoft Image Composer.



To change the colors in a gradient ramp
{button ,AL("gradient
ramp how")} Related
Topics

{button ,AL("
gradient 
ramp ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Gradient Ramp.
3 Click a color swatch.
4 In the Color Picker dialog box, pick the color you want for that corner of the ramp.

Tip      You can also click and drag a color from one color swatch and place it in another color 
swatch.

5 Click OK.
6 Repeat steps 3 through 5 for the remaining color swatches.

Tip      You can save the new ramp for later use.



To create a circular gradient
{button ,AL("gradient
ramp how;warps 
group how")} 
Related Topics

{button ,AL("
gradient 
ramp 
ovr;radial 
sweep 
warp")} 
Overview

Original sprite Sprite with linear
gradient ramp

Results after Radial
Sweep

1 Select a sprite.
2 In the toolbox, click Patterns and Fills.
3 From the list, click Gradient Ramp.
4 Select two colors for the color swatch corners. Place the first color in the top two color swatches, 

and place the second color in the bottom two color swatches.
5 Click Apply.
6 In the toolbox, click Warps and Filters.
7 In the drop-down list, click Warps.
8 In the list, click Radial Sweep.
9 Specify the degree of the sweep in the Angle scroll box.
10Click Apply.

Tip      You can save the new ramp for later use.



To copy values from one sprite to another
{button ,AL("sprite to
sprite how")} 
Related Topics

{button ,AL("s
prite to sprite 
item")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Sprite to Sprite.
3 In the Sprite Texture Type list, click the item you want to use.
4 Position the source sprite so that it intersects the destination sprite in the area that you want 

modified on the destination sprite.
5 Adjust the opacity by using the Opacity slider.
6 Select a destination sprite if it is not already selected.
7 Click Apply.
8 Click a source sprite.

Separate the two sprites to view the results.



To apply a pattern to a sprite
{button ,AL("patterns
how")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Patterns.
3 From the Patterns list, click the pattern you want.
4 Adjust the opacity slider to desired value.
5 Select the sprite you want to fill, and then click Apply.



To fill a sprite with a solid color
{button ,AL("current 
color fill")} Related 
Topics

{button ,AL("
patterns and 
fills ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Current Color Fill.
3 In the toolbox, click the Color Swatch.
4 From the Color Picker dialog box, select the color you want.
5 Specify the opacity value you want.
6 Select the sprite you want to fill, and then click Apply.



To apply a pattern to part of a sprite
{button ,AL("patterns
how")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

1 Create a simple reference sprite, and then fill it with a pattern.
2 Select the sprite to which you want to apply the pattern.
3 In the toolbox, click Paint.
4 Click Transfer.
5 Select the patterned reference sprite.
6 Paint the pattern onto the destination sprite.



To apply a checker pattern to a sprite
{button ,AL("patterns
how;checkerboard 
pattern")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Patterns.
3 From the Patterns list, click Checkerboard.
4 Specify the opacity value you want.
5 In the toolbox, click the Color Swatch.
6 In the Color Picker dialog box, select a color for the tiles in the checkerboard.
7 In the Width and Height boxes, specify the pixel size of the tiles.
8 Click the sprite you want to fill, and then click Apply.



To apply stripes to a sprite
{button ,AL("patterns
how;stripes 
pattern")} Related 
Topics

{button ,AL("
patterns 
ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Patterns.
3 From the Patterns list, click Stripes.
4 Specify the opacity value you want.
5 In the toolbox, click the Color Swatch.
6 In the Color Picker dialog box, select a color for the stripes.
7 In the Width and Spacing boxes, specify the pixel size of the stripes.
8 Click the sprite you want to fill, and then click Apply.



To create a complementary shape of a sprite
{button ,AL("comple
ment shape ovr")} 
Related Topics

{button ,AL("
patterns and 
fills ovr")} 
Overview

1 In the toolbox, click Patterns and Fills.
2 Click Complement Shape.
3 In the toolbox, click the Color Swatch
4 In the Color Picker dialog box, select a color for the reverse copy.
5 Select the sprite you want to modify, and then click Apply.

Tips
· To see the reverse copy that Complement Shape creates, move one sprite away from the other.
· Complement Shape works best on sprites that have distinct transparent areas. Using this tool on 

a sprite with no transparent pixels creates a copy consisting of a completely solid sprite.



Color Tuning Tool Palette Overview
{button ,AL("color 
shifting 
overview;highlight/s
hadow 
overview;dynamic 
range overview")} 
Related Topics

{button ,AL("
Shapes 
Palette 
ovr;Warps 
and Filters 
ovr;Patterns
and Fills 
Palette;Art 
effects 
Ovr;A_PAIN
T_Paint_To
ols_Overvie
w;A_ARRA
NGE_Arran
ge_Overvie
w;A_Overvi
ew_of_Text
_Sprites;")} 
Overview

      Click on the group button you want to learn more about.

Color Shifting Highlight/Shadow Dynamic Range

The Color Tuning tool palette allows you to alter multiple color aspects of a sprite in a single 
generation of change. This single generation of change reduces the overall image loss that often 
results from multiple generations of change.

The Color Tuning tool palette contains tools for altering the following color aspects of a sprite:

· Brightness
· Saturation
· Hue
· Contrast
· Shadow intensity
· Midtone intensity
· Highlight intensity
· Pixel intensity distribution



Color Shifting Overview
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Color Tuning Tool Palette with the Color Shifting Group

The Color Shifting tools alter the saturation, contrast, hue, and brightness color aspects of the pixels
in a sprite.

      Click on the picture you want to learn more about.
· Brightness alters the absolute lightness or darkness of the color for either all three color channels 

simultaneously or for the red, blue, and green channels individually.

· Contrast alters the degree of difference between the lightest and darkest parts of the color by 
adjusting either all three color channels simultaneously or by adjusting the red, blue, and green 
channels individually.

· Hue moves the color of each pixel around the color circle in increments of plus or minus one 
degree from -180 degrees to +180 degrees.

· Saturation alters a color by increasing or decreasing the amount of gray in proportion to hue for all
three color channels simultaneously.



Brightness
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Brightness at +50 Brightness at -50

Brightness alters the lightness or darkness of color in increments of +/-1, from -100 to +100. -100 
represents fully black and +100 represents fully bright.

By default, All Channels is selected when you work with Brightness. For more information about 
how Brightness affects the red, green, and blue color channels independently, see Brightness for 
RGB Channels.

Where to find this item
Brightness is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture to find out how to apply Brightness to all channels.

How to adjust the result
Move the Brightness slider to the right to increase the brightness of the color. Move the Brightness 
slider to left to increase the darkness of the color.



Brightness for RGB Channels
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Brightness at +50
for the Red Channel

only

Brightness at +50
for the Green
Channel only

Brightness at +50
for the Blue Channel

only

Brightness alters the lightness or darkness of color in increments of +/-1, from -100 to +100. -100 
represents fully black and +100 represents fully bright.

By default, All Channels is selected when you work with Brightness.

Where to find this item
Brightness is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture above to find out how to apply Brightness to RGB channels.

How to adjust the result
Move the Brightness slider to the right to increase the brightness of the color. Move the Brightness 
slider to the left to increase the darkness of the color.



Contrast
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Contrast at +50 Contrast at -50

Contrast alters the degree of difference between the lightest and darkest parts of the sprite in 
increments of -/+1, from -100 to +100.

By default, All Channels is selected when you work with Contrast. For more information about how 
Contrast affects the red, green, and blue color channels independently, see Contrast for RGB 
Channels.

Where to find this item
Contrast is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture to find out how to apply Contrast to all channels.

How to adjust the result
Move the Contrast slider to the right to increase the degree of difference between the lightest and 
darkest parts of the sprite. Move the Contrast slider to the left to decrease the degree of difference 
between the lightest and darkest parts of the sprite.



Contrast for RGB Channels
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Red Channel only;
Contrast at +50

Green Channel only;
Contrast at +50

Blue Channel only;
Contrast at +50

Contrast alters the degree of difference between the lightest and darkest parts of the sprite in 
increments of -/+ 1, from -100 to +100.

By default, All Channels is selected when you work with Contrast.

Where to find this item
Contrast is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture above to find out how to apply Contrast to RGB channels.

How to adjust the result
Move the Contrast slider to the right to increase the degree of difference between the lightest and 
darkest parts of the sprite. Move the Contrast slider to the left to decrease the degree of difference 
between the lightest and darkest parts of the sprite.



Hue
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Hue at +100 Hue at -100

Hue at 50 Hue at -50

Hue moves the color of each pixel around the color circle in increments of -/+ 1, from -180 to +180 
degrees. Red, green, and blue are 120 degrees apart on the color circle. If you rotate red pixels, for 
example, 120 degrees, the pixels become green.

By default, All Channels is selected when you work with Hue.

Where to find this item
Hue is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture to find out how to apply Hue.

How to adjust the result
Move the Hue slider to the right to increase the green tinting in the sprite color. Move the Hue slider to
the left to increase the blue tinting in the sprite color.



Saturation
{button ,AL("color 
shifting list")} 
Related Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

{button ,AL("color shifting 
how")} How?

Original sprite Saturation at +50 Saturation at -50
 

Saturation alters a color by increasing or decreasing the amount of gray present in increments of -/+ 
1, from -100 to +100.

By default, All Channels is selected when you work with Saturation. You cannot alter the saturation 
of each channel individually.

Where to find this item
Saturation is available on the Color Tuning tool palette, in the Color Shifting group.

How to apply this item
Click a picture above to find out how to apply Saturation.

How to adjust the result
Move the Saturation slider to the right to decrease the amount of gray in the color. Move the 
Saturation slider to the left to increase the amount of gray in the color.



Highlight/Shadow Overview
{button ,AL("highligh
t/shadow 
overview")} Related 
Topics

{button ,AL("
color 
shifting 
overview;dy
namic range
overview")} 
Overview

{button 
,AL("highlight/shadow 
how")} How?

Color Tuning Tool Palette with Highlight/Shadow Options

Highlight/Shadow alters the relative intensities of the shadows, midtones, and highlights of a sprite’s 
color.

For more information about how shadows, midtones, and highlights are controlled independently in 
the red, green, and blue color channels, see Highlight/Shadow for RGB Channels.

      Click on the picture of the setting you want to learn more about.

Original sprite Highlight/Shadow at
positive setting

Highlight/Shadow at
negative setting

Highlight/Shadow at
combined setting

· The Shadow handle, located on the bottom of the compensation curve, adjusts the intensity of the 
dark color elements.

· The Midtone handle, located in the middle of the compensation curve, adjusts the intensity of the 
middle range color elements.

· The Highlight handle, located at the top of the compensation curve, adjusts the intensity of the 
lightest color elements.

How to adjust the result
Move any of the three handles up to increase the intensity of the selected handle area. Move any of 
the three handles down to decrease the intensity of the selected handle area.



Tip      Strong differences in intensity between the color elements creates greater contrast.



Curves window at a brighter (positive) setting.



Curves window at a darker (negative) setting.



Curves window at a combined setting.



Highlight/Shadow for RGB Channels
{button ,AL("highligh
t/shadow 
overview")} Related 
Topics

{button ,AL("
color 
shifting 
overview;dy
namic range
overview")} 
Overview

{button 
,AL("highlight/shadow 
how")} How?

Original sprite All Channels with
varied settings

Red Channel

Green Channel Blue Channel

Highlight/Shadow alters the relative intensities of the shadows, midtones, and highlights of a sprite’s 
color in each channel independently.

Where to find this item
Highlight/Shadow is located on the Color Tuning tool palette.

How to apply this item
Click a pictures to find out how to apply Highlight/Shadow for RGB channels.

How to adjust the result
Move any of the three handles up to increase the intensity of the selected handle area. Move any of 
the three handles down to decrease the intensity of the selected handle area.



Curves window with all channels at varied settings.



Curves window with red channel setting.



Curves window with green channel setting.



Curves window with blue channel setting.



Dynamic Range
{button ,AL("highligh
t/shadow 
overview")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview")} 
Overview

{button ,AL("dynamic range 
how")} How?

Color Tuning Tool Palette with Dynamic Range Options

Dynamic Range designates how intensity is distributed in a sprite by defining the low and high 
intensity ranges.

The histogram window displays the intensity distribution within the sprite. The horizontal axis displays 
the intensity levels, with left representing low intensity and right representing high intensity. The 
vertical axis displays the number of pixels that fall within a given intensity level. The two vertical bars 
located on the sides of the histogram window represent the low and high intensity output ranges.

Original sprite Left bar moved to
left

Right bar moved to
right

Right and left bars
moved to center

Where to find this item
Dynamic Range is located on the Color Tuning tool palette.

How to apply this item
Click a picture to find out how to apply Dynamic Range.



Histogram of the original sprite.



Histogram showing the left bar moved left.



Histogram showing the right bar moved right.



Histogram showing the right and left bars moved to center.



To adjust shadow, midtone, and highlight intensity
{button ,AL("highligh
t/shadow how;color 
shifting 
how;dynamic range 
how;")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

Use the Highlight/Shadow group to increase or decrease the relative intensities within a sprite in the 
low, medium, and high tones independently.

1 Select a sprite.
2 In the toolbox, click Color Tuning.
3 On the Color Tuning tool palette, click Highlight/Shadow.
4 In the Curves window, select the Shadow, Midtone, or Highlight handle and drag to the desired 

position.
Tip      Dragging a handle up or left increases the brightness of that color area. Dragging a handle 
down or to the right increases the darkness of that color area.

5 Click Apply.
Note      Microsoft Image Composer applies all of the changes made on the Color Tuning tool 
palette, whether in the Color Shifting, Highlight/Shadow, or Dynamic Range groups, when you 
click Apply.

For more information about adjusting for individual channels, see To Adjust Shadow, Midtones and 
Brightness for RGB.



To adjust shadow, midtone, and highlight intensity for RGB channels
{button ,AL("highligh
t/shadow how;color 
shifting 
how;dynamic range 
how;")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

Use the Highlight/Shadow group to increase or decrease the relative intensities within a sprite in the 
low, medium, and high tones independently.

1 Select a sprite.
2 In the toolbox, click Color Tuning.
3 On the Color Tuning tool palette, click Highlight/Shadow.
4 Select either the red, green, or blue channel to adjust.
5 In the Curves window, select the Shadow, Midtone or Highlight handle and drag to the desired 

position.
Tip      Dragging a handle up or left increases the brightness of that color area. Dragging a handle 
down or right increases the darkness of that color area.

6 Click Apply.
Note      Microsoft Image Composer applies all the changes made on the Color Tuning tool palette,
whether in the Color Shifting, Highlight/Shadow, or Dynamic Range groups, when you click 
Apply.



To specify color intensity distribution
{button ,AL("highligh
t/shadow how;color 
shifting 
how;dynamic range 
how;")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

Use Dynamic Range to expand or reduce a sprite’s use of color intensity distribution.

1 Select a sprite.
2 In the toolbox, click Color Tuning.
3 On the Color Tuning tool palette, click Dynamic Range.
4 In the Low Output Range scroll box, select the lowest intensity value for pixels in the sprite.
5 In the High Output Range scroll box, select the highest intensity value for pixels in the sprite.

- or -
Adjust the left and right bars of the histogram window to set the low and high intensity values for 
the sprite.
Tip      If a sprite is too bright, reduce the distance between the left and right bars in the histogram 
window. If a sprite is too dark, increase the distance between the left and right bars in the 
histogram window.

6 Click Apply.
Note      Microsoft Image Composer applies all the changes made on the Color Tuning tool palette,
whether in the Color Shifting, Highlight/Shadow, or Dynamic Range groups, when you click 
Apply.



To alter the color of a sprite
{button ,AL("highligh
t/shadow how;color 
shifting 
how;dynamic range 
how;")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

1 Select a sprite.
2 In the toolbox, click Color Tuning.
3 Adjust the Brightness, Contrast, Hue and Saturation slider bars to achieve the desired result.
4 Click Apply.



To alter the RGB colors of a sprite independently
{button ,AL("highligh
t/shadow how;color 
shifting 
how;dynamic range 
how;")} Related 
Topics

{button ,AL("
color 
shifting 
overview;hig
hlight/shado
w 
overview;dy
namic range
overview")} 
Overview

1 Select a sprite.
2 In the toolbox, click Color Tuning.
3 Click the Red, Green, or Blue color channel.
4 Adjust the Brightness or Contrast sliders to achieve the desired result for the channel.
5 Click Apply

Note      If All is not selected, Microsoft Image Composer applies the changes you have specified 
for each color channel when you click Apply, even though you can not view all the channel 
settings.



Brightness Hint
Move the slider to the right to increase the brightness of the color.

Move the slider to the left to increase the darkness of the color.



Contrast Hint
Move the slider to the right to increase the degree of difference between the lightest and darkest parts
of the color.

Move the slider to the left to decrease the degree of difference.



Hue Hint
Move the slider to the right to increase the green tinting in the sprite color.

Move the slider to the left to increase the blue tinting in the sprite color.



Saturation Hint
Move the slider to the right to decrease the amount of gray in the color.

Move the slider to the left to increase the amount of gray in the color.



Shapes Palette Overview
{button ,AL("shapes
ovr")} Related 
Topics

{button ,AL(
"color tuning
palette 
ovr;art 
effects 
palette 
ovr;warps 
and filters 
ovr;patterns
and fills 
palette;A_P
AINT_Paint
_Tools_Ove
rview;A_AR
RANGE_Arr
ange_Overv
iew;A_Over
view_of_Tex
t_Sprites")} 
Overview

Geometry Colorlift

The Shapes palette contains items for performing the following actions:

· Create new rectangles, ovals, splines, and polygons
· Edit rectangles, ovals, splines, and polygons
· Duplicate sections of sprites
· Erase sections of sprites
· Erase select colors on sprites
· Lift colors from existing sprites



Geometry Overview
{button ,AL("geomet
ry item")} Related 
Topics

{button ,AL(
"shapes 
ovr")} 
Overview

{button ,AL("geometry 
how")} How?

Shapes Palette with the Geometry Options

The Geometry group allows you to create rectangular, oval, and polygon sprites, in addition to 
irregularly shaped sprites with the spline tool.

· Rectangle creates a rectangular sprite on the workspace. You can use Rectangle to create filled 
sprites, to create duplicate sections of sprites, or to erase sections of sprites. You also can adjust 
the opacity and color of the rectangular sprite.

· Oval creates a round sprite in the workspace. You can use Oval to create filled sprites, to create 
duplicate sections of sprites, or to erase sections of sprites. You also can adjust the opacity and 
color of the round sprite.

· Spline creates shapes with curved lines in the workspace. You can use Spline to create filled 
sprites, to create duplicate sections of sprites, or to erase sections of sprites. You also can adjust 
the opacity, line width, edit points, color, and other values for the spline.

· Polygon creates shapes with multiple straight lines in the workspace. You can use Polygon to 
create filled sprites, create duplicate sections of sprites, or to erase sections of sprites. You also 
can adjust the opacity, line width, edit points, color, and other values.



To create a rectangular sprite
{button ,AL("geomet
ry how")} Related 
Topics

{button ,AL(
"shapes 
ovr")} 
Overview

Square Rectangle

1 In the toolbox, click Shapes.
2 On the Shapes tool palette, click Rectangle.
3 Set the Opacity slider to the desired position.
4 Place the pointer on the workspace, then click and drag until the bounding box is in the desired 

position.
5 Alter the size of the sprite by clicking and dragging the editing points of the sprite.
6 Click Render.

Tip      If you hold down the SHIFT key while dragging the bounding box of the sprite, you can create a 
perfectly proportional square.



To create a round or oval sprite
{button ,AL("geome
try how")} Related 
Topics

{button ,AL(
"shapes 
ovr")} 
Overview

Circle Oval

1 In the toolbox, click Shapes.
2 On the Shapes tool palette, click Oval.
3 Set the Opacity slider to the desired position.
4 Place the pointer on the workspace, then click and drag until the bounding box is in the desired 

position.
5 Alter the size of the sprite by clicking and dragging the editing points of the sprite.
6 Click Render.

Tip      If you hold down the SHIFT key while dragging the bounding box of the sprite, you can create a 
perfectly proportional circle.



Spline
{button ,AL("geomet
ry item")} Related 
Topics

{button ,AL(
"shapes 
ovr")} 
Overview

{button ,AL("spline 
how")} How?

Open-ended Spline Closed Spline Filled Spline

Spline creates sprites with rounded edges that contain multiple editing points you can use to adjust 
the overall shape of the sprite. Depending on the type of spline you choose to create, whether a 
closed spline or an open-ended spline, the final result of the sprite can vary.

Where to find this item
Spline is available on the Shapes palette, in the Geometry group.

How to apply this item
Click a picture to find out how to create that item.

How to adjust the result
Note      All of the following adjustments must be done before you begin creating a spline on the 
workspace.

Adjust the Spline Line Width slider to increase or to decrease the outline thickness of open-ended 
splines.

Click Recall Spline to generate an exact, editable, copy of the last spline created. Recall Spline is 
only available after you have rendered, extracted, or erased a spline.



To create an open-ended spline
{button ,AL("spline 
how;geometry 
item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting Sprite

1 In the toolbox, click Shapes.
2 Click Spline.
3 Clear the Close box, then adjust the Line Width slider to the desired line thickness.
4 Adjust the Opacity slider to the desired setting.
5 Click the pointer in the workspace to create the first editing point of the spline, then click on other 

locations to create the spline.
Note      You can adjust the editing points of the spline by clicking Edit Points on the Shapes tool 
palette. To add editing points on the spline, click on a section of the spline and press I on the 
keyboard. To delete editing points on the spline, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the spline after you have clicked Render.

6 When you have finished, click Render.



To create a closed spline
{button ,AL("spline 
how;geometry 
item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting sprite

1 In the toolbox, click Shapes.
2 Click Spline.
3 Select the Close box.
4 Adjust the Opacity slider to the desired setting.
5 Click the pointer in the workspace to create the first editing point of the spline, then click on other 

locations to create the spline.
Note      You can adjust the editing points of the spline by clicking Edit Points on the Shapes tool 
palette. To add editing points on the spline, click on a section of the spline and press I on the 
keyboard. To delete editing points on the spline, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the spline after you have clicked Render.

6 When you have finished, click Render.



To create a filled spline
{button ,AL("spline 
how;geometry 
item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting Sprite

1 In the toolbox, click Shapes.
2 Click Spline.
3 Select the Close box.
4 Select the Fill box.

Note      By selecting the Fill box, you are indicating that the spline sprite will be filled with the color 
currently displayed in the Color Swatch.

5 Adjust the Opacity slider to the desired setting.
6 Click the pointer in the workspace to create the first editing point of the spline, then click on other 

locations to create the spline.
Note      You can adjust the editing points of the spline by clicking Edit Points on the Shapes tool 
palette. To add editing points on the spline, click on a section of the spline and press I on the 
keyboard. To delete editing points on the spline, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the spline after you have clicked Render.

7 When you have finished, click Render.



Polygon
{button ,AL("geomet
ry item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

{button ,AL("polygon 
how")} How?

Open-ended
Polygon

Closed Polygon Filled Polygon

Polygon creates sprites with straight edges that contain multiple editing points you can use to adjust 
the overall shape of the sprite. Depending on the type of polygon you choose to create, whether a 
closed polygon or an open-ended polygon, the final result of the sprite can vary.

Where to find this item
Polygon is available on the Shapes tool palette, in the Geometry group.

How to apply this item
Click a picture to find out how to apply that item.

How to adjust the result
Note      All of the following adjustments must be done before you begin creating a polygon on the 
workspace.

Adjust the Line Width slider to increase or to decrease the outline of polygons.

Click Recall Spline to generate an exact, editable copy of the last polygon created.



To create an open-ended polygon
{button ,AL("polygo
n how;geometry 
item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting Sprite

1 In the toolbox, click Shapes.
2 Click Polygon.
3 Clear the Close box, then adjust the Line Width slider to the desired line thickness.
4 Adjust the Opacity slider to the desired setting.
5 Click the pointer in the workspace to create the first editing point of the polygon, then click on other 

locations to create the polygon.
Note      You can adjust the editing points of the polygon by clicking Edit Points on the Shapes tool
palette. To add editing points on the polygon, click on a section of the polygon and press I on the 
keyboard. To delete editing points on the polygon, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the polygon after you have clicked Render.

6 When you have finished, click Render.



To create a closed polygon
{button ,AL("polygo
n how;geometry 
item")} Related 
Topics

{button ,AL(
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ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting Sprite

1 In the toolbox, click Shapes.
2 Click Polygon.
3 Select the Close box.
4 Adjust the Opacity slider to the desired setting.
5 Click the pointer in the workspace to create the first editing point of the polygon, then click on other 

locations to create the polygon.
Note      You can adjust the editing points of the polygon by clicking Edit Points on the Shapes tool
palette. To add editing points on the polygon, click on a section of the polygon and press I on the 
keyboard. To delete editing points on the polygon, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the polygon after you have clicked Render.

6 When you have finished, click Render.



To create a filled polygon
{button ,AL("polygo
n how;geometry 
item")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Step 1 Step 2

Step 3 Resulting Sprite

1 In the toolbox, click Shapes.
2 Click Polygon.
3 Select the Close box.
4 Select the Fill box.

Note      By selecting the Fill box, you are indicating that the polygon sprite will be filled with the 
color currently displayed in the Color Swatch.

5 Adjust the Opacity slider to the desired setting.
6 Click the pointer in the workspace to create the first editing point of the polygon, then click on other 

locations to create the polygon.
Note      You can adjust the editing points of the polygon by clicking Edit Points on the Shapes tool
palette. To add editing points on the polygon, click on a section of the polygon and press I on the 
keyboard. To delete editing points on the polygon, click on the editing point and press D on the 
keyboard. You cannot edit the editing points of the polygon after you have clicked Render.

7 When you have finished, click Render.



Colorlift Overview
{button ,AL("geomet
ry item")} Related 
Topics

{button ,AL(
"shapes 
ovr")} 
Overview

{button ,AL("colorli
ft how")} How?

Shapes Palette with Colorlift Options

Colorlift button

Colorlift creates a new sprite by selecting a specified range of pixel color in an existing sprite and 
duplicating the shape of the selected pixels. Colorlift provides the best results when you lift areas of 
solid colors or distinct borders, because you can easily mark the areas to be lifted.

When selecting a specified range of pixel color in a sprite, Microsoft Image Composer highlights the 
specified range with the color currently displayed in the Color Swatch so that you can view the areas 
selected.

Where to find this item
Colorlift is available on the Shapes tool palette.

How to apply this item
Click the Colorlift picture to find out how to apply this item.

How to adjust the result
Adjust the Hue, Whiteness, and Blackness sliders to alter the specified color range.

Click Global, which is found in the Search Mode section of the tool palette, to select all instances of 
a specified color range in a sprite.

Use Delete, which is found in the Selection section of the tool palette, to deselect an area of the 
sprite.



To lift colors from a sprite
{button ,AL("colorlift 
ovr")} Related 
Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Original sprite Resulting sprite Resulting sprite with
Feathering

1 Select the sprite you want to edit.
2 In the toolbox, click Shapes.
3 Adjust the Opacity slider to the desired setting.
4 On the Shapes tool palette, click Colorlift.
5 Select either the Local or Global mode for marking color pixels.
6 Place the Colorlift wand over the designated color area of the sprite and click.

The specified color range is marked, or highlighted, with the current color selection color.
7 Continue to mark sections of the sprite until you have included all intended areas.

Tip      If you accidentally click and mark an area that you did not intend to include in the colorlift, 
click Delete, and then click Redo Last. Microsoft Image Composer unmarks the last marked 
selection. You must then click Add to continue marking sections.
Tip      To reduce appearance of jagged pixels around the edges of the sprite, use the Feather 
option.

8 Click Extract.
You can now move the newly create sprite off the original sprite.



Local Search Mode
Marks only color pixels that match the specified color range and touch or connect to each other within
an area.



Global Search Mode
Marks all color pixels that match the specified color range within the entire sprite.



To duplicate selected areas of sprites
{button ,AL("geomet
ry misc how")} 
Related Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Original sprite Spline outline on
sprite

Duplicate section of
sprite

1 Select the sprite you want to edit.
2 In the toolbox, click Shapes.
3 Click the appropriate item from the Geometry group to select the area on the sprite.

Tip      Click Rectangle if the intended section can be encompassed best in a square or rectangular
shape. Click Oval if the intended section can be encompassed best in a circular shape. Click 
Spline if the intended section has multiple curved edges. Click Polygon if the intended section 
contains multiple straight edges.

4 On the Shapes tool palette, adjust the Opacity slider to the desired setting.
5 Select the Close and Fill boxes.
6 Within the bounding box, outline the appropriate area of the sprite using Rectangle, Oval, Spline, 

or Polygon.
7 Adjust the editing points.
8 Click Extract.

You can now drag the new sprite off the original sprite.



To erase selected areas of sprites
{button ,AL("geomet
ry misc how")} 
Related Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Original sprite Portion of Sprite
Outlined

Result

1 Select the sprite you want to edit.
2 In the toolbox, click Shapes.
3 Click the appropriate item from the Geometry group to select the area on the sprite.

Tip      Click Rectangle if the intended section can be encompassed best in a square or rectangular
shape. Click Oval if the intended section can be encompassed best in a circular shape. Click 
Spline if the intended section has multiple curved edges. Click Polygon if the intended section 
contains multiple straight edges.

4 On the Shapes tool palette, adjust the Opacity slider to the desired setting.
5 Select the Close and Fill boxes.
6 Within the bounding box, outline the selected area of the sprite using Rectangle, Oval, Spline, or 

Polygon.
7 Adjust the editing points.
8 Click Erase.



To erase selected colors on a sprite
{button ,AL("geomet
ry misc how")} 
Related Topics

{button ,AL(
"geometry 
ovr")} 
Overview

Original sprite Selected area
marked

Result

1 Select the sprite you want to edit.
2 In the toolbox, click Shapes.
3 Adjust the Opacity slider to the desired setting.
4 On the Shapes tool palette, click Colorlift.
5 Select either the Local or Global mode for marking color pixels.
6 Place the Colorlift wand over the designated color area of the sprite and click.

The specified color range is marked, or highlighted, with the current color selection color.
7 Continue to mark sections of the sprite until you have included all intended areas.

Tip      If you accidentally mark an area that you did not intend to include, click Delete, and then 
click Redo Last. Microsoft Image Composer unmarks the last marked selection. You must then 
click Add to continue marking sections.

8 Click Erase.



Applying, Undoing, and Resetting Actions

Up to three basic actions within Microsoft Image Composer are common to almost all effect 
procedures. They include the following:

      Apply
Located on tool and color palettes, this button applies the effect you choose. None of the Text, Patterns 
and Fills, Warps and Filters, Art Effects, or Color Tuning effects will be applied to your current 
composition until you click Apply.

      Undo
Located on the toolbar and Edit menu, Undo reverses the last unsaved Apply action.

 

      Reset or Default
Restores the sliders to their original positions and sets the values to their default settings. These buttons 
can be found on the Warps and Filters, Art Effects, or Color Tuning tool palettes.



Managing Files and Images Overview
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} How?

You can open or save images in many file formats with Microsoft Image Composer. These file types 
are listed in the Files of type list in the Open dialog box and in the Save as type list in the Save As 
dialog box. You can open either the Open or Save As dialog boxes on the File menu by clicking the 
appropriate command. Either file list includes:

· Adobe Photoshop 3.0 PSD
· Windows Bitmap (BMP)
· CompuServe Graphics Interchange Format (GIF)
· Joint Photographic Experts Group (JPEG)
· Microsoft Image Composer (MIC)
· Targa (TGA)
· Tagged-Image Format File (TIFF)



Working with supported file types
{button ,AL("A_MAN
AGING_Overview")}
Overview

{button ,JI(`',`MANAGING_BMP_Format')}    Saving an Image in BMP Format

{button ,JI(`',`MANAGING_GIF_Format')}    Saving an Image in GIF Format

{button ,JI(`',`MANAGING_JPEC_format')}    Saving an Image in JPEG Format

{button ,JI(`',`MANAGING_MIC_Format')}    Saving an Image in MIC Format

{button ,JI(`',`MANAGING_PSD_Format')}    Saving an Image in PSD Format

{button ,JI(`',`MANAGING_TGA_Format')}    Saving an Image in TGA Format

{button ,JI(`',`MANAGING_TIFF_Format')}    Saving an Image in TIFF Format



To save an image in BMP format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

BMP format 
information

BMP is the standard Windows raster image file format. It can be stored in Microsoft Image Composer 
with True Color or with an Image Composer custom color palette, such as Balanced Ramp, Gray 
Ramp, or Black and White. To save a sprite in BMP format:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click Windows (*.bmp).
5 On the Color format list, click the option you want.

· If you choose the True Color option, the Alpha as color check box is active, but not necessarily
selected. It is not selected by default. If not selected, the sprite’s colors are simply mapped to 
the Composition Guide’s colors when you save it. If the Alpha as color check box is selected, 
you must define a specific color to map the alpha data to.

· If you choose a format other than True Color, properties for each particular option appear to the
right of the list.

6 Click Save.



To save an image in GIF format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types;A_conUsing_
Custom_Color_Pale
ttes")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

GIF format 
information

GIF (Graphics Interchange Format) was created by CompuServe and is commonly used for online file
transfers for CompuServe Information Services and other online services. GIF is a compressed 
graphics file format designed to minimize transfer time over phone lines. Because of method of 
compression, the GIF algorithm is referred to as lossy. With Microsoft Image Composer, you can save
a sprite with an 8-bit (or less) custom palette by defining one of the palette’s custom colors as a 
transparent color. To save a sprite in GIF format:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click CompuServe (*.gif).
5 On the Color format list, click the option you want. Balanced Ramp is the default setting.

· The Transparent Color check box is active, but not selected. This is the default setting. When 
the Transparent Color check box is selected, you can use the Threshold slider to adjust the 
transparency level.

· Properties for each particular option you choose appear to the right of the Color format list.
6 Click Save.

Note      If you save a file as a GIF, you might notice some deterioration in quality after you reopen it. 
This is because GIF compression discards data inessential to the display of a sprite. You can 
minimize data loss by flattening a composition before you save it as a GIF, or you can save it with a 
custom color palette.



To save an image in JPEG format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

JPEG format 
information

JPEG (Joint Photographic Experts Group) compression creates moderately sized image files by 
discarding data inessential to the display of a sprite. Because of this, the JPEG algorithm is referred 
to as lossy. Microsoft Image Composer stores a JPEG file in True Color RGB format only. To save a 
file in JPEG format:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click JPEG (*.jpg). Note that on the Color format list, the only option 

available is True Color.
When you select JPEG (*.jpg), the Compression options becomes active. If you select 
Compression, you can adjust the Amount slider to determine the compression ratio you want. 
You should be aware, however, that because the JPEG format is lossy, higher compression ratios 
can result in greater losses in image quality when the image is reopened.

5 Click Save.



To save an image in MIC format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

MIC format 
information

MIC is the Microsoft Image Composer file format. This format retains the individual sprites in the 
composition so that you can continue to work on your composition with this benefit.

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click Microsoft Image Composer (*.mic).

Note      On the Color format list, the only option available is True Color. None of the other options
at the bottom of the Save As dialog box is active.

5 Click Save.



To save an image in PSD format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

PSD format 
information

PSD is the Adobe Photoshop 3.0 image format. In Microsoft Image Composer, sprites in a PSD file 
are converted and stored as Photoshop layers. To store a file in PSD format:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click Adobe Photoshop 3.0 (*.psd).

Note      On the Color format list, the only option available is True Color. None of the other options
at the bottom of the Save As dialog box is active.

5 Click Save.



To save an image in TGA format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

TGA format 
information

Images saved in the TGA (Targa) format in Microsoft Image Composer are stored as a single sprite in 
the True Color color format only. To save a sprite in TGA format:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click Targa (*.tga). Note that on the Color format list, the only option 

available is True Color. Within this confine, however, you have several options:
· Write Alpha. You can choose whether to save a sprite with the alpha channel or without. In 

other words, when a sprite is saved with the Write Alpha option selected, it is stored as an 
RGBA image. Write Alpha is selected as the default setting.

· Color format. You can choose either the True Color format or any Image Composer custom 
palette. True Color is the default option.

· Alpha as Color. When this option is selected, the alpha channel information is mapped as a 
color. This option is often used to designate which color of the sprite is displayed as transparent.
Also, the Threshold slider is active. Use this slider to adjust the transparency level. Note also 
that the Write Alpha option is disabled.

· Write Premultiplied Alpha. When the Write Alpha option is selected, you can select the Write 
Premultiplied Alpha to have the alpha premultiplied for you.

· Compression. You can store TGA files as compressed, but you cannot vary the amount of 
compression. TGA uses a run-length encoding compression algorithm.

5 Click Save.



To save an image in TIFF format
{button ,AL("A_MAN
AGING_Working_wi
th_Supported_File_
Types")} Related 
Topics

{button ,AL("
A_MANAGIN
G_Overview 
")} Overview

TIFF format 
information

Tagged-Image Format File, or TIFF, is a preferred file format because it is not lossy. In Microsoft 
Image Composer, TIFFs are stored as a single sprite. To store a sprite as a TIFF:

1 Click the sprite you want to save.
2 On the File menu, click Save As.
3 On the Save In list, click the drive location and folder where you want to save the file.
4 On the Save as type list, click TIFF (*.tif, *.tiff). Image Composer offers you have several options:

· Write Alpha. You can choose whether to save a sprite with the alpha channel or without. In 
other words, when a sprite is saved with the Write Alpha option selected, it is stored as an 
RGBA image. Write Alpha is selected as the default setting.

· Color format. You can choose either the True Color format or any Image Composer custom 
palette. True Color is the default option.

· Alpha as Color. When this option is selected, the alpha channel information is mapped as a 
color. This option is often used to designate which color of the sprite is displayed as transparent.
Also, the Threshold slider is active. Use this slider to adjust the transparency level. Note also 
that the Write Alpha option is disabled.

· Write Premultiplied Alpha. When the Write Alpha option is selected, you can select the Write 
Premultiplied Alpha option to have the alpha premultiplied for you.

· Compression. You can store TIFFs as compressed, but you cannot vary the amount of 
compression. TIFF uses a high-quality compression algorithm called LZW, which removes 
redundant pixel patterns to decrease the size of the file.

5 Click Save.
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MIC file format
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Choosing Alpha as Color

When Alpha as Color is selected on the Save As dialog box, Microsoft Image Composer replaces all
pixels that have alpha values greater than the value specified in the Threshold box with the Sprite 
color. Conversely, all pixels that have alpha values less than the value specified are replaced with the 
current color of the Color Swatch to the right of Alpha as Color. You can change or modify this color
by double-clicking the Color Swatch, which displays the Color Picker.
· Move the Threshold slider to adjust the threshold level, and then click Save.





Adjusting the Threshold of a GIF

When Transparent Color is selected on the Save As dialog box, Microsoft Image Composer 
replaces all pixels that have a transparency level below the threshold with the selected transparent 
color. These pixels appear transparent when you open an image file. All pixels with a transparency 
level above the threshold setting are displayed in their original opaque color.

· Move the Threshold slider to adjust the threshold level, and then click Save.



RGBA
The acronym RGBA stands for the color channels red, green, blue, and alpha. A sprite or composition
saved in this format stores color information in all three colors plus alpha, which stores the opacity 
level.



To choose a paint tool
{button ,AL("A_PAIN
T_To_choose_a_pai
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te")} Related Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

1 On the toolbox, click Paint.
2 On the left side of the Paint tool palette, click the paint tool you want. Paint tools available in 

Microsoft Image Composer are displayed below.

Click the tool below that you want to learn about.

Paint Airbrush Pencil

Smear Impression Eraser

Tint Colorize Dodge/Burn

Contrast Rubber Stamp Transfer

Mesa Vortex Spoke Inversion

Use Brush Use Template Pick Template

Over Continuous Strokes New Brush



To choose a paintbrush
{button ,AL("A_PAIN
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)} Related Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

1 On the toolbox, click Paint.
2 Click Paintbrush.
3 On the Paintbrush Selection grid, click the brush size you want.

4 On the toolbox, click the Color Swatch.
5 Select the color you want.
6 Drag the brush over the sprite to paint it.



To create a paintbrush template
{button ,AL("A_PAIN
T_To_choose_a_pai
nt_brush;A_PAINT_
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e")} Related Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

1 On the toolbox, click Paint.

2 On the Paint palette, click Pick Template. 
3 Click the sprite you want to use as a paintbrush template.
4 Click the paint effect you want to use to paint the current sprite.
5 Drag the pointer over the current sprite to apply the effect.

Note      If you modify the shape of the sprite you use as a template, the paintbrush template changes 
as well. Once you select a sprite to use as a paintbrush template, the shape is retained as the current
template until another template is selected.



To apply a template
{button ,AL("A_PAIN
T_To_create_a_tem
plate")} Related 
Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

1 On the toolbox, click Paint.

2 On the Paint palette, click Pick Template. 
3 Click the sprite you want to use as a paintbrush.
4 Click the paint effect you want.
5 Drag the pointer over the current composition to apply the current paint effect with the template 
paintbrush.



To use a paint effect
{button ,AL("A_PAIN
T_To_choose_a_pai
nt_brush;A_PAINT_
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te;A_PAINT_To_app
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Related Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

1 On the toolbox, click Paint.
2 On the left-most side of the Paint palette, click the paint effect you want on the Paint Effect grid.
3 Use the pointer to apply the selected paint effect to the composition.



Paint Tools Overview
{button ,AL("A_PAIN
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How?

Paint Palette

The Paint Effect grid is located on the left side of the Paint tool palette. These tools allow you to 
create a variety of paint effects. These tools include Paintbrush, Airbrush, Pencil, Smear, 
Impression, Erase, Tint, Colorize, Dodge-Burn, Contrast, Rubber Stamp, Transfer, Mesa, 
Vortex, Spoke Inversion, and Continuous Strokes. You can also create your own custom 
paintbrush or you can use the shape of a sprite as a template brush. You can click the tool you want 
to display a definition of its properties:

·       Paintbrush

·       Airbrush

·       Pencil

·       Smear

·       Impression

·       Erase

·       Tint

·       Colorize

·       Dodge-Burn

·       Contrast

·       Rubber Stamp

·       Transfer

·       Mesa

·       Vortex

·       Spoke Inversion

·       Use Brush

·       Use Template

·       Pick Template



·       Over

·       Continuous Strokes

·       New Brush



Paintbrush
Paintbrush uses the brush selected in the Paintbrush grid as the current paintbrush tool. The 
selected brush appears in the Paintbrush box on the right portion of the Paint tool palette.



Airbrush
Airbrush behaves the same as Paintbrush, except that it produces an airbrushed effect.



Pencil
Pencil draws a one-pixel wide line, in the current color, wherever you drag the pointer.



Smear
Smear blends the sprite's current colors, much the way you could smear fresh paint with your finger.



Impression
Impression can create a smudged, impressionistic effect as you drag the pointer.



Erase
Erase turns the current paintbrush into an eraser. It turns all the color pixels transparent as you drag 
across a sprite or composition.



Tint
Tint applies a translucent wash of the current color to the current sprite or composition, using the 
current paintbrush.



Colorize
Colorize applies the current color without affecting the dark and light intensity values of the sprite.



Dodge-Burn
Dodge-Burn allows you to lighten or darken a specific area of a sprite to change the color saturation 
of an area.



Contrast
Contrast allows you to increase or decrease the contrast in a specific area of a sprite.



Rubber Stamp
Rubber Stamp allows you to copy a sprite or color into the same or another sprite. To use this tool, 
click Rubber Stamp, click on the sprite you want to use as a template, and then you can determine 
your brush size and type.



Transfer
Transfer allows you to copy the colors and textures of an area of a sprite onto another area of the 
same sprite or to a different sprite.



Mesa
This paintbrush effect allows you to warp the pixels within the brush area, giving the appearance of 
wrapping them around a truncated cone.

The first example was created with the In option of Warp Direction selected. It shows the original 
sprite at left. The Mesa paintbrush effect was first applied with a soft-edged brush (center example) 
and then with a hard-edged brush (right example).

The second example was created with the Out option of Warp Direction selected. It shows the 
original sprite at left. The Mesa paintbrush effect was first applied with a soft-edged brush (center 
example) and with a hard-edged brush (right example).



Vortex
This paintbrush effect allows you to warp the pixels within the brush area, making them appear as 
though they are twisted toward the center of the brush area. Note that this paintbrush effect is similar 
to the Vortex effect on the Art Effects tool palette.



Spoke Inversion
This paintbrush effect inverts every spoke of an imaginary disk that fits within the diameter of the 
paintbrush. Note that this paintbrush effect is similar to the Spoke Inversion effect on the Art Effects
tool palette.



Use Brush
This example uses the template color of the rose. This color is "brushed" over the green oval work 
area.



Use Template
In this example, the first sprite, a rose, is used as a brush template. The template was "clicked" onto 
the work area (the green oval) for a silhouette effect. You can also drag the template brush for a 
different brush-stroke effect.



Pick Template
You can use a sprite as a paintbrush by making the sprite a template. You can click Pick Template 
and then select the sprite you want to use as a template brush to apply a paint effect. To use the 
template, click Use Template.



Over
This option determines how paint strokes are applied to a sprite. When Over is not selected, paint 
can be applied only to the non-transparent pixels of the current sprite. When Over is selected, paint 
can be applied to both the transparent and the non-transparent pixels of the current sprite.

The example below displays the original sprite (left), paint strokes applied to the sprite while Over is 
not selected (center), and paint strokes applied to the sprite while Over is selected.



Continuous Strokes
The Continuous Strokes option determines whether the paint stroke is rendered with a solid, even 
flow of paint or with a slow buildup of paint.

The example below displays the original sprite (top). When Continuous Strokes is selected, the 
paint flow is even and smooth as the sprite is used as a brush template (middle). When Continuous 
Strokes is not selected, the paint flow appears intermittent (bottom) and will build up only when the 
brush is not moved.



New Brush
Displays the Brush Designer dialog box.



Paint Effects grid
At the left on the Paint tool palette, the Paint Effects grid contains 20 different paint effect tools.



Paintbrush Selection grid
Displays the array of brushes available on the Paint tool palette. When you create new brushes, they 
are added to the Paintbrush Selection grid. You can also delete brushes from this grid.



Brush utilities
Consists of the New Brush, Delete Brush, and Reset To Defaults buttons.



Brush size tools
Consists of the Brush size slider and Brush size box. You can move the slider to specify the size of 
the brush you want. As you move the slider, the value in the Brush size box changes. You can also 
select the current Brush size value and type the new value you want, or click the arrows to select a 
new value.



Paint opacity tools
Consists of the Opacity slider and Opacity box. You can move the slider to specify the amount of 
opacity you want the current paintbrush effect to have. As you move the slider, the value in the 
Opacity box changes. You can also select the current opacity value and type the new value you want,
or click the arrows to select a new value.



Brush size display
Displays the size of the current brush.



Sticky
When selected, Sticky maintains the current tool selection after you perform an operation.



Warps and Filters group list
Displays a list of 5 Warps and Filters groups: Warps, Warp Transforms, Outlines, Filters, and 
Color Enhancement. Click one of the groups to display the contents of that group in the list below.



Warps and Filters list
Displays a list of items available under each Warps and Filters group. Click one of the items to 
display controls and settings associated with that item.



Escher Warp Spread control
Specifies the amount of spread that the Escher warp provides. The default setting for this control is 
150. Higher settings cause the center of the selected sprite to spread, pushing the edges of the sprite 
toward the sides of the bounding box. Lower settings cause the center of the selected sprite to shrink 
and the lower left and upper right corners of the sprite to elongate. To change the value, select the 
current value and type a number from 0 to 1000, or click the arrows to set a new value.



Mesa Radius Factor control
Specifies the size of the radius of the truncated cone created by the Mesa warp. The default value for 
this control is 70. With Warp Direction set to Out, higher settings cause the edges of the selected 
sprite to become more circular and the center to bulge out. With Warp Direction set to In, higher 
settings cause the center of the selected sprite to shrink and the edges to elongate. To change the 
value, select the current value and type a number from 0 to 100, or click the arrows to set a new 
value.



Angle box
Specifies the angle at which the Vortex or Radial Sweep warps are applied to the selected sprite. 
The default setting for this control is 45 degrees for the Vortex warp and 0 degrees for the Radial 
Sweep warp.

To change the value to a positive value, select the current angle value and type a number from 0 
degrees to 180 degrees, or click the arrows to set a new value. To change the value to a negative 
number, click the arrows or select the current value and enter the number of degrees as a positive 
number, then use the left arrow key on the keypad to move to the leftmost position and type a minus 
sign.



Value box
Specifies the percentage of spoke, from the center to the edge of a sprite, that is sampled for the 
Spoke Inversion warp. The default setting for this control is 100. To change the value, select the 
current value and type a number from 1 to 100, or click the arrows to set a new value.



Frequency % box
Specifies the frequency, or number of cycles of the Wave warp. The default value for this control is 
100, which is 100 percent of one cycle.

Higher values increase the number of waves applied to the selected sprite, so that a value of 200 
percent applies two waves, a value of 300 percent applies 3 waves, and so on. Lower values 
decrease the number of waves applied, so that a value of 50 percent applies a half-wave to the 
selected sprite. To change the value, select the current value and type a number from 1 to 1000, or 
click the arrows to set a new value.



Amplitude % box
Specifies the amplitude, or height, of the wave applied to the selected area. The default setting for this
control is 25.

Higher values raise the height of the wave so that the top and bottom of the wave might be cut off by 
the bounding box of the selected sprite. In the Arrange tool palette, increase the size of the bounding 
box if this occurs. Lower values flatten the height of the wave applied to the sample sprite. To change 
the value, select the current value and type a number from 1 to 100, or click the arrows to set a new 
value.



Symmetrical check box
When selected, specifies that the Wave warp is applied from the center of the sprite.



X Only option
When selected, specifies that the Wave warp is applied only to the x-axis (horizontal axis), of the 
selected sprite. The resulting effect looks like an S-shape.



Y Only option
When selected, specifies that the Wave warp is applied only to the y-axis (vertical axis), of the 
selected sprite.



Both X and Y option
When selected, specifies that the Wave warp is applied equally to both the x-axis (horizontal axis) 
and y-axis (vertical axis). The resulting effect looks as if two waves, one vertical and one horizontal, 
have been applied to the sprite.



Interactive Warps categories
Interactive Warps comprises seven interactive warps; the sample original sprite is in the upper left 
corner. Click a sample to choose a specific Interactive Warp, then drag the mouse over the selected 
sprite to set the amount of warp.



Linear Knee % box
Specifies the linear knee percentage for the Rectangle Options. The Linear Knee warp produces an
effect that appears as if the selected sprite is bent at a specific point, called the knee.

The default setting for this control is 70 percent. Higher values push the center of the selected sprite 
in the direction specified by the Axis control: to the right for X Only, down for Y Only, and down and 
to the right for Both X and Y.

For example, a value of 90 percent increases the effect closer to the right edge of the sprite than does
a value of 60 percent; a value of 90 percent for Y Only increases the effect closer to the bottom of the
sprite than does a value of 60 percent. To change the value, select the current value and type a 
number from 0 to 100, or click the arrows to set a new value.



Function group list
Displays a list of the Functions for Rectangle Options: Sine, Cosine, and Linear Knee. Click the 
Function you want to apply.



Symmetrical check box
When selected, specifies that the Rectangle Options are applied symmetrically to opposite edges 
rather than to a single edge.



X Only option
When selected, specifies that the Rectangular warp transform is applied only to the x-axis (horizontal
axis) of the selected sprite.



Y Only option
When selected, specifies that the Rectangular warp transform is applied only to the y-axis (vertical 
axis) of the selected sprite.



Both X and Y option
When selected, specifies that the Rectangular warp transform is applied equally to both the x-axis 
(horizontal axis) and y-axis (vertical axis) of the selected sprite.



Offset X box
Specifies the degree to which a shadow is cast along the x-axis (horizontal axis). The default setting 
for this control is 5. To change the value, select the current value and type a number from 0 to 100, or 
click the arrows to set a new value. The Shadow filter works differently on sprites that are not 
completely opaque. When applied to sprites that are transparent, this filter darkens colors in those 
sprites.



Offset Y box
Specifies the degree to which a shadow is cast along the y-axis (vertical axis).The default setting for 
this control is 7. To change the value, select the current value and type a number from 0 to 100, or 
click the arrows to set a new value. The Shadow filter works differently on sprites that are not 
completely opaque. When applied to sprites that are transparent, this filter darkens colors in those 
sprites.



Opacity slider
Adjusts the amount of opacity of Shadow, Edge, or Edge Only. Low opacity values create a more 
transparent effect. High opacity values create a more opaque effect. Move the slider left to decrease 
the amount of opacity or right to increase the opacity. The Edge, Edge Only, and Shadow filters work
differently on sprites that are not completely opaque. When applied to sprites that are transparent, 
these filters darken colors in those sprites.



Opacity box
Specifies the opacity value of Shadow, Edge, or Edge Only. Low opacity values create a more 
transparent effect. High opacity values create a more opaque effect. The default value is 100 for 
Edge and Edge Only, and 80 for Shadow. To change the value, select the current value and type a 
number between 0 and 100, or click the arrows to set a new value. The Edge, Edge Only, and 
Shadow filters work differently on sprites that are not completely opaque. When applied to sprites that
are transparent, these filters darken colors in those sprites.



Color swatch
Sets the color of Shadow, Edge, or Edge Only. Click this swatch to display the Color Picker dialog 
box, in which you can click to set a color for the shadow or edge you are creating. You can drag and 
drop a color from the main color swatch to the color swatch on this dialog box. The Edge, Edge Only,
and Shadow filters work differently on sprites that are not completely opaque. When applied to sprites
that are transparent, these filters darken colors in those sprites.



Thickness box
Specifies the thickness in pixels of the edge that will surround the current sprite. The default setting 
for this control is 1. To change the value, select the current value and type a value from 1 to 100, or 
click the arrows to set a new value. The Edge and Edge Only filters work differently on sprites that 
are not completely opaque. When applied to sprites that are transparent, these filters darken colors in
those sprites.



Blur Options, Horizontal control
Specifies the amount of blur applied to the horizontal axis (x-axis) of the selected sprite. The default 
setting for this control is 5. Higher settings make the selected sprite appear more blurry from left to 
right. Lower settings make the selected sprite appear less blurry from left to right. Higher settings 
make the selected sprite appear more blurry (the highest settings might cause the selected sprite to 
become unrecognizable). To change the value, select the current value and type a value from 0 to 
100, or click the arrows to set a new value.



Blur Options, Vertical control
Specifies the amount of blur applied to the vertical axis (y-axis) of the selected sprite. The default 
setting for this control is 5. Higher settings make the selected sprite appear more blurry from top to 
bottom. The highest settings might cause the selected sprite to become unrecognizable. Lower 
settings make the selected sprite appear less blurry from top to bottom. To change the value, select 
the current value and type a value from 0 to 100, or click the arrows to set a new value.
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      Click the effect you want to read about.

Original sprite Plastic Wrap Glass

Craquelure Mosaic Ripple

Chrome Glowing Edges Plaster

Bas Relief

The Exotic group allows you to apply a variety of effects to images in order to create specific results. 
For example, you can do the following:

· Create a smooth metallic surface over an image.
· Create the appearance of water rippling above an image.
· Create an image that seems to be composed of small tiles.



Chrome
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Original sprite Chrome

Chrome covers the sprite with a highly polished smooth metallic surface. Image features of the sprite 
are represented as hills and valleys in the reflecting surface.

Where to find this item
Chrome is available on the Art Effects palette, in the Exotic group.

How to apply this item
Click on the Chrome picture to find out how to apply this item.

How to adjust the results
Move the Detail slider to the right to see more detail reflected in the chrome surface.

Move the Smoothness slider to the right to produce a smoother surface.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      After applying Chrome to a sprite, increase its brightness and contrast to enhance the reflective
quality.
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Original sprite Craquelure

Craquelure covers the sprite with a high-relief plaster-like surface, producing a fine network of cracks
that follow the contours of the sprite.

Where to find this item
Craquelure is available on the Art Effects palette, in the Exotic group.

How to apply this item
Click on the Craquelure picture to find out how to apply this item.

How to adjust the results
Move the Crack Spacing slider to the right to make the spaces between cracks larger.

Move the Crack Depth slider to the right to increase the depth of the cracks.

Move the Crack Brightness slider to the right to increase the brightness of the cracks.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Craquelure works best on sprites that contain a broad range of color or grayscale values. Flat 

areas take on a grid-like look.
· Very low Crack Spacing settings create groups of small highlighted nuggets in the tones of the 

sprite.
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Original sprite Mosaic

Mosaic makes the sprite appear to be composed of small chips or tiles laid down on a flat surface. 
The chips are lit from the side, enhancing their texture.

Where to find this item
Mosaic is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Mosaic picture to learn how to apply this item.

How to adjust the results
Move the Tile Size slider to the right to make the tiles larger.

Move the Grout Width slider to the right to increase the amount of space between tiles.

Move the Lighten Grout slider to the right to lighten the spaces between the tiles.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      Tile Size and Grout Width settings are measured in pixels.
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Original sprite Ripple

Ripple adds randomly spaced ripples to the surface of the sprite, creating the appearance that the 
sprite is underwater, with the wind rippling the water.

Where to find this item
Ripple is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Ripple picture to find out how to apply this item.

How to adjust the results
Move the Ripple Size slider to the right to make the ripples larger.

Move the Ripple Magnitude slider to the right to increase the distortion of the ripples.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      For sprites composed of small elements, use the lower settings; for sprites composed of large 
elements, use higher settings.
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Original sprite Glass

Glass distorts a sprite, as if viewed through glass. You can choose from a variety of glass types, or 
you can specify custom image files for the glass surface.

Where to find this item
Glass is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Glass picture to find out how to apply this item.

How to adjust the results
Move the Distortion slider to the right to increase the amount of distortion caused by the selected 
glass surface and to the left to decrease the amount of distortion.

Move the Smoothness slider to the right to make the result smoother.

Change the glass surface type by displaying the Glass Surface Controls dialog box. Click Surface 
Controls, and select a surface from the Type drop-down list. For more information, see Glass 
Surface Options.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of pixels, retaining 
more of the sprite's original look.

Tips
· When creating your own custom Glass surface images, remember that any features that are 

visible in your surface image will show up as areas that will bend and refract the input image to the 
effect. For example, if you have a square in your surface image, the image that is created by the 
Glass effect using this surface will be unchanged everywhere except around the edges of where 
the square is located.

· You can combine the Glass effects to create effects that are not available with a single Glass 
variation. For example, apply Glass using one surface texture. Then apply Glass again using a 
different surface texture.

· If, after applying Glass, any areas of the sprite show too much detail, try applying Blur using 
values of 1 or 2 for Horizontal and Vertical to smooth these areas.

· Applying Blur with large Horizontal and Vertical settings, or several applications of smaller 
Horizontal and Vertical settings, enhance the appearance of the Frosted variation of Glass.

· For a surrealistic look, preprocess the original sprite with multiple blurs or the Diffuse Glow effect 
before applying Glass.
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Original sprite Plaster

Plaster makes the sprite look like it is molded from three-dimensional plaster. The dark areas of a 
sprite are raised into bumps and plateaus, while lighter areas are flattened into valleys. This effect 
works especially well on text or simple, high-contrast objects.

The dark areas in the original sprite take on the Color Picker's current color. Midtones and highlights 
take on tints of the Composition Guide's current color.

Where to find this item
Plaster is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Plaster picture to find out how to apply this item.

How to adjust the results
Move the Image Balance slider to the right to increase the areas of the image that appear as valleys 
and to decrease the areas that appear as bumps and plateaus.

Alter the location of the light source in the Light Position drop-down list.

Move the Smoothness slider to the right for a smoother effect.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· For a more realistic result, try increasing the contrast of your sprite before you apply Plaster.
· For an interesting variation, apply Complement Color before you apply Plaster.
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Original sprite Glowing Edges

Glowing Edges amplifies the edges of a sprite in bright luminous colors.

Where to find this item
Glowing Edges is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Glowing Edges picture to find out how to apply this item.

How to adjust the results
Move the Edge Width slider to the right to make the edges wider.

Move the Smoothness slider to the right to increase the smoothness of the edges.

Move the Edge Brightness slider to the right to make the edges stronger and brighter.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      To enhance the apparent colors in the final sprite, increase the contrast of the sprite before you 
apply Glowing Edges. Increasing the contrast also can create new edges.
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Original sprite Plastic Wrap

Plastic Wrap creates the appearance that the sprite is wrapped in shiny plastic that accentuates the 
surface detail of the sprite.

Where to find this item
Plastic Wrap is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Plastic Wrap picture to find out how to apply the item.

How to adjust the results
Move the Highlight Strength slider to the right for stronger highlights.

Move the Detail slider to the right to increase the amount of detail from the original sprite that will be 
used to create the shine in the final image.

Move the Smoothness slider to the right for a smoother result.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.
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Original sprite Bas Relief

Bas Relief makes the sprite appear to have been carved in low relief and lit to accent the surface 
modulations of the sprite.

The dark areas in the original sprite take on the Color Picker's current color. Midtones and highlights 
take on tints of the Composition Guide's current color.

Where to find this item
Bas Relief is available on the Art Effects tool palette, in the Exotic group.

How to apply this item
Click the Bas Relief picture to find out how to apply this item.

How to adjust the results
Move the Detail slider to the right to increase the surface detail of the sprite.

Alter the location of the light source in the Light Position drop-down list.

Move the Smoothness slider to the right for a smoother surface.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of pixels, retaining 
more of the sprite's original look.
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Original sprite Poster Edges Cutout

Stained Glass Patchwork Reticulation

Torn Edges Stamp Halftone Screen

Photocopy Note Paper

The Graphic group allows you to apply specialized effects to sprites to generate a specific result. For 
example, you can make sprites that seem to be created:

· From pieces of stained glass.
· From pieces of cloth, like a quilt.
· By an ink stamp.
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Original sprite Poster Edges

Poster Edges reduces the number of color shades in a sprite and adds dark lines along the edges. 
Large, broad areas have simple shading, while fine, dark detail is distributed throughout the sprite.

Where to find this item
Poster Edges is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Poster Edges picture to find out how to apply this item.

How to adjust the results
Move the Edge Thickness slider to the right to make the added edges thicker.

Move the Edge Intensity slider to the right to make edge outlining more apparent.

Move the Posterization slider to the right to increase the number of colors in the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      Before applying Poster Edges, try sharpening the sprite and adjusting the brightness and 
contrast.
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Original sprite Note Paper

Note Paper creates the appearance that the sprite was imprinted on embossed note paper.

The dark areas in the original sprite become the embossed areas, which use the Color Picker's 
current color. The light areas become the rough paper surface, which takes on the current color of the
Composition Guide.

Where to find this item
Note Paper is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Note Paper picture to find out how to apply this item.

How to adjust the results
Move the Image Balance slider to the right to increase the number of dark areas in the sprite, which 
will become embossed regions. Move the Image Balance slider to the left to increase the number of 
light areas in the sprite, which will become rough paper areas.

Move the Graininess slider to the right for grainier paper.

Move the Relief slider to the right to increase embossing.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· To incorporate textures other than simple grain, apply Note Paper with Graininess set to 0. Then 

apply the Texturizer with your choice of texture.
· Enliven black-and-white sprites by applying Note Paper with various Color Swatch and 

Composition Guide colors.
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Original sprite Patchwork

Patchwork creates the appearance that the sprite was stitched using needle and thread. The 
resulting small squares are shadowed to indicate varying depth.

Where to find this item
Patchwork is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Patchwork picture to find out how to apply this item.

How to adjust the results
Move the Square Size slider to the right for larger squares.

Move the Relief slider to the right for higher relief. Increasing the Relief setting results in squares with
harder edges, giving the sprite a tiled appearance.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· After applying Patchwork, you can enhance the needlepoint look by using Texturizer with a fabric 

texture (e.g., Canvas or another scanned cloth texture).
· For more definition of sprite features, try adjusting the contrast before applying Patchwork. When 

contrast is high, large areas of the sprite flatten out and don’t show the three-dimensional surface 
features characteristic of the Patchwork effect.



Photocopy
{button ,AL("graphic 
item")} Related 
Topics

{button ,AL("
graphic ovr")}
Overview

{button ,AL("graphic 
how;photocopy how")}
How?

Original sprite Photocopy

Photocopy redraws the sprite as a two-color image resembling a photocopy of the original, using 
colors you select. Large dark areas tend to copy only around their edges, and midtones become solid 
colors.

The darks in the original sprite use the Color Picker's current color. Midtones and highlights use tints 
of the Composition Guide's current color.

Where to find this item
Photocopy is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Photocopy picture to find out how to apply this item.

How to adjust the results
Move the Detail slider to the right for more detail in the sprite.

Move the Darkness slider to the right to increase the amount of darkness in the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Simulate the effect of photocopying an image several times by applying Photocopy to an image 

twice. The first time, use the default settings. Apply the effect again on the resulting image, but this 
time decrease the Detail to the point where amounts of the black areas (created in the first pass) 
start to dissolve.

· Try applying Colored Pencil after applying Photocopy twice to create an excellent pencil sketch 
effect. Increase the brightness and contrast of the resulting image to create the look you desire.
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Original sprite Stamp

Stamp draws the sprite to look like the imprint of a wooden or rubber stamp.

The dark areas in the original sprite use the Color Picker's current color. Midtones and highlights use
tints of the Composition Guide's current color.

Where to find this item
Stamp is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Stamp picture to find out how to apply this item.

How to adjust the results
Move the Light/Dark Balance slider to the right to increase the areas of the sprite that use the color 
currently displayed in the Color Swatch.

Move the Smoothness slider to the right to increase the overall smoothness of the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Try applying Texturizer after applying Stamp to add texture to the solid areas of color on the 

sprite.
· To create a stamp-pad look, apply Grain after Stamp to break up flat areas in the selection.
· To reduce unwanted texture in the lighter areas of the sprite, increase the brightness and contrast.
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Original sprite Cutout

Cutout creates the appearance that the sprite is composed of roughly cut pieces of colored paper. 
High-contrast sprites appear to be silhouetted, while colored images appear to be composed of 
several layers of colored paper. Cutout can also look like a linoleum block print, especially when 
applied to a simple high-contrast sprite.

Where to find this item
Cutout is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Cutout picture to find out how to apply this item.

How to adjust the results
Move the No. of Levels slider to the right for more levels of color. Higher settings create greater 
detail.

Move the Edge Simplicity slider to the right to simplify the cutout edge.

Move the Edge Fidelity slider to the right to depress the cutout edges and retain the fidelity of the 
shapes in the sprite. Move the Edge Fidelity slider to the left to create a more distorted 
representation of the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      For more depth and overlap of the layers created with Cutout, try following it with the Emboss 
effect.
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Original sprite Halftone Screen

Halftone Screen creates the appearance that the sprite has been printed using a variety of halftone 
dot screens. Unlike digital halftones, this effect displays the continuous tones of an image as smoothly
varying element sizes that blend together like those created by an analog halftone screen.

The dark areas in the original sprite use the Color Picker's current color. Midtones and highlights use
tints of the Composition Guide's current color.

Where to find this item
Halftone Screen is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Halftone Screen picture to find out how to apply this item.

How to adjust the results
Move the Size slider to the right to increase the size of the elements in the halftone screen layer.

Alter the type of screen used by selecting an option from the Screen Type drop-down list.

Move the Contrast slider to the right to increase the contrast.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· To add a halftone edge to a high-contrast sprite, such as text, apply Blur before applying the 

halftone.
· Try applying Halftone Screen to posterized sprites or to sprites processed with Cutout. This 

technique creates uniform halftone dots in the large flat areas of common color.
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Original sprite Reticulation

Reticulation simulates the photographic effect created when film emulsion shrinks and distorts an 
image in a controlled way. This effect renders the darker areas of the sprite with dense clumps of dark
emulsion and the lighter areas with stippled grain.

The dark areas in the original sprite use the Color Picker's current color. Midtones and highlights use
tints of the Composition Guide's current color.

Where to find this item
Reticulation is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Reticulation picture to find out how to apply this item.

How to adjust the results
Move the Density slider to the right for denser stippling.

Move the Black Level slider to the right to increase the areas taking on the current color of the Color 
Swatch.

Move the White Level slider to the right to increase the areas taking on the current color of the 
Composition Guide.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· You can create a range of evocative effects by applying Diffuse Glow before applying 

Reticulation. Try adding just a little of the Glow effect.
· Try using the Reticulation effect to add background paper texture and grain to a composition.
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Original sprite Stained Glass

Stained Glass creates the illusion that the sprite is made up of small pieces of colored glass, lit from 
behind. You can vary the strength of the light shining through the glass from an even glow to a 
focused brilliance. The borders around the pieces of glass are rendered in the Color Picker's current 
color.

Where to find this item
Stained Glass is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Stained Glass picture to find out how to apply this item.

How to adjust the results
Move the Cell Size slider to the right for bigger stained glass pieces.

Move the Border Thickness slider to the right for wider borders around the glass pieces.

Move the Light Intensity slider to the right to brighten the light that shines through the glass pieces.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· By applying Poster Edges or Cutout before applying the Stained Glass effect, you can create 

larger areas of common color to enhance the Stained Glass effect.
· To make the sprite appear to be viewed through leaded glass, reduce the Opacity setting, choose 

a dark color for the borders, and reduce the Light Intensity.
· To give the sprite an antique look, apply the Ripple effect with low Ripple Magnitude and Ripple 

Size settings.
· Adding a bit of grain by using the Grain effect before applying Ripple further enhances the aged 

quality of the result.
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Original sprite Torn Edges

Torn Edges makes the edges of the sprite look like torn paper. This effect works best with text or with
simple high-contrast graphical sprites.

The dark areas in the original sprite use the Color Picker's current color. Midtones and highlights use 
tints of the Composition Guide's current color.

Where to find this item
Torn Edges is available on the Art Effects tool palette, in the Graphic group.

How to apply this item
Click the Torn Edges picture to find out how to apply this item.

How to adjust the results
Move the Image Balance slider to the right to emphasize the darker areas of the original sprite and to
the left to emphasize the areas of midtones and highlights.

Move the Smoothness slider to the right for a smoother result.

Move the Contrast slider to the right for higher contrast.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Try this effect as a final touch after applying Stamp or Photocopy.
· This is a great effect to roughen type.
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Original Sprite Watercolor Spatter

Sponge Dry Brush Fresco

Dark Strokes Paint Daubs Sprayed Strokes

Sumi-e Accented Edges Underpainting



Water Paper Palette Knife

The Paint group allows you to apply specialized effects to create specific artistic results. For example,
you can make the sprite appear to have been painted with:

· Watercolors
· A palette knife
· A spatter airbrush technique
· A sponge
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Original sprite Dark Strokes

Dark Strokes paints the sprite with diagonal black-and-white brush strokes. The lighter areas are 
whitened and are painted with longer strokes that are visible outside areas that are not solid white. 
The darker areas are blackened and are painted with short, tight strokes.

Where to find this item
Dark Strokes is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Dark Strokes picture to find out how to apply this item.

How to adjust the results
The Balance slider changes the proportions of the areas affected by each of the two painting strokes.
Move the slider to the right to increase the area to be painted with short, dark strokes and to the left to
increase the area to be pained with longer, white strokes.

Move the Black Intensity slider to the right to increase the intensity of black painted on the sprite.

Move the White Intensity slider to the right to increase the intensity of white painted on the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      After applying Dark Strokes, try sharpening the sprite by using the Sharpen or Sharpen Lite 
filter from the Warps and Filters tool palette.
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Original sprite Dry Brush

Dry Brush paints the edges of the sprite using a dry brush technique and simplifies the sprite into 
areas of common color. Reapplying the effect further reduces color detail.

Where to find this item
Dry Brush is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Dry Brush picture to find out how to apply this item.

How to adjust the results
Move the Brush Size slider to the left to make the painting style more complex and paint with a 
smaller brush. Move the Brush Size slider to the right to simplify the painting style and to paint with a 
larger brush.

Move the Brush Detail slider to the right to increase the amount of detail in the individual paint 
strokes and dabs.

Move the Texture slider to the left for a smoother texture, and move it to the right for a rougher 
texture.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· After you apply Dry Brush, try Emboss for more depth.
· Try sharpening the result by using the Sharpen or Sharpen Lite filters from the Warps and Filters

tool palette.
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Original sprite Fresco

Fresco paints the sprite in a coarse painting style using short, rounded dabs.

Where to find this item
Fresco is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Fresco picture to find out how to apply this item.

How to adjust the results
Move the Brush Size slider to the right to paint with a coarser brush.

Move the Brush Detail slider to the right to give more detail within each stroke or dab.

Move the Texture slider to the left for a smoother texture and to the right for a rougher texture.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Spatter
{button ,AL("paint, 
ae item")} Related 
Topics

{button ,AL("
paint, art 
effect ovr")} 
Overview

{button ,AL("paint 
effect how")} How?

Original sprite Spatter

Spatter paints the sprite in a pointillist style using a spatter airbrush technique.

Where to find this item
Spatter is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Spatter picture to find out how to apply this item.

How to adjust the results
Move the Spray Radius slider to the right to spray within a wider radius of the selection.

Move the Smoothness slider to the right to create a smoother effect.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.
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Original sprite Watercolor

Watercolor paints the sprite in watercolor style using a medium brush loaded with water and color. 
The color appears to have dried on smooth paper, leaving dark concentrations of pigment around the 
edges of the dabs.

Where to find this item
Watercolor is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Watercolor picture to find out how to apply this item.

How to adjust the results
Move the Brush Detail slider to the right to paint with more detail.

Move the Shadow Intensity slider to the right to add more shadows.

Move the Texture slider to the right for a rougher texture.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Try applying Emboss after applying Watercolor.
· If the dabs created by Watercolor are too small, try applying Palette Knife first, with a large 

Stroke setting. Then apply Watercolor to the sprite.



Accented Edges
{button ,AL("paint, 
ae item")} Related 
Topics

{button ,AL("
paint, art 
effect ovr")} 
Overview

{button ,AL("paint 
effect how")} How?

Original sprite Accented Edges

Accented Edges adds edge accents to a sprite. When the Edge Brightness control is set to a high 
value, the accents resemble white chalk; when set to a low value, the accents resemble black ink.

Where to find this item
Accented Edges is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Accented Edges picture to find out how to apply this item.

How to adjust the results
Move the Edge Width slider to the right to make the edges wider.

Move the Edge Brightness slider to the right to make the edges brighter and to the left to make them
darker. The middle setting has no effect on the edges.

Move the Smoothness slider to the right to make the overall result smoother and to the left to retain 
more detail.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Try applying this effect before some of the other effects (such as Dry Brush, Watercolor, or 

Texturizer) to make the result even more paint-like.
· When Accented Edges is applied to a high-resolution sprite (so that the resulting accented edges 

are narrow), the result is similar to egg tempera.
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Original sprite Palette Knife

Palette Knife creates rough, irregular patches of color that appear to have been applied by a palette 
knife.

Where to find this item
Palette Knife is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Palette Knife picture to find out how to apply this item.

How to adjust the results
Move the Stroke Size slider to the right for bigger knife strokes.

Move the Stroke Detail slider to the right for more detailed knife strokes.

Move the Softness slider to the right for softer edges.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· For a special effect, apply Poster Edges or Accented Edges to the selection before applying 

Palette Knife.
· For a realistic manually applied paint look, use Texturizer after applying Palette Knife. Try using 

the Canvas texture type.
· If the daubs created by Watercolor are too small (especially when working with large sprites), first 

apply Palette Knife with a high Stroke Size setting. Then apply Watercolor for the final watercolor
style.



Sprayed Strokes
{button ,AL("paint, 
ae item")} Related 
Topics

{button ,AL("
paint, art 
effect ovr")} 
Overview

{button ,AL("paint 
effect how")} How?

Original sprite Sprayed Strokes

Sprayed Strokes paints a sprite in disjointed sprayed strokes of adjustable length and orientation.

Where to find this item
Sprayed Strokes is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Sprayed Strokes picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right for longer strokes.

Alter the direction of the sprayed strokes by choosing one of the options in the Stroke Direction 
drop-down list.

Move the Spray Radius slider to the right to spray within a wider radius and create more disjointed 
strokes.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      Try applying Sprayed Strokes before you apply some of the other effects (such as Dry Brush 
or Watercolor) to make the result more paint-like.



Underpainting
{button ,AL("paint, 
ae item")} Related 
Topics

{button ,AL("
paint, art 
effect ovr")} 
Overview

{button ,AL("paint 
effect how")} How?

Original sprite Underpainting

Underpainting roughly paints the image of the sprite on an underlying surface texture, then paints 
the image of the sprite again over the first image.

Where to find this item
Underpainting is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Underpainting picture to find out how to apply this item.

How to adjust the results
Move the Brush Size slider to the right to increase the brush size and to create more heavily 
accented contours.

Move the Texture Coverage slider to the right to increase the area of the sprite that receives 
underlying texture.

Adjust the texture type and direction of light in the Texture Controls dialog box. Click Texture 
Controls, then select from the options available in the Type and Light Position drop-down lists. For 
more information, see Texture Options in help.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      Try creating your own textures of wood, paper, or other materials before applying 
Underpainting.
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Original sprite Paint Daubs

Paint Daubs is a suite of effects that renders a selection using a variety of paintbrush styles and 
sizes.

Where to find this item
Paint Daubs is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Paint Daubs picture to find out how to apply this item.

How to adjust the results
Move the Brush Size slider to the right for a larger brush size. Larger brush sizes smooth and 
simplify images while smaller brush sizes accentuate fine details.

Alter the brush type by selecting an option in the Brush Type drop-down list.

Move the Sharpness slider to the right for sharper details.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· Use the suite of styles in this effect to accentuate an artistic look before applying other effects.
· On variations that use large brush sizes, try moving the Sharpness slider all the way to the right. 

This brings out the small color details of the resulting sprite. These colors can be accentuated even
more by processing with other variations of the Paint Daubs effect.

· Most of the styles created by Paint Daubs benefit from a final application of the Texturizer, which 
creates the impression that the sprite was painted on a textured background.
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Original sprite Sponge

Sponge roughly dabs or blots the colors in a sprite. This effect is characterized by highly textured 
areas of contrasting color.

Where to find this item
Sponge is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Sponge picture to find out how to apply this item.

How to adjust the results
Move the Brush Size slider to the right for a larger brush size.

Move the Definition slider to the right for better defined textured areas.

Move the Smoothness slider to the right for a smoother look.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· To enhance Sponge, apply the Texturizer effect after applying Sponge. The Sandstone or Brick 

textures work well.
· To create the appearance of depth, apply Emboss after applying Sponge.
· For some sprites, the combination of Sponge followed by Ink Outlines can create a strong 

impression of age and wear.
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Original sprite Sumi-e

Sumi-e (pronounced sue-me-ay) paints the sprite with a wet brush heavily loaded with ink, resulting 
in rich blacks with soft, blurry edges on a textured, highly absorbent ground, such as rice paper.

Where to find this item
Sumi-e is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Sumi-e picture to find out how to apply this item.

How to adjust the results
Move the Stroke Width slider to the right for a broader stroke.

Move the Stroke Pressure slider to the right to increase the pressure of the stroke.

Move the Contrast slider to the right for more contrast.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.
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Original sprite Water Paper

Water Paper renders a sprite with blotchy daubs of color that appear to have been painted on damp 
paper. The painted colors appear blurred and seem to run along the fibers of the paper, softening and 
extending the original outlines of the sprite.

Where to find this item
Water Paper is available on the Art Effects tool palette, in the Paint group.

How to apply this item
Click the Water Paper picture to find out how to apply this item.

How to adjust the results
Move the Fiber Length slider to the right for longer paper fibers.

Move the Brightness slider to the right for a brighter sprite.

Move the Contrast slider to the right for higher contrast.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· To give a sprite a more authentic painting look, apply Water Paper before you apply other effects 

from the Paint tool palette.
· Use Texturizer to enhance the impression of damp paper. Any texture, when used with a low 

Relief value, makes the streaks created with Water Paper look like they were naturally created 
during the painting process.

· Use Ripple at a low setting to create the impression that the paint has meandered somewhat as it 
was blotched on the damp paper.
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Original sprite Smudge Stick Angled Strokes

Rough Pastels Colored Pencil Ink Outlines

Crosshatch Conté Crayon Charcoal

Chalk And Charcoal Graphic Pen

The Sketch group allows you to apply specialized effects to produce specific results. For example, 
you can make a sprite appear to have been drawn with:

· Charcoal.
· Pastel colored chalk.
· A graphic pen.
· Ink.
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Original sprite Angled Strokes

Angled Strokes paints the selection in bi-directional diagonal strokes. The lighter areas of the sprite 
are painted in strokes going one direction, while the darker areas are painted in strokes going the 
opposite direction.

Where to find this item
Angled Strokes is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Angled Strokes picture to find out how to apply this item.

How to adjust the results
Move the Direction Balance slider to the right to increase the proportion of right diagonal strokes and
to the left to increase the proportion of left diagonal strokes.

Move the Stroke Length slider to the right to make the strokes longer.

Move the Sharpness slider to the right to increase the detail of the sprite and to the left to increase 
the softness of the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tip      To create an exaggerated version of this effect, scale the selection down to 50 percent or 25 
percent, apply Angled Strokes, and then scale the selection back up to its original size. You can 
sharpen the result to make the strokes more apparent.
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Original sprite Chalk And Charcoal

Chalk And Charcoal transforms the sprite using coarse diagonal strokes on a solid medium-gray 
background.

The charcoal is drawn using the current color of the Color Swatch, and the chalk is drawn using the 
current color of the Composition Guide.

Where to find this item
Chalk And Charcoal is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Chalk And Charcoal picture to find out how to apply this item.

How to adjust the results
Move the Charcoal Area slider to the right to increase the amount of dark areas drawn with charcoal.

Move the Chalk Area slider to the right to increase the amount of light areas drawn with chalk.

Move the Stroke Pressure slider to the right to increase the intensity of the charcoal and chalk 
strokes.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Charcoal
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Original sprite Charcoal

Charcoal draws the sprite onto a rough, paper surface. Major edges are drawn boldly while midtones 
are sketched using diagonal strokes.

Charcoal areas are drawn using the current color of the Color Swatch. The paper color is the current 
color of the Composition Guide.

Where to find this item
Charcoal is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Charcoal picture to find out how to apply this item.

How to adjust the results
Move the Charcoal Thickness slider to the right to draw thicker lines.

Move the Detail slider to the right for more detail in the selection.

Move the Light/Dark Balance slider to the right to darken the selection.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Graphic Pen
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Original sprite Graphic Pen

Graphic Pen captures the details of a sprite in fine linear ink strokes, as if drawn on paper on a fine-
grained wood surface. The stroke density increases in darker areas and is less evident in the lighter 
areas of the sprite.

The current color of the Color Swatch is used for the ink color, and the current color of the 
Composition Guide is used for the paper color.

Where to find this item
Graphic Pen is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Graphic Pen picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right to lengthen the strokes.

Alter the direction of the stroke by selecting an option from the Stroke Direction drop-down list.

Move the Light/Dark Balance slider to the right for a higher proportion of ink.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· For better results, try increasing the contrast of the sprite before applying Graphic Pen.
· After applying the effect, blur the sprite to smooth the pen lines.



Smudge Stick
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Original sprite Smudge Stick

Smudge Stick smears the darker areas of the sprite with short diagonal strokes. Lighter areas are 
brightened.

Where to find this item
Smudge Stick is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Smudge Stick picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right to increase the stroke length.

Move the Highlight Area slider to the right to increase the areas being whitened.

Move the Highlight Intensity slider to the left to increase the transparency of the brightened sprite 
(this lets more of the original sprite show through).

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Colored Pencil
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Original sprite Colored Pencil

Colored Pencil draws an image using colored pencils on a solid background. Major edges are 
retained and given a rough, crosshatched appearance, while the solid background is allowed to show 
through the smoother areas of the sprite, simulating rough gray sketch paper.

Where to find this item
Colored Pencil is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Colored Pencil picture to find out how to apply this item.

How to adjust the results
Move the Pencil Width slider to the right to widen the pencil stroke.

Move the Stroke Pressure slider to the right to increase the intensity of the pencil stroke.

Move the Paper Brightness slider to the right to increase the brightness of the background paper.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Rough Pastels
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Original sprite Rough Pastels

Rough Pastels sketches the sprite in rough strokes of colored pastel chalk on a textured 
background. In areas of bright color the chalk is thick, with little texture; in darker areas the chalk is 
thinner, revealing the background texture.

Where to find this item
Rough Pastels is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Rough Pastels picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right for longer strokes.

Move the Stroke Detail slider to the right for better defined strokes.

Alter light position and texture type in the Texture Controls dialog box. Click Texture Controls and 
select options from the Type and Light Position drop-down lists. For more information, see Texture 
Options.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Conté Crayon
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Original sprite Conté Crayon

Conté (pronounced CON-tea) Crayon sketches the sprite in highly textured soft strokes on a rough 
textured background, using colors you select.

The dark areas in the original sprite use the Color Picker's current color. Midtones and highlights use
tints of the Composition Guide's current color.

Where to find this item
Conté Crayon is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Conté Crayon picture to find out how to apply this item.

How to adjust the results
Move the Foreground Level slider to the right for heavier coverage of the Color Picker’s current 
color over the gray background.

Move the Background Level slider to the right to increase the coverage of the current color of the 
Composition Guide over the gray background.

Alter light position and texture type in the Texture Controls dialog box. Click Texture Controls and 
select options from the Type and Light Position drop-down lists. For more information, see Texture 
Options.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· For authenticity, try foreground colors such as black, sepia, or sanguine to emulate the colors of 

real Conté crayon.
· Conté crayon used with the Sandstone texture resembles nineteenth-century Conté drawings.



Crosshatch
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Original sprite Crosshatch

Crosshatch sketches the sprite using fine hatched strokes in the existing colors. While preserving the
features of the original sprite, this effect adds texture and roughens the edges of the colored areas.

Where to find this item
Crosshatch is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Crosshatch picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right for longer strokes.

Move the Sharpness slider to the right for sharper, harder hatching.

Move the Strength slider to indicate the number of times you want the effect to be applied in 
succession. More iterations strengthens the results of this effect.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.



Ink Outlines
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Original sprite Ink Outlines

Ink Outlines draws fine, narrow lines around the details in the sprite and crosshatches the midtone 
areas to create a corroded pen-and-ink look.

Where to find this item
Ink Outlines is available on the Art Effects tool palette, in the Sketch group.

How to apply this item
Click on the Ink Outlines picture to find out how to apply this item.

How to adjust the results
Move the Stroke Length slider to the right for longer crosshatch strokes.

Move the Dark Intensity slider to the right to increase the amount of dark areas.

Move the Light Intensity slider to the right to increase the amount of light areas.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the sprite's original look.

Tips
· You can vary the textures that Ink Outlines creates by processing the selection first with one of the

Paint Daubs variations.
· Try adding texture by applying any one of the several Grain effects before you apply Ink Outlines.
· If the output of Ink Outlines is too harsh, blur the sprite with a small blur and then adjust the 

brightness and contrast.
· Higher contrast versions of Ink Outlines (increase the Dark Intensity and Light Intensity 

settings) tend to look more like pen-and-ink drawings. If these higher contrast sprites are blurred 
successively with a few small blurs, they look like soft pencil sketches.

· For a softened pen-and-ink effect, try applying Water Paper (with a small Fiber Length setting) 
after applying Ink Outlines.



Utility Overview
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      Click the effect you want to read about.

Original sprite Emboss Neon Glow

Grain Diffuse Glow Film Grain

Texturizer

The Utility group allows you to apply specialized effects to images to create a specific result. For 
example, you can create the appearance of:

· A three-dimensional image.
· Surface texture to an image.
· Film-grain texture to an image.

Utility effects are available on the Art Effects tool palette. You can apply one or more of these effects
to one sprite or to a selection set of sprites.



Emboss
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Original sprite Emboss

Emboss gives the sprite a three-dimensional appearance.

Where to find this item
Emboss is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click the Emboss picture to learn how to apply this item.

How to adjust the result
Move the Relief slider to the right to increase the amount of embossing.

From the Light Position list box, select the position from which to light the sprite.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the original look of the sprite.

Tip      For striking results, try applying this effect after applying any other effect.



Film Grain
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Original sprite Film Grain

Film Grain adds a film-grain texture to the selection. An even pattern is added to the dark areas and 
midtones; a smoother, more saturated pattern is added to the sprite's lighter areas.

Where to find this item
Film Grain is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click on the Film Grain picture to learn how to apply this effect.

How to adjust the result
Move the Grain slider to the right to increase the grain of the image.

Move the Highlight Area slider to 20 for more white highlights.

Move the Highlight Intensity slider to 10 for more intense highlights.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the original look of the sprite.



Texturizer
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Original sprite Texturizer

Texturizer applies a surface texture to a selection. Using the Texture Controls dialog box, you can 
select a pre-defined texture, or you can create your own texture to apply as a .tif file.

Where to find this item
Texturizer is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click on the Texturizer picture to learn how to apply this item.

How to adjust the results
Alter the texture type and location of the light source in the Texture Controls dialog box. Click 
Texture Controls and select an option from the Type and Light Position drop-down boxes. For 
more information, see Texture Options in help.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the original look of the sprite.

Tips
· Use Texturizer to create a random textured pattern. Select Texturizer, set Relief to 50, and 

choose Sandstone from the Type list. This random noise pattern can be applied to a white or 
black background for a fancy appearance. You also can get good results by using it on text sprites.

· For maximum texturing, choose a light source direction perpendicular to the dominant direction of 
the texture. Textures that are parallel to the light source direction tend to show little relief.



Grain
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Original sprite Grain

Grain adds a wide variety of grain types to the selection.

Where to find this item
Grain is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click on the Grain picture to learn how to apply this item.

How to adjust the results
Move the Graininess slider to the right for a grainier effect.

Alter the type of grain used by selecting an option from the Grain Type drop-down list. Click here to 
see samples. 

Move the Contrast slider to 100 to increase the contrast.
Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, retaining 
more of the original look of the sprite.

Tips
· The grain types available in this effect are good for adding tooth to a sprite before applying other 

effects. This is especially true with synthetic images that have been created by paint programs, 3-D
graphics programs, or with typography. Adding a small amount of grain yields better results with 
most effects.

· By adding grain of the appropriate type, you can match the amount of visible grain in a set of 
sprites generated from different sources.

· You can simulate the appearance of old photographs by using the various grain types. The effect is
enhanced if the colors are changed to a sepia tone (yellow-brown) using Microsoft Image 
Composer's hue/saturation controls on the Color Tuning tool palette. For a more realistic look, try 
adding small speckles of paint by using the Paint tools to simulate bits of dirt. Also, you may want 
to randomly blur areas of the sprite using the Blur effect, on the Warps and Filters palette.



Grain types
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Grain types are available on the Art Effects tool palette, in Utility group. You can apply one or more 
of these effects to one sprite or to a selection set of sprites.

The Stippled grain type uses the current colors of the Color Picker and the Composition Guide. 
The Sprinkles grain type uses the current color of the Composition Guide. Other grain types use 
the original colors of the sprite or black.

Original sprite Regular Soft

Sprinkles Clumped Contrasty

Enlarged Stipple Horizontal

Vertical Speckle
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Original sprite Diffuse Glow

Diffuse Glow makes the selection look as if it were viewed through a soft diffusion filter. Brighter 
areas glow with diffused light, while other areas are muted with soft granularity.

Note      The current Composition Guide color is used for the diffuse glow color.

Where to find this item
Diffuse Glow is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click on the Diffuse Glow picture to learn how to apply this item.

How to adjust the results
Move the Graininess slider to the right to increase the grain in the image.

Move the Glow Amount slider to the right to increase areas of the sprite affected by the glow.

Move the Clear Amount slider to the right to increase the amount of the sprite not affected by the 
glow.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the original look of the sprite.



Neon Glow
{button ,AL("utility 
item")} Related 
Topics

{button ,AL("
utility ovr")} 
Overview

{button ,AL("utility 
how")} How?

Original sprite Neon Glow

Neon Glow adds various types of glows to the objects in a selection. This effect can be used to 
create neon effects or to give an object the appearance of radiating light and heat. This effect is 
particularly useful for text sprites or simple, high-contrast graphical sprites.

Note      The current colors of the composition guide and the Color Swatch are used for Neon Glow.

Where to find this item
Neon Glow is available on the Art Effects tool palette, in the Utility group.

How to apply this item
Click on the Neon Glow picture to learn how to apply this item.

How to adjust the results
The Glow Size slider can be set over a range of positive or negative values. Positive Glow Size 
settings create glows on the outside of dark areas and on the inside of light areas, while negative 
settings create glows on the inside of dark areas and the outside of light areas. Greater settings 
create larger glow effects.

Move the Glow Brightness slider to the right to increase the brightness of the glow.

Click the Glow Color swatch to select a color for the glow using the Color Picker dialog box.

Move the Opacity slider to the right to blend more of the effect with the original sprite. Higher opacity 
values create more total effect. Lower opacity settings blend a smaller proportion of the effect, 
retaining more of the original look of the sprite.

Tip      Neon Glow can produce both outline and inline glow variations. An outline glow appears to be 
around the outside of the sprite; for example, around the outside of a letter. An inline glow appears to 
be on the inside of the letter. When the inside areas are small, the Glow Size and Glow Brightness 
settings should be adjusted correspondingly.



General Keyboard Shortcuts

Keyboard 
Combination Result

CTRL+A Selects all the sprites in a composition.

CTRL+C Copies the selected sprites.

CTRL+D Duplicates the selected sprite.

CTRL+E Explodes the selected group.

CTRL+F Flattens the selected sprites.

CTRL+G Groups the selected sprites.

CTRL+L Locks or Unlocks the position of a sprite.

CTRL+N Creates a new Microsoft Image Composer 
composition.

CTRL+O Displays the Open dialog box.

CTRL+P Prints the current composition.

CTRL+S Saves the current composition.

CTRL+T Clears the current selection.

CTRL+U Ungroups the selected group.

CTRL+V Pastes the currently copied or cut sprites.

CTRL+W Closes the composition.

CTRL+X Cuts the selected sprites.

CTRL+Z Reverses the last action.

CTRL+HOME Returns the currently selected sprite to it's 
saved home position .

ALT+0 Displays the Pan pointer.

ALT+1 Displays the Arrange tool palette.

ALT+2 Displays the Paint tool palette.

ALT+3 Displays the Text tool palette.

ALT+4 Displays the Shapes tool palette.

ALT+5 Displays the Patterns and Fills tool palette.

ALT+6 Displays the Warps and Filters tool palette.

ALT+7 Displays the Art Effects tool palette.

ALT+8 Displays the Color Tuning tool palette.

ALT+9 Displays the Zoom pointer.

ALT+Enter Displays the properties of a sprite.

ALT+HOME Instructs Image Composer to remember the 
home position of the sprite.

ALT+F4 Exits Image Composer.



F1 Displays context-sensitive help topic for the 
area displayed.

F2 Toggles the palette view on or off.

F8 Centers the selected sprite within the view 
onto the workspace.

SHIFT+F1 Displays a context-sensitive help pop-up for 
the area displayed.

Number Pad + Zooms in one level.

Number Pad - Zooms out one level.

ESC Cancels the current operation.

DELETE Deletes the current selection.

Spacebar When pressed, hides selection outlines and 
handles.

HOME Returns the view focus to the composition 
guide.

TAB Selects sprites in the order that they appear 
in the stack.



Impressionist Plug-In Overview
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Impressionist allows you to apply and modify various artistic styles on a sprite. With Impressionist 
you can apply a cave painting effect, a crayon stroke effect, a spatter effect, or a detailed, soft pencil 
effect. The artistic styles available in Impressionist are similar to those found on the Art Effects tool 
palette, but provide you with more options and control over the results.

You can gain access to Impressionist from the Plug-Ins menu.

Impressionist provides you with the following:

· Seventeen artistic style groups including Chalk, Charcoal, Crayon, Paint, Pencil, Pointillist, and 
Watercolor. Each style group contains several effect variations to choose from.

· Control over the application of styles, by allowing you to manipulate items such as brush size, 
paper texture, color choice, and orientation.

· Extensive preview and demonstration capabilities, which allow you to preview multiple artistic 
styles as applied to the selected sprite and to view a demonstration of a group of styles.

· A detailed help system that describes the results of using each style and control available with 
Impressionist.



To Gain Access to Additional Plug-In Software within Image Composer
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Microsoft Image Composer provides two options for gaining access to plug-in software, such as Kai’s 
Power Tools and KPT Convolver. You can place the plug-in software in the PlugIns directory of Image
Composer, or you can indicate the location of the plug-in software so Image Composer can find it.

To point to plug-in software
1 Select Options from the Tools menu.
2 Select the Plug-Ins tab.
3 Click Browse and select the path containing the plug-in software.
4 Click OK.

The Plug-Ins menu should now contain menu items for the plug-ins you indicated.
– or –

Install the plug-in files in the \Microsoft Image Composer\PlugIns directory.



Using Tool Palettes
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The toolbox contains eight categories of Microsoft Image Composer’s tools, which are contained on 
tool palettes. You can click any item on the toolbox to open its respective tool palette. These tool 
palettes are Arrange, Paint, Shapes, Patterns and Fills, Warps and Filters, Art Effects, and Color
Tuning. Zoom and Pan tools are located at the bottom of the toolbox.



Using Context Menus
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Context menus appear when you click the right mouse button anywhere on the Composition Guide.

Many of the commands on the context menu are the same as those on the Arrange menu or the 
Arrange tool palette. Use the right mouse button to click a file or folder.



Choosing Tools from the Toolbox
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The toolbox contains ten buttons. Each of the first eight buttons displays a tool palette, which contains
tools with which you can modify a sprite or composition.

The last two buttons are Pan and Zoom. Pan allows you to drag the current sprite around on the 
Composition Guide. Zoom increases the magnification in the area of the composition where the 
pointer is located.



Using the Toolbar
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The Microsoft Image Composer toolbar contains standard Windows 95 tool buttons as well as six tool 
buttons and two lists specifically for use with Image Composer.

A ToolTip identifies each tool button when you move the pointer over it. Likewise, the status bar 
concurrently displays a definition for each button as you move the pointer over it.

To remove the toolbar, click Toolbars on the View menu. Then click to clear the Toolbar option, and 
click OK.



Quick Color Palette
Allows you to click a color to use for text sprites, patterns, and fills. This palette displays either the 
True Color palette or a Custom Palette depending on which tab is selected in the Color Picker 
dialog box. To display the Color Picker dialog box, click Color Picker from the Tools menu.



Palette name (New Color Palette and Edit Color Palette dialog boxes)
Specifies the name that identifies the palette. To change the name of the palette, use the Edit Color 
dialog box.



Palette size box (New Color Palette and Edit Color Palette dialog boxes)
Specifies the number of colors on the current palette. If you are creating a new palette, you can enter 
from 1 to 256 to accommodate the largest possible set of colors. If you are editing an existing palette, 
you can’t change this number.



Dither by box (New Color Palette and Edit Color Palette dialog boxes)
Specifies the type of dithering used to adjust colors if the display system is unable to directly 
reproduce the specified color. The choices are Error Diffusion, Solid, Pattern, and Random.



Number of colors edit box (Generate Colors dialog box)
Specifies the number of colors to add from another ramp or palette to the custom palette. The text to 
the right of the box displays a range of numbers you can enter based on the number of open entries 
left in the custom palette. Some palettes have a set number of colors you must select. If the custom 
palette does not have enough open entries, you cannot click the Add button. For example, to add the 
Windows system colors, the custom palette must have at least 20 open entries for the 20 system 
colors.



Number of colors range (Generate Colors dialog box)
Displays the range of numbers you can enter in the Number of colors edit box based on the number 
of empty entries in the custom palette. Some palettes have a set number of colors you must select. If 
the custom palette does not have enough open entries, you cannot click the Add button. For 
example, to add the Windows system colors, the custom palette must have at least 20 open entries 
for the 20 system colors.



Generate from box (Generate Colors dialog box)
Specifies the name of the ramp or palette to select colors from. The choices are the standard palettes 
and ramps provided with Image Composer and colors from the current composition or selected 
sprites.



Add button (Generate Colors dialog box)
Adds the number of colors specified from the selected palette to the custom palette to the current 
custom palette.



Close button (Generate Colors dialog box)
Stops the option to generate colors and returns to the Custom Palette tab.



Color ramp showing hue/blackness (Choose Color dialog box)
Displays the true colors you can select. There are two handles for changing the basic hue of the color 
or adjusting the amount of black that is mixed in the color. You can click a color within the ramp or use
the handle on the left side to control the amount of black mixed with the hue. To specify the hue, use 
the handle at the top of the ramp. The color you select appears in the New color box.



Color ramp showing hue/whiteness (Choose Color dialog box)
Displays the selected color. There is a handle for changing the amount of white that is mixed in the 
color. You can click a color within the ramp or use the handle on the right side to control the amount of
white mixed with the color specified in the hue and blackness ramp located to the left. If you move the
handle to the bottom, the color becomes pure white regardless of your selection in the hue and 
blackness ramp. The color you select appears in the New color box.



Original color used (Choose Color dialog box)
Displays the current color selected on the Custom Palette. If you select a new color, it appears to the
right of this current color.



New color to use (Choose Color dialog box)
Displays the current color or the new color, if you have selected one, that you can apply to the color 
entry you selected on the Custom Palette.



Revert button (Choose Color dialog box)
Sets the new color box back to the same as the original color used.



RGB option (Choose Color dialog box)
Displays the edit boxes for adjusting the amount of red, green, and blue in the new color you select.



HSV option (Choose Color dialog box)
Displays the edit boxes for adjusting the hue, saturation, or value in the new color you select.



Red edit box or Hue edit box (Choose Color dialog box)
If you selected the RGB option, this edit box specifies the number setting (0 to 255) for the amount of 
red in the New color box. If you selected the HSV option, this edit box specifies the number setting (0
to 359) for the hue in the New color box based on degrees on the color wheel.



Green edit box or Saturation edit box (Choose Color dialog box)
If you selected the RGB option, this edit box specifies the number setting (0 to 255) for the amount of 
green in the New color box. If you selected the HSV option, this edit box specifies the number setting
(0 to 100) for the saturation in the New color box based on degrees on the color wheel.



Blue edit box or Value edit box (Choose Color dialog box)
If you selected the RGB option, this edit box specifies the number setting (0 to 255) for the amount of 
blue in the New color box. If you selected the HSV option, this edit box specifies the number setting 
(0 to 100) for the value in the New color box based on degrees on the color wheel.



Pick a color from a region on the desktop button (Choose Color dialog box)
Specifies a single color, or an averaged color, from any area visible on the monitor’s screen as the 
new color to use. To specify a color, click this button, position the eyedropper over the color you want 
to select from the screen, and then click to pick up the color. To choose an averaged color from an 
area on the screen, click this button, then drag a rectangle around the area on the desktop that you 
want to average.



Show current region on the desktop being picked (Choose Color dialog box)
Displays the category axis (x-axis) and value axis (y-axis) coordinates for the eyedropper on the 
screen when Pick a color from a region on the desktop is active.



Apply button (Choose Color dialog box)
Closes the Choose Color dialog box and displays the selected color in the Custom Palette. This 
button is not available if you are trying to change an entry in one of the three standard palettes 
provided with Image Composer.



Cancel button (Choose Color dialog box)
Closes the Choose Color dialog box without changing the color in the Custom Palette.



Render
Creates a sprite in the shape you have drawn on the Composition Guide. The sprite is rendered in 
the color currently displayed in the Color Swatch.



Extract
Duplicates the area of an existing sprite included within the editing points of a shape (a rectangle, an 
oval, a spline, or a polygon).



Erase
Deletes the color of an existing sprite in the area included within the editing points of a shape (a 
rectangle, an oval, a spline, or a polygon).



Insert From Photo CD
Provides a set of photo thumbnails so you can select the photo you want to edit in the Composition 
Guide. Click on a photo thumbnail and click Import to begin importing the photo.



Insert From Photo CD
Imports the image you selected in the dimensions you specify onto the Composition Guide. Select 
the dimensions of the photo before importing onto the composition guide.



Color Format
Specifies the color palette for each file format. The default color palette for most file formats is 
TrueColor, a 24-bit color palette. For .gif and .bmp file formats, select TrueColor, Balanced Ramp, 
Gray Ramp, Black and White, or your own custom 8-bit color palettes.



*Color Format information
Displays the properties of the palette selected in the Color Format list. These properties include the 
number of colors in the palette and the type of dither used in the palette.



Write Alpha
Stores images with the Alpha, or transparent, channel included. The image is then an RGBA (Red, 
Green, Blue, Alpha) image.



Transparent Color or Alpha as color
· Transparent Color allows you to designate a palette color as the transparent color of the 

composition or selection to be saved in the .gif file format. If Transparent Color is selected, you 
can assign a color for the transparent color by clicking the Color Swatch. Adjust the Threshold 
slider to determine which pixels are changed to the designated transparent color.

· Alpha as color allows you to map the alpha channel transparency information of a composition or 
selection to a single transparent color. If Alpha as color is not selected, the composition or 
selection is blended with the background that is set to the Composition Guide color. If Alpha as 
color is selected, you can assign a color for the transparent color by clicking on the Color Swatch.
Adjust the Threshold slider to determine which pixels are changed to the designated transparent 
color. Some programs read this solid transparency color and turn it into true transparency.



Color Swatch
Allows you to choose a color for the alpha channel or transparent colors in a composition. Click the 
Color Swatch to display the Color Picker dialog box, or right-click the Color Swatch to display the 
shortcut color menu.



Compression
Allows you to reduce the size of the file by reducing the size of its contents. For some file formats, you
can adjust the amount of compression by adjusting the Amount slider.



Write Premultiplied Alpha
Designates that Alpha is premultiplied for you when Write Alpha is also selected. The image is then 
saved as a premultiplied RGBA (Red, Green, Blue, Alpha) image. Not all applications can read RGBA 
images.



Threshold slider
Indicates the transparency levels that will be changed to the color indicated by Transparent Color or 
Alpha as color. All pixels with a transparency value below the designated Threshold will appear fully
transparent when viewed in the designated file format. All pixels with a transparency level above the 
one indicated by Threshold will appear fully opaque when viewed in the designated file format.



Threshold edit box
Indicates the transparency levels that will be changed to the color indicated by Transparent Color or 
Alpha as color. All pixels with a transparency value below the designated Threshold will appear fully
transparent when viewed in the designated file format. All pixels with a transparency level above the 
one indicated by Threshold will appear fully opaque when viewed in the designated file format.



Amount slider
Allows you to specify the compression ratio applied to a composition when saved in the JPEG (*.jpg) 
file format. To achieve high image quality, set a low compression amount. High compression amounts 
reduce the file size but can cause some image quality deterioration.



Amount edit box
Allows you to specify the compression ratio applied to a composition when saved in the JPEG (*.jpg) 
file format. To achieve high image quality, set a low compression amount. High compression amounts 
reduce the file size but can cause some image quality deterioration.



Inserting Password-Protected Images From PhotoCD
Images can be protected by passwords to ensure copyright protection. Such images are encrypted 
and are available only to authorized users. To unlock protected images you must enter a password in 
the Password edit box and click Unlock. The password is provided with your PhotoCD.

If you do not have the password and want to view the image, click Ignore. The image displayed 
contains a watermark of copyright symbols overlaid on the protected image.



True Color tab (Color Picker dialog box)
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The True Color tab allows you to adjust or to select a new color to use in the Color Swatch. The 
color you select is applied whenever you create a new shape, add a text sprite, or apply a fill or 
pattern to a sprite in your composition.

On the True Color tab, you can adjust or select a color in a variety of ways depending on the color 
model you want to use. If you want to add black and white to your basic hue, you can use the Color 
Ramp. If you are familiar with selecting a color based on amounts of Red, Green, Blue (RGB) or Hue,
Saturation, and Value (HSV), you can use the sliders and edit boxes associated with those color 
spaces. For more information about True Color or color models, see the Color Overview.

The True Color tab provides the following elements for selecting and adjusting color.

Original color used/New color to use

Displays the current color for the Color Swatch and the new color, if one is selected.

Revert button
Sets the New color to use box back to the same as the original color used.

Color ramp

Displays the true colors you can select and has two ramps for changing the basic hue of the color or 
adjusting the amount of black or white that is mixed in the color. The hue and blackness ramp to the 
left has two handles. You can click a color within the ramp or use the handle on the left side to control 
the amount of black mixed with the hue. You can use the handle at the top of the ramp to specify the 
hue. The whiteness ramp to the right has one handle on the right of the ramp that controls the amount
of white mixed with the color specified in the hue and blackness ramp. The color you select appears 
in the New color to use box.

Note      If you move the handle on the whiteness ramp to the bottom, the color becomes pure white 
regardless of your selection in the hue and blackness ramp.

Color Space category

Specifies which color model is used for adjusting the color by displaying the sliders and edit boxes 



associated with either the RGB or HSV models for representing true colors.

Red/Green/Blue sliders and edit boxes

The sliders increase or decrease the amount of red, green, or blue in the New color to use box. The 
edit box specifies the number setting from 0 to 255 for the amount of red, green, or blue in the New 
color to use box. These sliders are available when the RGB Color Space option is selected.

Hue/Saturation/Value sliders and edit boxes

The sliders adjust the hue, saturation, or value in the New color to be used box based on degrees 
on the color wheel. The Hue edit box specifies the number setting from 0 to 359 for the hue in the 
New color to use box. The Saturation and Value edit boxes specify the number setting from 0 to 
100 for the saturation of the New color to use box.

Pick a color from a region on the desktop button

Specifies a single color or an averaged color from any area visible on the monitor’s screen as the new
color to use. To specify a color, click this button, position the eyedropper over the color you want to 
select from the screen, then, click to pick up the color. To choose an averaged color from an area on 
the screen, click this button, then drag a rectangle around the area on the desktop that you want to 
average.

Show current region on the desktop being picked
Displays the horizontal-axis (x-axis) and vertical-axis (y-axis) coordinates for the eyedropper on the 
screen when the Pick a color from a region on the desktop feature is active.

OK button
Closes the Color Picker dialog box and displays the selected color in the Color Swatch.

Cancel Button
Closes the Color Picker dialog box without changing the color in the Color Swatch.



Choose Color dialog box
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The Choose Color dialog box allows you to adjust or select a new color as an entry in a custom 
palette. You can adjust or select a color in a variety of ways depending on the color model you want to
use. If you want to add black and white to your basic hue, you can use the Color Ramp. If you are 
familiar with selecting a color based on amounts of Red, Green, Blue (RGB) or Hue, Saturation, and 
Value (HSV), you can use the edit boxes associated with those color spaces. For more information 
about true color or color models, see the overview, Working with Color.

The Choose Color dialog box provides the following elements for selecting and adjusting color.

Original color used/New color to use

Displays the current color selected on the Custom Palette and the new color, if one is chosen.

Revert button
Sets the New color to use box back to the original color used.

Color ramp

Displays the true colors you can select and has two ramps for changing the basic hue of the color or 
adjusting the amount of black or white that is mixed in the color. The hue and blackness ramp to the 
left has two handles. You can click a color within the ramp or use the handle on the left side to control 
the amount of black mixed with the hue. You can use the handle at the top of the ramp to specify the 
hue. The whiteness ramp to the right has one handle on the right of the ramp that controls the amount
of white mixed with the color specified in the hue and blackness ramp. The color you select appears 
in the New color to use box.

Note      If you move the handle on the whiteness ramp to the bottom, the color becomes pure white 
regardless of your selection in the hue and blackness ramp.

RGB or HSV color space categories

Specifies which color model is used for adjusting the color by displaying the sliders and edit boxes 
associated with either the RGB or HSV models for representing True Colors.

Red/Green/Blue edit boxes



The edit box specifies the number setting from 0 to 255 for the amount of red, green, or blue in the 
New color box. These edit boxes are available when the RGB Color Space option is selected.

Hue/Saturation/Value edit boxes

The edit boxes adjust the hue, saturation, or value in the New color box based on degrees on the 
color wheel. The Hue edit box specifies the number setting from 0 to 359 for the hue in the New color
to use. The Saturation and Value edit boxes specify the number setting from 0 to 100 for the 
saturation of the New color box.

Pick a color from a region on the desktop button

Specifies a single color or an averaged color from any area visible on the monitor’s screen as the new
color to use. To specify a color, click this button, position the eyedropper pointer over the color you 
want to select from the screen, then, click to pick up the color. To choose an averaged color from an 
area on the screen, click this button, then drag a rectangle around the area on the desktop that you 
want to average.

Show current region on the desktop being picked
Displays the horizontal-axis (x-axis) and vertical-axis (y-axis) coordinates for the eyedropper on the 
screen when the Pick a color from a region on the desktop feature is active.

Apply button
Closes the Choose Color dialog box and displays the selected color in entry of the Custom Palette. 
This button is not available if you are trying to change an entry in one of the three standard palettes 
provided with Image Composer.

Close button
Closes the Choose Color dialog box without changing the color in the Custom Palette.



Custom Palette tab (Color Picker dialog box)
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The Custom Palette tab allows you to select a new color to use in the Color Swatch from the colors 
available in a custom palette or to create and edit your own custom palette. You can choose from a 
three standard palettes provided with Microsoft Image Composer, or you can create your own custom 
palette.

The three standard palettes are the balance ramp, grayscale, and black and white ramps. You can’t 
edit these standard palettes.

If you create your own custom palette, you can use this tab to load, to create, and to change custom 
color palettes.

The color you select in the Custom Palette tab is applied whenever you create a new shape, add 
text, or apply a fill or pattern to a sprite in your composition.

Color Palette box

Displays the name of the palette currently shown in the tab and allows selection from a list of palettes 
that are loaded and available for you to use. This list includes the three standard color ramps provided
with Image Composer, plus any palettes that came with imported sprites in the composition. The three
standard color ramps are the balanced ramp, the gray ramp, and the black and white provided by 
Image Composer. The palettes in this list are the same as those that appear in the Color Format edit 
box of the Image Composer toolbar.

Load button

Displays the Import Custom Palette dialog box to locate and to select a custom palette file (.PAL) to 
use in Image Composer. After you load a palette, you can select one of its entries as the current color 
or select that palette from the Color Format edit box on the toolbar to preview your composition using
that palette.

Export button

Displays the Export Custom Palette dialog box to save the palette as a .PAL file for use in other 
applications.

Custom palette entries

Displays the colors currently available in the palette, allows selection of a new color to use, and 
allows changes to a color within the palette.

Sort palette by box



Specifies the order the colors appear in the palette so you can easily find or compare colors. For 
example, to display all of the reds, greens, or blues, you can select Red, Green, or Blue. To display 
the range of values, you can select Value. The choices are Unsorted, Hue, Saturation, Value, Red, 
Green, or Blue.

Create and Edit Custom Palettes category

Contains the buttons used to create a custom palette or to alter an existing palette. You can use these
buttons to alter custom palettes that you have created or the palettes for the sprites in a composition. 
The three standard palettes provided with Image Composer can’t be altered. If you want to vary one 
of these three palettes, first create a new palette, generate colors from the palette you want to alter, 
then change the entries on the new palette.

New button
Displays the New Color Palette dialog box for creating a custom palette. You can specify the number
of colors to place on the palette and the type of dithering the palette uses. After creating a palette, you
can’t change the number of color entries the palette offers. To change the number of color entries, you
must create a new palette.

Edit button
Displays the Edit Color Palette dialog box for altering the name and type of dithering used by the 
custom palette. For the balance ramp, grayscale, and black and white custom palettes, you can view 
the settings but you can not change them.

Remove button
Unloads the custom palette currently displayed in the Custom Palette tab, but does not delete any 
exported palette files (.PAL) from disk.

Generate Colors button
Displays the Generate Colors dialog box for adding colors to the current custom palette. You can add
colors only if the palette has entries without colors in them.

Note      To add colors to a palette that is already full of colors, select a color you want to change and 
use the Quick Color Picker command from the shortcut menu to add a new color or double-click the 
entry and use the Choose Color dialog box.

OK Button
Closes the Color Picker dialog box and displays the selected color in the Color Swatch.

Cancel Button
Closes the Color Picker dialog box without changing the color in the Color Swatch.

Note      Changes to custom palettes are saved immediately and are not canceled if you click this 
button.



Microsoft Office97 Compatible
Microsoft Image Composer is a Microsoft Office97 Compatible product, which means that many of its 
basic features (including toolbars, menus, and accelerator keys) are similar to those used by 
Microsoft Office. If you are already using Office97 or an Office97 Compatible product, then you will 
see that many tasks can be completed in a similar manner in Image Composer. These similarities will 
make it easier for you to use Office97 Compatible products together.

Look for the Microsoft Office97 Compatible    logo when purchasing software. For more information 
about the Microsoft Office97 Compatible    program, and for a complete listing of Microsoft Office97 
Compatible    products, please see our web site at http://www.microsoft.com/msoffice/ofccomp or call 
Microsoft Customer Service at 1-800-426-9400. Customers outside the United States should contact 
their local Microsoft office.

Office97 Compatible Features Supported by Image Composer
Image Composer includes the following Office97 Compatible features:

· Windows NT and Windows 95 logo design features set.
· Main Menu bar and accelerator keys.
· Drop-down menus with accelerator keys.
· Popup menus.
· Basic dialog boxes, including Open, Save As, and Print.
· Standard Toolbar and Toolbars configuration dialog box. The Toolbar Configuration dialog box 

contains a Show ToolTips checkbox . Selecting this box turns on the ToolTips for the main menu 
but does not turn them off globally in Image Composer.

· Office Compatible Help Topic.

Using Image Composer with Office
You can integrate Image Composer    with Office applications in many ways. The following list 
describes some of the ways you can use Image Composer with Office97 Compatible products:

· Cut, copy, and paste from Image Composer into Office applications; for example, Microsoft Word 
documents, Microsoft PowerPoint presentations, and Microsoft Excel spreadsheets. 

· Cut, copy, and paste into Image Composer from Office applications; for example, Word documents,
PowerPoint presentations, and Excel spreadsheets.



Composition Guide Defaults Tab (Options dialog box)
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The Composition Guide tab allows you to specify the default size and color of the Composition 
Guide, which is the background for the sprites in your composition. Although you can place sprites 
outside of the Composition Guide in Microsoft Image Composer, only the sprites inside the guide 
are printed, flattened, or saved to a format other than Image Composer’s. Sprites or portions of 
sprites outside the guide are clipped when the composition is saved to another format.

If you print the composition or save it to another file format, the area of the Composition Guide prints
or saves along with the sprites inside the guide. If you set the Composition Guide to a color other 
than white, you may see a color or dithered background in the results. If you open the file in another 
application, you see the size of the Composition Guide included with the sprites. You can reduce the
amount of extra space saved with the composition by resizing the guide to fit closely around the 
sprites.

Size group
Specifies the default area of the Composition Guide for each new composition.

Width in Pixels
Specifies the number of pixels the Composition Guide extends from side to side.

Height in Pixels
Specifies the number of pixels the Composition Guide extends from top to bottom.

Color
Displays the current color of the Composition Guide and, when clicked, displays the Color Picker 
dialog box for selecting a new color.



Tool Palettes Tab (Options dialog box)
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The Tool Palettes tab allows you to control the display of tool palettes.

Show New Tool Palette on Change
Specifies that a tool palette appears whenever you select a new palette from the Toolbox. If you clear
this option, you can use the Toggle Palette View command on the View menu to display the palettes.

AutoHide Tool Palette
Specifies that a tool palette disappears when the cursor moves off the palette but reappears when 
you move the cursor over the status bar at the bottom of the window.

Note      If you clear Show New Tool Palette on Tool Change and select AutoHide Tool Palette, you
can choose a new tool palette from the toolbox, but it will not appear until you move the cursor to the 
status bar at the bottom of the window.



View Tab (Options dialog box)
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The View tab allows you to control the scroll bars, selection handles, and hint dialog boxes that 
appear in your workspace.

Show Scroll bars
Hides or displays the controls that allow you to move off-screen portions of the composition into view.

Show Selection Handles
Hides or displays the small boxes that appear on the bounding box of the sprites that are selected. If 
this check box is clear, you can use the SPACE BAR to temporarily show the selection handles.

Show Hint Dialog Boxes
Hides or displays all special dialog boxes that provide additional information about a tool. You also 
can choose to hide specific hint dialog boxes by selecting the Do Not Show Again option when the 
hint dialog box appears.

Reset Hints
Sets all special dialog boxes that provide additional information about a tool to display. If you apply 
certain effects, a hint dialog box appears to assist you. If you select the Do Not Show Again option in
hint dialog boxes, you can click this button so that they do show.

Pixel Spacing Ratio
Sets the width-to-height ratio of your pixel display. The default setting is 1.0, which is a square pixel 
spacing and is appropriate for most users. You can set this option to match your composition to non-
standard display systems.

Note      Be careful when changing this setting because an incorrect pixel spacing ratio (PSR) can 
produce unexpected results from some commands and effects used in Microsoft Image Composer. 
For example, the following commands may not perform as you expect: Transpose Right, Transpose
Left, Rotate Right 90, and Rotate Left 90. Many of the transform commands, and particularly 
Rotate, can cause a circle to become an ellipse or a square to become a rectangle.



Matching the Pixel Spacing Ratio for Non-standard Display Systems
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In the View tab of the Options dialog box, you can set the Pixel Spacing Ratio for a composition 
that you want to display on a non-standard display system, such as some broadcasting video displays
and frame buffers.

If you are not using a Windows display or other square-pixel display, you can determine the Pixel 
Spacing Ratio (PSR) using the following formula:
PSR = DAR * number of scan lines/number of pixels per scan line
DAR is the Display Aspect Ratio, which is the width of your display divided by the height of your 
display. For example, a typical broadcast DAR is 4/3, or 1.333. Measure your screen to be sure. The 
video screen resolution for a typical PC frame buffer is 400 scan lines by 512 pixels, which equals 
0.78125 DAR. Multiply 1.333 by 0.78125, and you’ll find that your PSR is 1.04.



Plug-Ins Tab (Options dialog box)
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The Plug-Ins tab allows you to specify a path and directory for plug-in applications in addition to the 
default path. To use a plug-in with Microsoft Image Composer, the plug-in must be located in one of 
these two paths.

To display the Options dialog box, click Options on the Tools menu.

Image Composer Plug-In
Displays the default path specified for plug-ins. This path is read-only.

Additional Plug-In Directory
Specifies another path to the location of plug-ins. You can type in a new directory or use the Browse 
button. Any plug-ins in this directory appear on the Plug-In menu. You can use this to specify the 
directory where you have existing plug-ins.

Browse button
Displays the Choose Plug-In Directory dialog box for selecting a new path for plug-ins.



Choose Plug-In Directory dialog box
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Specifies the additional directory Microsoft Image Composer searches for plug-in applications. This 
dialog box is available from the Plug-Ins tab of the Options dialog box.

Directories
Displays the path specified for plug-ins and allows you to select a new path from a list of directories 
available on the drive, shown in the Drives drop-down box.

Drives
Displays the letter, computer name, and share currently selected, and allows you to select other 
computers and shares currently connected to your computer.

Network button
Displays the Map Network Drive dialog box for connecting to other computers and shared directories
on the network.



Gamma Tab (Options dialog box)
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The Gamma tab allows you to specify the settings that affect the brightness of the midtones of an 
image for all sources of image input and output including file reading and saving, cutting and pasting, 
scanning, viewing and printing. Typically, you do not need to change the default gamma settings 
unless you know the specific gamma settings for your particular monitor, printer, or data source.

Gamma describes the nonlinear brightness response of a monitor or other imaging device. All 
computer and video display monitors have a nonlinear brightness response, which means that if the 
voltage on their electronics is doubled, their brightness does not double as you might expect. The 
degree of nonlinearity varies from monitor to monitor.

Microsoft Image Composer performs gamma processing on image input and output operations so that
images viewed on differing output devices (computer monitors, video monitors, printers, etc.) look 
identical and so that all image processing operations are performed on linear (not gamma-corrected) 
data for accurate results.

Gamma Setting/Value
Displays the list of gamma settings for all input/output devices and file formats. If a selection is clear, 
the gamma setting for the item is not used. If for some reason you wish to have no gamma 
processing performed, clear all the check boxes in the list.

Gamma
Specifies the gamma setting for the selected item in the list.

Override File option
If an image file contains a gamma setting, this value will be used. However, selecting this box 
specifies that the Image Composer setting should override the setting contained in the file. Of the 
currently supported file formats, only TGA files contain a gamma setting.

Defaults button
Sets all of the gamma settings to their default value.



Edit Tab (Options dialog box)
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The Edit tab allows you to specify the minimum and maximum distance a selected sprite moves when
you use the ARROW keys to manipulate sprites in your composition.

Small Offset (ARROW key)
Specifies the distance that pressing an ARROW key moves a selected sprite.

X      specifies how far the selected sprite moves on the horizontal axis (x-axis) when the LEFT or RIGHT 
ARROW keys are pressed.

Y      specifies how far the selected sprite moves on the vertical axis (y-axis when the UP or DOWN keys 
are pressed.

Large Offset (CTRL + ARROW key)
Specifies the distance that pressing a CTRL + ARROW key moves a selected sprite.

X      specifies how far the selected sprite moves on the horizontal axis (x-axis) when CTRL + the LEFT 
or RIGHT ARROW keys are pressed.

Y      specifies how far the selected sprite moves on the vertical axis (y-axis) when CTRL + the UP or 
DOWN keys are pressed.

Undo Enabled
Specifies that you can select Undo to cancel changes you make to your composition. If you are not 
concerned with undoing changes, you can clear this option to free the memory used to buffer 
changes.



Glossary

A
alpha channel

amplitude

B
biquadratic patch

bounding box

brightness

C
channels

closed polygon

closed spline

color circle

color palette

Color Picker

color space

color swatch

compensation curve

composition guide

composition

cosine function

current color

custom color palette

D
destination sprite

display system

dithering

dynamic range

E
effects

eyedropper

F
flatten



frequency

G
group

H
HSB color model

HSV color model

hue

HWB color model
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alpha channel
One of the four channels that defines the total color of the sprite. The alpha channel carries 
information about the degree of opacity for each pixel.



amplitude
The height or depth of a wave pattern.



biquadratic patch
A mesh of curves laid over a sprite that describes how each point in the sprite should be warped. In 
Microsoft Image Composer, the interactive warps show these patches as a crisscross of lines and 
points that can be moved to control the warp.



bounding box
Area that defines the perimeter of a sprite typically displayed by lines and handles.



brightness
A color attribute that defines the quality of radiance or luminosity of a color and is determined by the 
radiant energy of a color. This attribute is used in the HSB color model. See also hue and saturation.



channels
Medium for transferring color information to the pixels of a display monitor. Microsoft Image 
Composer uses four channels for color information. Three channels carry red, green, and blue. One 
channel known as the alpha channel carries information about the degree of opacity for each pixel.



closed polygon
A shape defined by a series of lines that includes a curve connecting its first and last editing points. 
You can create an closed polygon by selecting the Close box on the Shapes tool palette.



closed spline
A shape defined by a series of curves that connect all of the editing points that define a shape. You 
can create a closed spline by selecting the Close box on the Shapes tool palette.



color circle
A disk with the rainbow of pure colors spread around its edge, much like those found in paint stores.



color palette
Set of specific colors that can be saved with a composition or as a separate PAL file.



color picker
Dialog box that allows you to select a new current color that is applied to new sprites, patterns, and 
fills. You can also define a custom color palette using this dialog box.



color space (model)
Method for representing color.



color swatch
Square of color in the toolbox that displays the current color. You can click the Color Swatch to 
display the Color Picker dialog box.



compensation curve
Displays the relative brightness or darkness of the dark, middle, and light regions of a sprite.



composition
Microsoft Image Composer document made up of one or more sprites displayed in the Image 
Composer workspace.



composition guide
Area in the Microsoft Image Composer workspace that defines the area of a composition. This area 
and the sprites within it are included with a composition when the file is printed, exported, or saved to 
other file formats.



cosine function
Based on the mathematical cosine function, this feature distorts a sprite by compressing and 
expanding the areas of a sprite according to the axis and symmetry settings. For example, if you set 
the Y axis only, the bottom of the sprite appears expanded with increased compression toward the 
top. If you set the X axis only, the right side of the sprite appears expanded with increased 
compression toward the left. For examples, see the topic, Rectangular Warp Variations.



custom color palette
A set of colors on a palette with 1 to 256 specific color entries.



current color
The color displayed on the Color Swatch below the Toolbox. The current color is used when you 
create a new sprite and when you add fills and patterns to the current sprite. . You can change the 
color by clicking Color Picker from the Tools menu or by clicking the Color Swatch.



destination sprite
The sprite that is modified based on the parameters determined from the source sprite.



display system
The combination of monitor, video adapter, and display software that shows the final composition.



dithering
Method of controlling how colors specified by a composition are approximated on a display system or 
in a file format that does not have the specified color available. Custom palettes allow you to choose 
from four types of dithering: none, error diffusion, random, and pattern.



dynamic range
The difference in intensity between the brightest and darkest pixels in a sprite.



effects
The features and tools offered by Microsoft Image Composer for changing the look of sprites in your 
composition.



eyedropper
A button on the True Color tab of the Color Picker dialog box and the Choose Color dialog box that 
allows you to select a color shown on your desktop as the current color. Using the Eyedropper, you 
can specify a single color or drag to specify an averaged color from a range of colors.



flatten
Microsoft Image Composer feature that combines selected sprites to produce a single sprite.



frequency
The number of times a wave pattern repeats in a given interval.



group
Feature that designates all currently selected sprites as a single sprite within a composition. In 
addition to arranging a group of sprites as a single sprite, you can also arrange the stack order of the 
grouped sprites. You can also align a group with another sprite, and you can lock it to prevent it from 
being moved.



hue
The color attribute that most readily distinguishes one color from other colors and is determined by 
the frequency of the wave of light in the visible spectrum. This attribute is used in the HSB color 
model. See also saturation and brightness.



HSB color model
Method for describing colors that uses the attributes of hue, brightness, and saturation to specify a 
color.



HSV color model
Method for describing colors that uses the attributes of hue, saturation, and value to specify a color.



HWB color model
Method for describing colors that uses the attributes of hue, whiteness, and blackness to specify a 
color.



intensity
The strength of a color, especially the degree to which it lacks its complementary color on the color 
wheel. If intensity alone is chosen as a color, it is shown as shades of gray, with no hue.



linear knee function
Effect that changes portions of a sprite by compressing and expanding areas based on percentage, 
axis, and symmetry settings. For example, if you set the linear knee percent at 70% and the axis to Y 
only, the top 70% of the sprite is expanded and the bottom 30% is compressed. If you set the linear 
knee percent at 70% and the axis to X only, 70% of the area on the left of the sprite is expanded and 
30% on the right is compressed. If you change the axis to include both X and Y, then the top left is 
expanded 70% and the bottom right is compressed. For examples, see the topic, Rectangular Warp 
Variations.



lossy
Lossy means that once a sprite is compressed and decompressed, it is no longer identical to the 
original image. In most cases, however, the difference is indistinguishable.



monochrome
A photograph or drawing containing a single hue or color, typically grayscale.



opacity
The quality and degree to which light cannot pass through pixels. A low opacity value makes pixels 
more transparent; a high value makes the pixels less transparent . 

In Image Composer, opacity is specified as a percentage. For instance, a sprite with an opacity value 
of 100 percent is composed of totally opaque pixels, so that another sprite could not be seen through 
the completely opaque sprite.

You can specify opacity by using an opacity slider. Many Image Composer tool palettes and dialog 
boxes provide an opacity slider, as shown here. Some features allow you to change the opacity 
values for specific pixels within the sprite.



opaque
The quality of a sprite’s pixels that defines the ability of light to pass through. Completely opaque 
sprites do not allow any light to pass through. See also opacity and transparent.



open-ended polygon
A multi-sided shape that does not have a line connecting its first and last editing points. You can 
create an open-ended polygon by clearing the Close box on the Shapes tool palette.



open-ended spline
A shape defined by a series of curves between editing points that does not have a curve connecting 
its first and last editing points. You can create an open-ended spline by clearing the Close box on the 
Shapes tool palette.



pixel
Single unit of measure on your screen that relates to the rectilinear grid used by display hardware to 
paint images on your screen. These units, which often appear as tiny dots on your screen, compose 
the pictures displayed by your screen. The color capability of each pixel is determined by the video 
card installed in the display system.



plug-ins
Separate applications you can use to edit sprites in your composition. If located in one of the two 
Plug-in directories, these applications are available from the Plug-Ins menu.



ramp
A gradient blend of colors, usually between two end colors. 



RGB channels
The color lines that carry information to determine the color of a pixel. Red, green, and blue are the 
three basic colors that are mixed to create a variety of colors.



RGB color space
A color mixing model or method of describing the colors available on a display system. RGB (red, 
green, blue) uses the additive primaries method, mixing percentages of red, green, and blue to get 
the desired color. In this model, mixing no amount of RGB produces black and mixing the full amount 
of RGB produces white.



saturation
The amount of color, or fullness, in a specified hue.



selection set
A selection set is a temporary collection of currently selected sprites, used to apply a function to all 
selected sprites at one time, instead of applying a function to each sprite individually. As soon as you 
click another sprite, the selection set disappears. Grouped sprites, however, are more permanent, 
and you can nest groups within groups.



sine function
Based on the mathematical sine function, this feature distorts a sprite by compressing and expanding 
the areas of a sprite according to the axis and symmetry settings. For example, if you set the Y axis 
only, the top of the sprite appears expanded with increased compression toward the bottom. If you set
the X axis only, the left side of the sprite appears expanded with increased compression toward the 
right. For pictures, see the topic, Rectangular Warp Variations.



source sprite
The sprite that is used as the basis for modifying another sprite.



spoke
A line from the center of a disk to its circumference. 



sprite
A single image object, composed of pixels, whose area is defined by its bounding box. The sprite’s 
shape is determined by its non-transparent pixels. To add a sprite to your composition, you can insert 
a file, create a shape, or add text.



stack
The ordering of sprites, front to back, in a composition. Also known as z-order.



template brush
A template brush has the shape of a sprite that you select. When you use a template brush in a 
composition, the shape of that sprite is the paintbrush shape.



toolbar
Narrow panel of buttons that typically appears below the menu bar and contains the buttons for doing 
standard composition tasks, such as saving a composition, cutting and pasting sprites, or previewing 
your composition with another color palette.



toolbox
Narrow panel of buttons that typically appears on the left side of the Microsoft Image Composer 
window and contains the buttons for choosing and displaying the tool palettes.



tool palette
Window that displays a set of options and controls (or items) that you can choose to add or change 
sprites in your composition. For example, the Shapes tool palette provides you with the tools for 
adding new shapes or extracting shapes from your composition.



transform matrix
The array of numbers used to warp points when you apply linear effects, including translation, 
rotation, shear, and perspective. These effects use a single 4x4 transform matrix per sprite.



transparent
Transparent sprites are comprised of pixels with no color, e.g. completely clear pixels. See also, 
opacity and opaque.



true color
The True Color palette mixes the red, green, and blue available from your 24-bit color video card to 
produce the wide range of colors. There are 16 million colors available on the True Color palette. 
Microsoft Image Composer always stores your composition in True Color when you save it as an MIC 
file. However, you can save or view your composition using a reduced color palette.



two-point perspective
The technique of representing the spatial relation of objects as they might appear to the eye. You can 
apply two-point perspective in Microsoft Image Composer using the Perspective warp.



workspace
The entire area available to use when creating a composition that includes the composition guide, the
area around it, and any windows you have open showing parts of the composition.



z-order
The numerical position of a sprite in the stack of sprites, ordered front to back, that make up a 
composition.



Mask and Shadow Overview
{button ,AL("artistic 
effect how")} How?

Original sprite Mask made from original sprite

Mask and background after
applying effects

Composition with all sprites in
place

You can use the spline tool to create both masks and shadows that alter all the elements of an image 
object: color, texture, light, and shape. To create masks or shadows, you first create a new sprite 
containing a specific area of a source sprite. This new sprite, the mask, is an area you want to protect 
from changes, to apply specific changes to, or to use as the basis of a shadow. Then, after you make 
changes to the source sprite, the mask, or both, you can move the mask into its original position, or 
you can offset it from the source sprite to create a shadow.

Masks are typically used to protect sections of a sprite while you apply changes to the non-masked 
areas. For example, in the preceding figures, you see a composition of a skyline against a neutral-
colored sky in the first frame. The goal is to show the scene at dusk. To accomplish this task, you 
create a mask of only the skyline and move it away from the composition. Next you can apply a 
gradient ramp, such as the Night Sky ramp, to the composition. Finally, you can apply a colorize filter 
to give the skyline an evening feel and move the skyline back into its original location.

Shadows enhance sprites by adding the illusion of a light source hitting a particular section of the 
sprite and creating a distinct shape and texture. For example, the following figures show a metronome
with a shadow. The shadow was created by using the spline tool to make a new sprite with the shape 
of a metronome. The shadow was then placed behind the metronome.



Original sprite New sprite for
shadow shape

Shadow in place Finished composition

You can also add full shadows to simplistic sprites.

· Masks allow you to protect sections of a sprite while you apply changes to the rest of the sprite.
· Shadows allow you to add the illusion of depth and realism to a sprite.



To create a mask
{button ,AL("artistic 
effect how")} 
Related Topics
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artistic effect 
ovr")} 
Overview

1 In the toolbox, click Shapes.
2 Click Spline.
3 Adjust the Opacity slider to the desired setting.
4 Select the Close and Fill boxes.
5 Within the bounding box of the sprite, outline the appropriate area of the sprite you want to mask.
6 Click Edit Points to adjust the spline.
7 Click Extract.

You have created an exact copy of the area of the sprite included in the spline.



To create a shadow for a portion of a sprite
{button ,AL("artistic 
effect how")} 
Related Topics

{button ,AL("
artistic effect 
ovr")} 
Overview

1 Select a sprite and then, in the toolbox, click Color Swatch.
2 Select a color for the shadow and click OK. For example, to create a black shadow, set Red to 0, 

Green to 0, and Blue to 0.
3 Create a new sprite for the shadow by creating a spline. For details, see To create a mask.
4 Drag the new sprite away from the original sprite.
5 In the toolbox, click Warps and Filters.
6 In the drop-down list, click Color Enhancement, then click Color Atop. You can also use Tint or 

Colorize to create shadows. Tint adds color more transparently than does Color Atop. Colorize 
adds color more transparently than does Tint, allowing more of the original sprite to show through. 
Adjust opacity as needed and click Apply.

7 Place the shadow you have created behind the original sprite, or wherever you want the shadow to
be.
Note      You might need to rearrange the position of the sprites in the stack for the shadow to 
appear behind the original sprite. To change the order of the sprites, use the Send to Back or 
Bring to Front options on the Arrange menu.



To create a new sprite from a single channel
{button ,AL("existing
sprite how")} 
Related Topics

1 Select a sprite.
2 In the Edit menu, click Copy Channel.
3 From the Copy Channel submenu, click the Red, Green, Blue, or Alpha channel.
4 In the Edit menu, click Paste.

A new sprite appears which contains a single color channel.



What is Microsoft Image Composer?
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Microsoft Image Composer is an application for creating compositions for on-screen display on Web 
sites or other destinations. You can use existing art in a wide variety of formats or create new art by 
using a combination of powerful tools, virtually unlimited workspace, and sample images. The 
following figure shows a composition created with Image Composer.

Image Composer is based on the model of an image object known as a sprite. You can move sprites 
by using a mouse, much as you move objects on your desktop. When you bring an existing image 
into Image Composer, it is automatically converted into a sprite.

Image Composer was designed for experimentation. You can apply effects easily, view the results, 
then modify or undo those effects to achieve the result you seek.

When you work with Image Composer, you enjoy the following advantages:

· Work with industry-standard file formats.
You can use Image Composer to work with a wide variety of popular file formats, including TIFF 
(.tif), CompuServe GIF (.gif), Targa (.tga), JPEG (.jpg), Windows bitmap (.bmp), and Adobe 
Photoshop 3.0 (.psd). For working with scanned images, Image Composer supports the TWAIN 
interface.



· Use the simplified interface.
In addition to standard menus and toolbars, Image Composer functions are divided into groups and
placed on eight tool palettes that disappear from view when not needed. Each tool palette contains 
a related group of tools or effects. For example, all paint tools are grouped on the Paint tool 
palette.

· Use popular plug-in sets.
Image Composer includes the Impressionist plug-in, which provides dozens of additional effects 
and filters beyond those available in Image Composer. Image Composer supports the use of many 
popular plug-ins, including Kai’s Power Tools, Adobe Photoshop-compatible plug-in filters, and 
others.

· Choose from hundreds of sample images.
Image Composer includes hundreds of sample images, available as part of the online Help system.
You can browse the images while working on a composition and include them as part of the 
composition you are working on. These images include scenes of nature, cityscapes, animals, 
plants, household items, textures, buttons, frames, and more.



Using Image Composer Documentation

Microsoft Image Composer documentation consists of online Help and a README file containing 
information gathered too late to be included in Help.

The online help system consists of the following parts:

· Context-sensitive Help. This is brief help on a particular tool or for a particular dialog box. 
Context-sensitive Help is available in the following ways:
· Clicking the question mark button on the tool bar, moving the question mark pointer to a tool or 

control (not a label or an icon), and clicking.
· Clicking Help in a dialog box.
· Pressing F1 or SHIFT + F1 to get context at the most specific level available.

· Procedure Help. This is help that consists of a series of steps that you follow to perform a specific 
task. Procedure help is available from the Help menu by clicking Image Composer Help Topics 
and then clicking the procedure you want.

· ToolTips. This help consists of brief names for tools and controls that do not have labels. To use 
this help, move the pointer over the control you want help for and pause.

· Reference Help. This help consists of topics based on sample images you can create with each 
category of tools, and a table that maps keyboard combinations to actions you perform with a 
mouse.

· Hint Messages. This help appears automatically when you are required to follow a specific 
sequence or act on a specific object. You can disable hint messages at any time from within the 
hint message dialog box.



Overview of Creating Artwork for Web Sites

You can use Image Composer to edit existing images from your own or other Web sites, or create 
new artwork.

While in Image Composer, you can work in True Color to provide millions of colors for your art. At the 
same time you are creating or modifying an image, you also can view that image in reduced color to 
preview its appearance on a Web site.

You can work with existing images from a variety of sources. For example, you can take pictures with 
a digital camera and save those pictures to a standard file format that you can work with in Image 
Composer. Other sources of images include files stored in industry-standard formats, photo compact 
discs, sample images included with Image Composer, and images scanned into Image Composer.

Image Composer makes creating buttons and other elements of Web sites easy and quick. Sample 
files contain buttons, borders, and backgrounds that you can use unchanged or turn into dazzling 
original works.

When your artwork is complete, you can save it in a format that is optimized for quick downloading 
and display, such as transparent .gif files.



Using Image Composer with Microsoft Office

Microsoft Image Composer offers compatibility with Microsoft Office products. You can cut, copy, and 
paste to and from Image Composer to and from Microsoft Word, Microsoft Excel, Microsoft 
PowerPoint, and other applications. Menus, toolbars, accelerator keys, shortcut menus, and other 
controls in Image Composer follow the Office standard. For more information, see the Office 
Compatible Help topic.



Working with Light Overview
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Light is one of the basic elements of a visual composition, along with color, texture, and shape. By 
adjusting the amount of light in specific areas of a sprite, you can add depth and character. Increasing
the light on a portion of a sprite can make that portion appear closer to the viewer. Darkening an area 
can make an area seem farther away.

With Microsoft Image Composer, you can manipulate the amount of light, and the quality of the light, 
for entire sprites or for selected areas of a sprite.

To manipulate light for entire sprites, you can use Color Shifting, Highlight/Shadows, and Dynamic
Range on the Color Tuning tool palette. To manipulate light for selected areas of a sprite, you can 
use Dodge-Burn and Contrast on the Paint tool palette.



Using the Dodge-Burn Tool
{button ,AL("working
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Related Topics
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Dodge-Burn creates effects similar to those used by photographers when printing or enlarging 
pictures.

A dodge effect is the result of placing an object between the light source and the photographic paper 
so that a specific portion of the picture gets less light than the rest of the picture. Typically, a 
photographer uses a small object and moves it around as light from the enlarger falls on the paper. 
You can use Dodge to recreate that effect by using a paintbrush as the dodge object and dragging it 
over a portion of a sprite to darken that portion.

A burn effect is just the opposite of a dodge effect, so that a portion of the photograph gets more light 
than the rest of the sprite. You can use Burn to recreate that effect by using a paintbrush as a Burn 
object and dragging it over a portion of a sprite to light that portion.



To lighten a portion of a sprite
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Overview

1 Click the sprite you want to modify.
2 In the toolbox, click Paint.
3 On the Paint tool palette, click Dodge-Burn.
4 In the Paint Brush Selection grid, click a brush.
5 On the Dodge-Burn slider, move the slider to the right. Higher numbers add more light.
6 Drag the brush over the area of the sprite you want to lighten.



To darken a portion of a sprite
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Overview

1 Click the sprite you want to modify.
2 In the toolbox, click Paint.
3 On the Paint tool palette, click Dodge-Burn.
4 In the Paint Brush Selection grid, click a brush.
5 On the Dodge-Burn slider, move the slider to the left to apply negative values. Lower negative 

numbers make the area darker.
6 Drag the brush over the area of the sprite you want to darken.



To adjust the contrast of a portion of a sprite
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Overview

1 Click the sprite you want to modify.
2 In the toolbox, click Paint.
3 On the Paint tool palette, click Contrast.
4 In the Paint Brush Selection grid, click a brush.
5 On the Contrast, move the slider to the left to lessen the contrast or to the right to increase the 

contrast.
6 Drag the brush over the area of the sprite you want to adjust.



To adjust the brightness of a sprite
{button ,AL("light 
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Overview

1 Click the sprite you want to modify.
2 In the toolbox, click Color Tuning.
3 On the Color Shifting page of the Color Tuning tool palette, move the Brightness slider to the 

right to make the sprite brighter or to the left to make the sprite darker.
4 Click Apply.

Tip      You can experiment with levels of brightness by applying a value, choosing a new level of 
brightness and applying that value. Each new value is applied to the original sprite, not to the version 
of the sprite to which the previous level was applied. You can experiment in this manner until you 
select a different sprite.



To adjust the contrast of a sprite
{button ,AL("light 
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Overview

1 Click the sprite you want to modify.
2 In the toolbox, click Color Tuning.
3 On the Color Shifting page of the Color Tuning tool palette, move the Contrast slider to the right 

to increase contrast or to the left to decrease contrast.
4 Click Apply.

Tip      You can experiment with levels of contrast by applying a value, choosing a new level of contrast
and applying that value. Each new value is applied to the original sprite, not to the version of the 
sprite to which the previous level was applied. You can experiment in this manner until you select a 
different sprite.



Creating Compositions
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The basic building block of a Microsoft Image Composer composition is the image object known as a 
sprite. A composition can have one sprite, one hundred sprites, or more. Because a sprite is an 
object, you can move it anywhere in a composition just as easily as you move an icon on your 
desktop.

In many image editing programs, images must be manipulated through layers, which can be 
confusing and tedious work. In Image Composer, sprites can be moved independently and directly 
with a simple click. Rather than working with a single fixed image in a composition, you work with 
many objects (sprites) that you move, process, and manipulate. For more information on sprites, see 
What is a Sprite?.



What is a Sprite?
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A sprite is an image object with shape and transparency. A composition includes every sprite that you 
have created or modified, regardless of whether you can see it in the workspace view window.

Each time you insert an existing image into a composition, regardless of its source, that image 
automatically becomes a sprite. When you create a new image with Microsoft Image Composer, that 
new image is created as a sprite. You can move sprites anywhere in a composition and arrange them 
as you choose.

When you click a sprite, you see that it is surrounded by a bounding box. The bounding box provides 
reference points for various effects and tools. The following figure shows a sprite and its bounding 
box. In this figure, the eight ball itself is set for 100% opacity (completely opaque); the clear area 
outside the ball extending to the bounding box is set for 0% opacity (completely transparent).

The bounding box has handles in each corner and on each line. You use these handles for resizing a 
sprite, rotating it, and more.

As you use a tool or apply an effect, its action is applied to the sprite(s) you currently have selected. 
The bounding box handles indicate which group of tools is currently selected. The following figure 
shows examples of different bounding boxes, as they relate to a specific tool or effect.

Crop/Extend bounding box, Paint bounding box, and Color Tuning bounding box

Sprites can be completely independent, combined in temporary selection sets, or combined in 
permanent groups. You can apply various tools, effects, and filters to either single sprites or 
temporary selection sets of sprites.

The position of a sprite in a composition is determined by where you place it on the workspace and 
when you added that sprite to the composition. Each new sprite is positioned on a stack of sprites. As 



each new sprite becomes part of a composition, it is placed on top of the stack. For more information, 
see Understanding the Stack.



Sprites and Opacity
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The shape of a sprite is determined by the opacity of the image being represented and by the 
transparent space around it. However, the transparency of a sprite is not limited to the space 
surrounding it.

A sprite is defined by four channels that contain settings for red, green, blue, and alpha. The alpha 
channel defines the degree of opacity of a sprite from zero (completely transparent) to 100 
(completely opaque).

You can use the alpha channel as if it were another color. Many effects and filters contain a setting for
opacity, which sets the transparency of the effect anywhere from completely transparent to completely
opaque. For example, you can set the opacity of the erase tool to partially erase a portion or a sprite 
and allow the sprite behind it to show through. The following is a composition that makes use of 
transparency.



Understanding the Stack
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Overview

A composition has three dimensions: height, width, and depth. The depth is represented by the stack, 
also referred to as the z-order. When a new sprite is added to a composition, whether by inserting an 
existing image or by creating a new image, that sprite is placed on top of the stack.

You can move sprites anywhere in the workspace. As you do so, they remain in their order in the 
stack until you specifically change the order.

The placement of sprites in the composition space does not necessarily reflect their order in the 
stack. Two sprites can be next to each other in a composition and yet be at opposite ends of the 
stack. Two sprites can be adjacent in the stack and can be at opposite ends of a composition. The 
following figure shows the relationship of sprites in a stack. The numbers in the sprites show their 
position in the stack.



Creating New Sprites
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You can create new sprites by inserting images that already exist or by creating new sprites with 
Microsoft Image Composer. Among the types of existing images you can insert into a composition 
include those stored in a variety of file formats, images scanned in from existing art, images from 
Kodak photo compact discs, and images imported from the World Wide Web.
When you insert an image from an outside source into Image Composer, that image immediately 
becomes a sprite, and you can treat it as you would any sprite. Note that some file formats that Image
Composer supports do not save alpha (transparency). For more information, see Working with 
Supported File Types.

You can create new sprites within Image Composer in a variety of ways. You can create sprites in 
different geometric shapes, such as rectangles, ovals, and polygons. You can also create a new sprite
from an existing sprite by duplicating it exactly, or by cutting out a portion of that sprite.

You can use the Image Composer Spline tool for creating free-form sprites or to cut out parts of 
existing sprites. You can use Spline to create shadows and masks and many other original shapes.



Overview of the Image Composer Interface
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The Microsoft Image Composer interface includes the toolbox and design space in addition to a 
toolbar and menus. The toolbox is a set of tools that you can use to apply tools, filters, and effects to 
sprites. When you start Image Composer, the toolbar appears below the standard Microsoft Windows 
95 menu bar. Below it is the Composition Guide, the Color Swatch, and a toolbox to the left. At the 
bottom of the screen, one of eight tool palettes appears, depending on which button is selected on the
toolbox. A status bar appears at the bottom of the window.

The following figure shows the Image Composer interface. Click on an area of the figure to get 
information on that part of the interface.

Note that when you work with the interface and move the pointer over a toolbar button or list, toolbox 
button, or Color Swatch, a ToolTip appears over the tool. The status bar also displays the name of 
the tool as the pointer passes over it.



If you have your own set of tools, such as Adobe Photoshop-compatible plug-in filters or Kai’s Power 
Tools, you can also use them with Image Composer.

The workspace is the area of Image Composer you use to create and modify a composition. Notice 
that the sliders are located on the midpoints of the horizontal and vertical scroll bars of the workspace
window to show that the workspace itself extends far beyond the workspace window.

Within the Image Composer workspace is the Composition Guide, a rectangle that occupies most of
a maximized view window, as shown in the figure of the interface. By default, the composition guide is
white, but it you can make it any color. The Composition Guide provides a reference space and a 
background color when creating a composition.

The area within the Composition Guide is the only area of the workspace that is included when you 
save a composition to certain file formats, such as GIF, or flatten a composition to a single sprite.



Working with the Image Composer Toolbox
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By using tools in the toolbox, you can    create your own style, or emulate an historic style. For 
example, you can use Microsoft Image Composer’s paint tools to emulate the bright colors and strong
brush strokes of a nineteenth century master like Cezanne, or create a monochrome wash drawing in 
the suiboku-ga style of the fourteenth century sumi-e master Sesshu Toyo.

Tool palettes are out of view until you activate them and then they slide up from behind the status bar. 
You can customize the behavior of the tool palettes to suit your own work style much as you can 
modify behavior of the task bar in Windows 95.

In Image Composer, tools palettes are organized by related tasks. For example, the Art Effects tool 
palette contains dozens of tools for sketching, painting, and more. You activate a tool palette by 
clicking a tool on the toolbox. The following list describes each tool palette.

· The Arrange tool palette contains tools to arrange, resize, rotate, flip, and change the order of 
sprites in the stack. Tools to crop or extend the bounding box of a sprite are also included.

· The Paint tool palette contains tools to apply various paint effects, such as spraying a color with an
airbrush or painting a color with a brush you choose from dozens of sizes and shapes.

· The Text tool palette contains tools to create text sprites using    the set of scaleable fonts that are 
installed on your computer.

· The Shapes tool palette contains tools to create new sprites in geometric shapes or in free-form 
shapes you create with the Spline tool. In addition, you can use the color lift tool to create a new 
sprite of a single color from an existing sprite or to extract the texture of a sprite.

· The Patterns and Fills tool palette contains tools to add color gradient ramps, predefined patterns,
complement shapes, and to transfer pixels from one sprite to another.

· The Warps and Filters tool palette contains tools to add warps, warp transforms, outlines, filters, 
and color enhancements to sprites.

· The Art Effects tool palette contains tools to add fine art effects to sprites, including paint, sketch, 
graphic, exotic, and utility effects.

· The Color Tuning tool palette contains tools for making adjustments to the contrast, brightness, 
hue, and saturation of colors, and for making adjustments to highlights and shadows, and dynamic 
range.

· The Color Picker dialog box provides access to true color palettes and to custom reduced-color 
palettes. You activate the Color Picker by clicking the Color Swatch. You also right-click to 
activate a more compact color picker with fewer options, depending on which tab of the Color 
Picker is current. You can drag a color from the main color swatch to color swatches on the tool 
palettes, such as those for shadow color and edge color in the Warps and Filters Outlines 
options, or from the color swatches on the tool palettes to the main Color Swatch.





Exploring the Image Composer Workspace
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The Microsoft Image Composer workspace extends far beyond the confines of a single monitor 
screen. The workspace includes the Composition Guide, plus an infinite amount of space beyond 
the Composition Guide. You can take advantage of this design space to place finished or 
experimental sprites in temporary storage in any part of the workspace.

You also can open more than one view window for a composition. For example, you can have one 
window showing your composition in True Color at 100% size, a window showing the composition 
reduced to 20%, and a window showing the composition with a custom color palette. You can use the 
Image Composer view window as a virtual camera that you can move around through an infinite 
scene.

The Image Composer workspace

When you save an Image Composer composition, you save everything in the workspace, including 
the sprites that are not on the Composition Guide. You can determine the size of the Composition 
Guide for a particular work session or set default size and color for all compositions.



The Image Composer Work Cycle
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An important concept in working with Microsoft Image Composer is current selection. At any moment 
in the course of designing your composition, the actions you perform, and the sprites you perform 
those actions on, are determined by the following current selections.

· Current sprite. This is the sprite you have selected by clicking it. The current sprite can be a single
sprite, a temporary set of sprites, or a permanent group of sprites.

· Current tool. This is the tool, filter, or effect that you most recently clicked.
· Current color. This is the color that is displayed in the Color Swatch.
· Current mode. This is the state of the composition environment as shown by the handles 

surrounding the bounding box. For example, in order to select a sprite, you must be in select mode.

At any time during your Image Composer work session, you can make any sprite the current sprite by
clicking it, any tool the current tool by clicking it, any color the current color by using the Color Picker,
and any mode the current mode by clicking a tool in the toolbox.

The Image Composer work cycle is built on the idea of experimenting easily with sprites that you 
create and with images you insert.

The Image Composer work cycle



Arrange tool palette



Paint tool palette



Text tool palette



Shapes tool palette



Patterns and Fills tool palette



Warps and Filters tool palette



Art Effects tool palette



Color Tuning tool palette



Color Picker



Answer Point
Answer Point support for Microsoft Image Composer is available by contacting Answer Point for your 
host product. For more information, see your host documentation.



Pointer location
Gives the X (horizontal) and Y (vertical) coordinates for the pointer.



Current sprite dimensions
Gives the dimensions, in pixels, of the current sprite, if any.



Composition Guide
The portion of the workspace that serves as a reference when you work on compositions. It 
determines the content of files saved to certain file types, a choice of which portion of a composition is
printed, and more. You can change the size and color of the composition guide.



Sprite
An image object, containing shape and transparency, that makes up a composition. Although sprites 
can be any shape, they are contained within rectangular bounding boxes. 



Current color swatch
Displays the current color, used in determining the color in many actions, such as creating geometric 
shapes, certain patterns and fills, and more.



Toolbox
Contains a button to activate each tool palette.



Title bar
Contains the title of the file that is currently open.



Menu bar
Contains commands to apply actions, arrange compositions, manage files, set options, and more.



Tool bar
Contains buttons to activate tools.



Workspace
The entire area available for composing images. Includes the workspace windows, composition 
guide, and sprites, including those not visible in the workspace window.



Current sprite location
Displays the location of the upper-left corner of the bounding box of the current sprite, if any, relative 
to the upper-left corner of the composition guide.



Cursor mode
Displays the current cursor mode, such as selection, zoom, pan, or any of the paint tools.



Status bar
Displays information about the current status of the composition as well as information about menu 
items and more.



Workspace window horizontal scrollbar
Use this scrollbar to move the view within the workspace window in a horizontal direction.



Workspace window vertical scrollbar
Use this scrollbar to move the view within the workspace window in a vertical direction.



Composition title bar
Displays the title of the composition currently within the workspace window.



Text Sprites Overview
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If a picture is worth a thousand words, imagine the value of a picture composed of words, or a word 
composed of pictures. By combining words with pictures, you can convey more information and 
produce more emotional impact than you could with pictures or words alone.

When you work with text in Microsoft Image Composer, you can create text sprites, which are the 
same as any other sprites you create. After you have created a text sprite, you cannot edit the text. 
You can apply any effect or filter to the text, but you cannot change the text string itself. Any text that 
you have typed in the Text edit box in the Text tool palette remains in the box, so creating a new text 
sprite with slightly altered text is a simple matter.

Text sprites are created in the current color displayed in the Color Swatch. When you want to use a 
different color for a text sprite, you must change the current color before creating the text sprite.

Image Composer supports any scaleable fonts that you have installed on your computer, including the
sample fonts that can be installed with this product.



To Create a Text Sprite

1 In the toolbox, click Text.
2 On the Text tool palette, click Select Font.
3 In the Font dialog box, choose a Font type, Font style, and Size.
4 Click OK.
5 In the Text edit box, type the text you want to appear in your composition.
6 Move the Opacity slider to the setting you want for the text sprite.
7 Click Apply.



To Create a Justified List

1 Arrange the text sprites in the top-to-bottom spacing you want for the list.
2 Press and hold the SHIFT key and select all the text sprites; this creates a temporary selection set.
3 On the toolbox, click Arrange.
4 In the Align grid, click Left Sides for a left-justified list or Right Sides for a right-justified list.
5 Click the sprite that you want to align the other sprites with.



To create a new web image from FrontPage
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You can create new web images in FrontPage 97 using Microsoft Image Composer. Your new image 
can combine shapes, other image files, and the various effects available on the tool palettes in Image 
Composer. After you are done creating your image, you can send it to FrontPage. When you include 
the image in a FrontPage web, the sprites in your composition are flattened into a single-image GIF 
file.

1 In FrontPage Editor, open the web page you want to add a new image to.
2 On the FrontPage toolbar, click Show Image Editor. This action starts Image Composer and you 

can begin a new composition for your web page.
3 In Image Composer, use the toolbox to display the tool palettes you want to use to create the 

image.
4 After you finish your composition, select all the sprites that make up the composition.
5 In Image Composer, on the Edit menu, click Copy.
6 In the FrontPage Editor, use the Paste command or the Insert Image command to insert the 

composition into your web page. This action automatically converts the selection into a GIF file.
7 If you want to save the file in Image Composer format (.mic), click Save As on the File menu, then 

enter a name for the file.
8 On the File menu, click Exit, then finish your work in FrontPage.

Note      If Image Composer does not start when you click Show Image Editor, you may need to set it
as the default image editor in FrontPage. If you want to preserve the flexibility multiple sprites provide,
you can also save the image as an Image Composer file (.mic) and after making changes to it, you 
can send it as a GIF file to your web.



To edit an existing web page image
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You can edit a web image you have in FrontPage 97 using Microsoft Image Composer. You can alter 
the image with shapes, other image files, and the various effects available on the tool palettes in 
Image Composer. After you are done editing your image, you can return it to FrontPage. When you 
return the image to FrontPage the sprites in your composition are combined into a single-image GIF 
file or flattened to the original format of the file.

1 In the FrontPage Editor, open the web page that contains the image you want to edit.
2 Double-click the image to start Image Composer.
3 In Image Composer, use the toolbox to display the tool palettes you want to use to edit the image.
4 Click Save on the File menu.
5 On the File menu, click Exit, then finish your work in FrontPage.

Note      If Image Composer does not start when you double-click your image, you may need to set it 
as the default image editor in FrontPage. If you want to preserve the flexibility that multiple sprites 
provide, you can also save the image as an Image Composer file (.mic). If you make changes to it, 
you need to re-save it as the GIF file used in your web. If you save the image as another name, you 
will have to add this new file to the web in FrontPage. The original file remains in the web, but is not 
referenced in the web page.



To select the color palette used by an image in FrontPage
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You can select the colors used by an image in your web page by changing the color format. Some 
images have color formats that look great in one web browser, but do not look good in all of them. To 
match the colors available with most web browsers, use the color format of the Balanced Ramp color
palette provided by Microsoft Image Composer. This way, you can ensure your page looks its best in 
most common web browsers. By changing color formats, you don't lose your old image and color 
palette. Image Composer doesn't remove the original image, but adds a new file with the new color 
palette to your web and web page. The old image with its original palette remains in your web.

1 In FrontPage, open the page that has the image you want to change.
2 Double-click the image.
3 In Image Composer, click Save As on the File menu.
4 In the Save As dialog box, if you have selected GIF as the file type, select Balanced Ramp in the 

Color format drop-down box, then click Save.
5 From the File menu, click Exit.



To make an existing sprite transparent
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You can make an existing sprite transparent to allow the sprites behind it to show through. By using a 
wash, you can change the opacity or percentage of the alpha channel mixed in the colors of the 
image. Lower wash opacity values create a more transparent sprite. If you apply a wash repeatedly, 
the image will fade so that all of the pixels are clear and the image is invisible.

1 In your composition, click the sprite you want to make transparent.
2 In the toolbox, click Warps and Filters.
3 From the Warps and Filters tool palette, select Color Enhancement.
4 Select Wash.
5 Adjust the Wash Opacity slider to specify the amount of transparency you want, then click Apply.

Note      If you are not sure what setting to use, start with a high value and apply that setting several 
times to slowly increase the transparency of the sprite.



To make an area of a sprite transparent
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You can make an area of a sprite semi-transparent or invisible to allow portions of other sprites 
behind the sprite to show through. For example, if you want to make two rings appear to be 
interlocked, you can overlap two sprites of a ring and erase the portions of one ring that would not be 
visible if the rings were interlocked.

Using Erase found on the Paint tool palette on areas of a sprite, you can change the opacity or 
percentage of the alpha channel mixed in the colors of an area of a sprite. Higher opacity values 
increase the transparency of the area. If you erase with the opacity set at 100, the areas of the sprite 
where you apply Erase become completely transparent or invisible. If you apply the erase item with a 
lower setting repeatedly to the same area, the area becomes more and more transparent.

1 In your composition, click the sprite that has the parts you want to make transparent.
2 In the toolbox, click Paint.
3 From the Paint tool palette, click Erase from the Paint Effect Grid on the left side of the palette.
4 Adjust the Opacity slider to specify the amount of transparency you want.
5 In the sprite that has areas you want to change, drag over the area you want to make transparent.



To map transparency from one sprite to another
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You can map the transparent pixels from one sprite to another so that a cutout shaped like the other 
sprite appears in the first sprite.

1 In your composition, position the sprite you want to use as a source of transparent pixels over the 
sprite that you want to add the transparent pixels to.

2 Click the destination sprite you want to add transparent pixels to.
3 In the toolbox, click Patterns and Fills.
4 From the Patterns and Fills palette, select Sprite to Sprite.
5 In the Sprite Texture Type drop-down box, select Transparency Map, then click Apply.
6 If the option to display Hint dialog boxes is selected, the Hint dialog box appears. Click OK.
7 In the composition, click the source sprite that has the transparent pixels you want to add to the 

destination sprite.
8 To see the results, move the source sprite off the sprite you wanted to change.



Editing Adobe Photoshop Files in Microsoft Image Composer
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You can open and edit your Adobe Photoshop files in Microsoft Image Composer. If you created your 
file using version 3.0, each of the image objects becomes a sprite when you open the file in Image 
Composer. For files created in earlier versions, the image objects are combined into one sprite in your
Image Composer composition. If you want to make separate sprites from the single sprite, you can 
extract portions. Also, if the paths in your Photoshop image do not appear in Image Composer; you 
can create sprites that have the same image as your paths using the Spline tool.

The size you set for the original composition in Photoshop determines the size of the Composition 
Guide in Image Composer. If your PSD file has a background image, that image becomes a sprite in 
the Image Composer composition, covering the Image Composer Composition Guide. The layers of 
the composition are blended much like the Normal layer function used in Photoshop.

To open an Adobe Photoshop file
1 From the File menu, click Open.
2 In the Open dialog box, select Adobe Photoshop (*.psd) in the Files of type box.
3 Locate the file you want to open and click Open.

Note      If your PSD file does not open, you need to save it as RGB in Photoshop before opening it 
in Image Composer.

You can edit the file using any of Image Composer's palettes.



Saving Your Composition to Adobe Photoshop File Format
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You can save your Microsoft Image Composer composition as an Adobe Photoshop version 3.0 PSD 
file. Each sprite becomes an image object.

To save your composition as a PSD file
1 From the File menu, click Save As.
2 In the Save As dialog box, select Adobe Photoshop 3.0 (*.psd) in the Save as type box. Click 

OK.
3 If you want to include the Composition Guide as the background object in your file, select the 

Save the composition guide as the background layer item in the Photoshop (.PSD) File Save 
Options dialog box.
Note      If you select this item, and then open the file in Photoshop, the file has a background layer 
that is the size and color of the Composition Guide. If you clear this item, the file does not include 
the Composition Guide as a background layer.

4 If you want to include all of the sprites regardless of their position relative to the Composition 
Guide, select the Save the sprites outside of the composition guide item.
Note      If you select this item, then open the file in Photoshop, the file has a background layer that 
is the size and color of the Composition Guide. If you clear this item, only the sprites and portions
of sprites that are within the area of the Composition Guide are saved in the file.

5 Click OK.



Overview of Working with Color
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Microsoft Image Composer offers you a wide range of colors and a variety of ways to use them in 
your composition. You can control the color palettes used by your composition, the current color used 
to apply various effects, how colors appear in a sprite, and how colors are corrected for viewing on 
various display systems.

With Microsoft Image Composer, you can use a true color or a variety of custom color palettes to 
control the colors used by your composition. The palette you choose depends on the display system 
and the colors that your composition needs.

Use the following descriptions to find out more about color and how you can use it.

· Using true color      All the compositions you design in Image Composer use true color available on 
display systems using a 24-bit video card.

· Using custom color palettes      You can design compositions that look great on less capable 
systems or for web browsers that may not have true color capability.

· Setting a current color      The Image Composer provides several ways for you to select a current 
color so that you can work efficiently.

· Adjusting the current color with color spaces      If you need to fine-tune the colors in a sprite or the 
colors of a palette, you can control the color using one of three different color spaces.

· Tuning the color of a sprite      If you want to adjust the brightness, contrast, highlight, or shadow of 
color in a sprite, you can edit the red, green, and blue channels.

· Control color with dithering      If you want to determine which effect is used by a custom palette to 
accommodate display systems of varying capabilities, you can choose from four types of dithering.



Using True Color
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You might plan to show your composition on a system with a 24-bit video card that can reproduce all 
16 million colors available on the true color palette. The True Color palette mixes the red, green, and 
blue available from your 24-bit color video card to produce the wide range of colors.

True color (24-bit color) means 16 million colors available

For more information see the following topics.

· To select a true color for the Color Swatch
· Adjusting the current color with color spaces
· To adjust the current color in the Color Swatch
· Adjusting color channels - Red, green, blue, and Alpha
· To select a true color as an entry in a custom palette
· To set a color from the desktop as the current color



Using Custom Color Palettes
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Currently, some video cards and web browsers are not able to reproduce the full range of true colors. 
If you want to publish your composition on the web, you can accommodate a variety of display 
systems and web browsers that may have less capability by using a custom color palette of 256 
colors. Instead of mixing colors, a custom palette or 8-bit color palette has 1 to 256 specific color 
entries. For example, the following figure shows the balanced color palette. Any composition you 
store or edit in Microsoft Image Composer is in true color.

Custom palette (8-bit color) means up to 256 specific colors available

Although Image Composer default palette is True Color, you can view and save your compositions 
with a custom color palette such as balanced ramp, grayscale, or a palette you create to fulfill the 
purpose of your composition. For example, you might want to use your composition as a logo on a 
web page and want to make sure it looks good on most display systems. Using a custom palette, you 
can simulate a system with reduced color capability and adjust your design to look its best.

Using a custom palette, you can:

· Preview your composition with a palette
· Create a custom palette
· Select a custom color for the Color Swatch
· Add colors to a custom palette

You can add colors from many sources:
· Sprites or an entire composition
· Various color ramps or system colors

· Change colors in a custom palette
· Select a color from the desktop
· Select a true color
· Adjust an entry



To create a custom palette
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1 Click the Color Swatch.
2 In the Color Picker dialog box, select the Custom Palette tab.
3 Click New.
4 In the New Color Palette dialog box, type a name in the Palette name box.
5 In the Palette size box, type the number of colors you want to add to your new palette.

Note      Once you specify a number of colors, you can’t change it. The maximum number of colors 
you can specify is 256.

6 In the Dither by box, select a method for approximating colors that are not in the current color 
palette, then click OK.

To Select Effect
Not dither Solid No color blending 

which creates a poster-
like effect with 
splotches of color

Use a standard 16 x 16 
ordered dither

Pattern Little color blending 
that produces a blocky 
appearance

Use a 256x256 ordered 
dither

Random Medium color blending

Distribute the color 
difference between the 
true color and the 
nearest palette color to 
the neighboring colors

Error Diffusion High color blending 
useful with 
photographs.

Now you can add colors to your custom palette from a single sprite or an entire composition or from 
various color ramps or system colors.



To add colors from a sprite or composition
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

After you create a palette, you can add colors from selected sprites or an entire composition. The 
palette must have empty entries. For example, you can create a new palette with 256 color entries, 
add 100 colors from one group of sprites, then you can continue to add an additional 156 colors.

1 In the composition, select the sprites that have the colors you want to add to a palette.
2 Click the Color Swatch to display the Color Picker dialog box.
3 In the Color Picker dialog box, select the Custom Palette tab.
4 If the palette you want to add colors to is not displayed, click the name of the palette in the Color 

Palette box.

Note      If the palette’s name does not appear in the Color Palette box, use Load to locate the 
palette and add it to the list of items.

5 Click Generate Colors.
6 In the Generate Colors dialog box, type the number of colors you want to generate from the sprite.

Note      The minimum and maximum number of colors you can add appears to the right of the 
Number of colors edit box. These numbers are based on the number of empty entries in the 
palette.

7 In the Generate from box, select Selection or Composition, then click the Add button.
Using the colors from the selection, Image Composer adds the number of colors you specified to 
the custom palette.

8 If your palette still has empty entries and you want to add more colors, repeat steps 6 and 7.
– or – 
Click Close.



To add colors from a color ramp or system colors
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

You can add colors to a custom palette from several color ramps. For example, if you want to add 
several blues to your palette, you can choose the blue ramp. The number of colors you specify 
determines how many different blues are added.

To add colors to a custom palette, the palette must have empty entries. For example, you can create 
a new palette with 256 color, add 100 colors from the blue ramp, then you can continue to add an 
additional 156 colors.

1 Click the Color Swatch, then click the Custom Palette tab in the Color Picker dialog box.
2 If the palette you want to add colors to is not displayed in the tab, click the name of the palette in 

the Color Palette box.

Note      If the palette’s name in not in the list in the Color Palette box, use the Load button to 
locate the palette and add it to the list of items.

3 Click Generate Colors.
4 In the Generate Colors dialog box, type the number of colors you want to add in the Number of 

colors edit box.
5 In the Generate from box, click the ramp or palette you want, then click Add.

Note      If Add is not available, either the number of colors you specified is too low for the ramp you
selected or the palette does not have enough empty entries to add the colors.

6 If your palette still has empty entries and you want to add more colors, repeat steps 4 and 5 until 
you have added all of the colors you want.

7 Click Close.



To change colors in a custom palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

After you create a custom palette and add colors, you can change the colors in a custom palette one 
at a time.

1 Click the Color Swatch.
2 In the Color Picker dialog box, click the Custom Palette tab.
3 In the Custom palette entries, double-click the color you want to change.
4 From the Choose Color dialog box, select the color you want.
5 Click Apply.



To select a true color as a custom palette entry
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

After you create a custom palette and add colors, you can change the colors in a custom palette one 
at a time.

1 Click the Color Swatch.
2 In the Color Picker dialog box, click the Custom Palette tab.
3 In the Custom palette entries, double-click the color you want to change.
4 From the Choose Color dialog box, click a color in the Color Ramp, then click Apply.

– or – 
Use the handles and edit boxes to change the color displayed in the New color to use box, then 
click Apply.

To Do
Change the amount of black in the 
color

Move the handle on the left of the 
color ramp

Change the amount of white in the 
color

Move the handle on the right of the 
color ramp.

Change the hue Move the handle at the top of the 
color ramp
– or – 
Select the HSV color space and use
the slider and edit box for Hue.

Change the amount of gray in the 
color

Select the HSV color space and 
change the setting for Saturation.

Lighten or darken the color Select the HSV color space and 
change the setting for Value.

Select a pure primary color Select the RGB color space and 
change one of the settings to 255 
and the other two to zero.

Select a pure secondary color Select the RGB color space and 
change two of the setting to 255 and
the other to zero.

Select gray Select the RGB color space and 
change all three settings to the 
same number.



To select a color from the desktop as a custom palette entry
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

After you create a custom palette and add colors, you can change the colors in a custom palette one 
at a time.

1 Click the Color Swatch.
2 In the Color Picker dialog box, click the Custom Palette tab.
3 In the Custom palette entries, double-click the color you want to change.
4 In the Choose Color dialog box, click the Eyedropper button on the True Color tab.
5 To select a single color, place the Eyedropper cursor over the color you want to copy and click.

– or – 
To select the average color from a range of colors, drag the Eyedropper cursor to select an area of 
colors on the desktop.

6 Click Apply.



To adjust a color in a custom palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

After you create a custom palette and add colors, you can change the colors in a custom palette one 
at a time.

1 Click the Color Swatch.
2 In the Color Picker dialog box, click the Custom Palette tab.
3 In the Custom palette entries, double-click the color you want to change.
4 From the Choose Color dialog box, move the handles on the color ramp.

– or – 
Choose a color space and type the numbers you want into the edit boxes.

5 Click Apply.



To preview a composition with a palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

You can preview your composition using the colors from any color palette currently loaded. 
Previewing your composition with another palette allows you to make sure your composition appears 
properly in a variety of color environments. For example, some web browsers are not able to show 
true color. You can use the Balance Ramp palette to preview compositions you want to publish on a 
web page.

1 On the Image Composer toolbar, click the Color Format edit box.
2 Click the name of the palette with the colors you want to preview.

Note      If the name of the palette is not in the list, use the Custom Palette tab of the Color Picker 
dialog box to load the palette.



Setting a Current Color
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

The Color Swatch displays the current color used by Microsoft Image Composer for many effects and 
actions, such as creating a new sprite or adding a pattern, painting on a sprite, filling a sprite, and 
more. Click the following topics to learn about different ways to set the current color.

· To select a true color for the Color Swatch
· Adjusting the current color
· To adjust the current color in the Color Swatch
· Adjusting color channels
· To select a true color as an entry in a custom palette
· To set a color from the desktop as the current color



To select a color using the Quick Color Palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

1 Right-click Color Swatch.
2 In the Quick Palette, click the color you want to use.

Note      Any new sprite, pattern, or fill you add uses the new color you picked. If you want to change 
which colors are available you can set the Quick Color Palette to show true colors or to show a 
custom color palette, use the Color Picker dialog box.



To select a true color for the Color Swatch
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

1 Click the Color Swatch.
2 In the Color Picker dialog box, select a color from the True Color tab.
3 If you want to adjust the color, use the handles, sliders, and boxes to change the color displayed in 

the New color to use box.
4 Click OK.

Note      If you move the handles on the color ramps and the new color remains white regardless of 
what you select, move the handle on the Hue and Whiteness ramp toward the top. Any new sprite, 
pattern, or fill you add uses the new color you picked. If you want to change which colors are 
available in the Quick Color palette, use the Color Picker dialog box.



To select a custom color for the Color Swatch
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

1 Click the Color Swatch.
2 In the Color Picker dialog box, select the Custom Palette tab.
3 In the Color Palette box, select the name of the palette that has the color you want to use.
4 In Custom palette entries, click a color.
5 Click OK.

Note      Any new sprite, pattern, or fill you add uses the new color you picked. Also, the Quick Color 
palette displays the custom palette displayed in the Color Picker dialog box.



To set a color from the desktop as the current color
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

1 Click the Color Swatch.
2 In the Color Picker dialog box, click the Eyedropper button on the True Color tab.
3 To select a single color, place the Eyedropper over the color you want to copy and click.

– or – 
To select the average color from a range of colors, drag the Eyedropper to select an area of colors
on the desktop.



To select true color for the Quick Color Palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

You can select which palette appears in the Quick Color palette which is available from the shortcut 
menu.

1 Click the Color Swatch.
2 Click the True Color tab.

Note      If you want a custom palette to display in the Quick Color palette, click the Custom 
Palette tab and select a name from the list for the Palette Name box.

3 Click OK.

Note      The palette showing when you close the Color Picker dialog box displays in the Quick Color
palette.



To select a custom palette for the Quick Color Palette
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

You can select which palette appears in the Quick Color palette which is available from the shortcut 
menu.

1 Click the Color Swatch.
2 Click the Custom Palette tab and select a name from the list for the Palette Name box.

Note      If you want true colors to display in the Quick Color palette, click the True Color tab.

3 Click OK.

Note      The palette showing when you close the Color Picker dialog box displays in the Quick Color
palette.



Adjusting the current color with Color Spaces
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

You can specify a color using one of three color spaces available in Microsoft Image Composer. You 
typically may see true color expressed as number settings for red, blue, and green, known as the 
RGB color space. If you are more familiar with numbers for hue, saturation, and value, you can use 
the HSV color space. If you would rather add black and white to a color to produce the color you 
want, you might find using the handles for the hue, whiteness, and blackness (HWB) ramps more 
useful for mixing the color you want. For more information on using the color spaces to adjust the 
current color in the color swatch, see the topic, To adjust the current color in the Color Swatch.



To adjust the current color in the Color Swatch
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

1 Click the Color Swatch.
2 In the Color Picker dialog box, use the handles, sliders, and boxes to change the color displayed 

in the New color to use box.
Note      If you move the handles on the color ramps and the new color remains white regardless of 
what you select, move the handle on the Hue and Whiteness ramp toward the top.

To Do
Change the amount of black in the 
color

Move the handle on the left of the 
color ramp

Change the amount of white in the 
color

Move the handle on the right of the 
color ramp.

Change the hue Move the handle at the top of the 
color ramp
– or – 
Select the HSV color space and use
the slider and edit box for Hue.

Change the amount of gray in the 
color

Select the HSV color space and 
change the setting for Saturation.

Lighten or darken the color Select the HSV color space and 
change the setting for Value.

Select a pure primary color Select the RGB color space and 
change one of the settings to 255 
and the other two to zero.

Select a pure secondary color Select the RGB color space and 
change two of the setting to 255 and
the other to zero.

Select gray Select the RGB color space and 
change all three settings to the 
same number.



Adjusting Color Channels - Red, green, blue, and alpha
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

In your composition, you can adjust the four channels of a color using the Color Tuning tool palette. 
Typically, you don’t need to consider the individual channels and pixels, because the functions work 
directly on the image. However, you might like to know that each pixel in an image is described by 
four channels of data that define the mixture of red, green, and blue colors, plus the alpha 
transparency. These channels are referred to as RGBA (red, green, blue, and alpha). Altering the 
intensity of the RGB channels produces combinations that alter the hue of a pixel. Altering the 
intensity of the alpha channel changes the transparency of a pixel. For more information about tuning 
color, see the topic, Color Tuning Tool Palette Overview. For more information about transparency, 
see the topic, Sprites and Opacity.



Controlling Color with Dithering
{button ,AL("color 
con")} Related 
Topics

{button ,AL("c
olor ovr ")} 
Overview

{button ,AL("color how
",1,`',`howto')} How?

The appearance of custom palette colors can vary depending on the capabilities of the display system
you are using. For example, most but not all video cards are 24-bit, and some display systems may 
still use an 8-bit card. Also, some web browsers have their own color palette. To correct for 
differences between the colors in the custom palette and the colors the display system can produce, 
Microsoft Image Composer uses dithering, which mixes available colors to approximate the color that 
is not available. To control how dithering is applied for your custom palette, you can choose from four 
types of dithering for a custom color palette. Each type of dithering specifies the number and 
arrangement of gray pixels used to correct a color.

To Select Effect
Not dither Solid No color blending, 

which creates a poster-
like effect with splotches
of color

Use a standard 16 x 16 
ordered dither

Pattern Little color blending that
produces a blocky 
appearance

Use a 256x256 ordered 
dither

Random Medium color blending

Distribute the color 
difference between the 
true color and the nearest 
palette color to the 
neighboring colors

Error Diffusion Sharp color blending 
useful with 
photographs.



Sprite Properties dialog box

The Sprite Properties dialog box allows you to change the name of a sprite and to view the settings 
for the sprite's size, position, and color model.

Name      Specifies the name of the selected sprite or displays Multiple Selection if you have more 
than one sprite or a group selected. If you inserted a sprite from a file, the sprite name matches the
filename; otherwise, the sprites are numbered. If you selected a single sprite, you can change the 
name of the sprite by typing over the current name.

Thumbnail      Displays a reduced version of the sprite or sprites.
Width      Displays the number of pixels the sprite (or selection of sprites) extends from side to side.
Height      Displays the number of pixels the sprite or selection of sprites extend from top to bottom.
Color space      Indicates which color model is used by the sprite.
Has alpha      Indicates that the alpha or transparency channel is used by this sprite.
Num. channels      Displays the number of color channels in the sprite. For example, 4 indicates that 

the red, blue, green, and alpha color channels are present in the current sprite or multiple 
selection.

Bits per channel      Displays the number of bits used to represent color in a single pixel of the sprite.
OK button      Closes this dialog box and, if you changed the name of a sprite, saves the change.
Cancel button      Closes this dialog box without saving changes you have made.
Apply button      Saves the changes you made to the sprite's name.



Composition Properties dialog box

The Composition Properties dialog box allows you to change the size and color of the 
Composition Guide and to view the settings for the composition's color model and shows a list of all 
the sprites in the composition.

Width      Displays the number of pixels the Composition Guide extends from side to side.
Height      Displays the number of pixels the Composition Guide extends from top to bottom.
Thumbnail      Displays a reduced version of the composition.
Color space      Indicates which color model is used by the composition.
Has alpha      Indicates that the alpha or transparency channel is used by the composition.
Num. channels      Displays the number of color channels that are present in the composition. For 

example, 4 indicates that the red, blue, green, and alpha color channels are present in the current 
sprite or multiple selection.

Bits per channel      Displays the number of bits used to represent color in a single pixel of the 
composition.

Sprite List      Displays the names of the sprites in the composition and allows you to display the 
properties for the sprite by double-clicking the sprite's name or using the shortcut menu.

OK button      Closes this dialog box and, if you changed the size or color of the Composition Guide,
saves the change.

Cancel button      Closes this dialog box without saving changes you have made.
Apply button      Saves the changes you made to the Composition Guide's size or color.



Toolbars dialog box

The Toolbars dialog box allows you to select which toolbars are displayed in Microsoft Image 
Composer and to change some of their display properties.

Toolbars list box      Specifies the available toolbars and allows you to select which toolbars appear. 
Select the box to display or clear the box to hide each item in the list.
· Toolbar      Shows or hides the bar of icons or standard Image Composer toolbar that is located 

above the workspace.
· Toolbox      Shows or hides the bar of icons that you use to display the tool palettes.
· Color Swatch      Shows or hides the square of color that you use to select a new color or to 

display the Color Picker dialog box.
· Status Bar      Shows or hides the bar that displays prompts, cursor position, and other 

information at the bottom of the Image Composer window.
Color Buttons      Displays colored buttons on the standard toolbar.
Large Icons      Enlarges the buttons on the standard toolbar so that they are easier to see.
Show ToolTips      Displays on-screen descriptions of the standard toolbar buttons when the pointer 

pauses on them.
OK button      Closes this dialog box and saves the changes you have made.
Cancel button      Closes the dialog box without saving the changes you have made.



Brush Designer
{button ,AL("A_PAIN
T_To_choose_a_pai
nt_brush;A_PAINT_
To_create_a_templa
te")} Related Topics

{button ,AL("
A_PAINT_Pai
nt_Tools_Ove
rview")} 
Overview

Diameter
Specifies the diameter of the brush you are designing. Higher Diameter values create larger brushes.
You can move the slider to create the brush diameter you want, or you can select the current value 
and type a number between 1 and 100, or click the arrows to select a new value.

Aspect
Specifies the shape of the brush you are designing. The Aspect value determines the ratio of height 
to width of the brush. The default value is 100, which specifies a round brush shape. Lower Aspect 
values create oval to flat brush shapes. You can move the slider to create the brush shape you want, 
or you can select the current value and type a number between 1 and 100, or click the arrows to 
select a new value.

Rotation
Specifies the angle of rotation of the brush you are designing. Rotation is not a factor in your brush 
design unless the Aspect value is less than 100. The default value is 0; maximum value is 360.You 
can move the slider to create the brush shape you want, or you can select the current value and type 
a number between 0 and 360, or click the arrows to select a new value.

Softness
Specifies the edge softness of the brush you are designing. Lower Softness values create softer 
brush edges. The default value is 1; the maximum value is 100. You can move the slider to determine 
the brush edge softness you want, or you can select the current value and type a number between 1 
and 100, or click the arrows to select a new value.



Channel Edit Commands Overview
{button ,AL("color 
shifting 
how;highlight/shado
w 
how;A_Intro_Sprites
_and_Opacity;chan
nel")} Related 
Topics

{button ,AL("
A_To_Copy
_A_Channel
;A_To_Past
e_A_Chann
el;A_To_Bro
adcast_A_C
hannel")} 
How?

Source sprite Destination sprite

Destination sprite
after pasting a

channel

Sprite after
broadcasting a

channel

You can use the channel edit commands, Copy Channel, Paste Channel, and Broadcast Channel, 
to perform actions such as the following:

· Create new sprites based on a single channel of an existing sprite.
· Replace a channel of one sprite with a channel from another sprite.
· Replace all channels of a sprite with a channel from that same sprite.

The Copy Channel and Paste Channel commands work with the Clipboard, much the same as any 
copy and paste operations. They are useful for placing a single channel from a source sprite into the 
same, or another, channel in a destination sprite. This action produces an effect in which a single 
channel from the source sprite appears superimposed on the destination sprite. You can also use 
these commands on a single sprite. The copied channel also can be pasted back into the composition
as a new sprite.

The Broadcast Channel command operates on a single sprite to create a grayscale version of the 
sprite. This command is useful when examining a single channel. For example, when you broadcast 
the alpha channel, you replace all color channels with the alpha channel, producing an image 
resembling a cutout of the sprite.

Note      If your Composition Guide color is set to white, a sprite might seem to disappear when you 
use the edit channel commands. This is because the sprite is filled with white in those areas in which 
the channel has content, and it is transparent in those areas in which there is no content. To see the 
sprite, change the Composition Guide color or move the sprite off the Composition Guide.



To Copy a Channel
{button ,AL("color 
ovr;A_Intro_Sprites
_and_Opacity;")} 
Related Topics

{button ,AL("
A_Channel_
Edit_Comm
ands_Overv
iew")} 
Overview

1 Select the sprite from which you want to copy a channel.
2 On the Edit menu, click Copy Channel.
3 On the Copy Channel submenu, click one of the following: Red, Green, Blue, or Alpha.



To Paste a Channel
{button ,AL("color 
ovr;A_Intro_Sprites
_and_Opacity;")} 
Related Topics

{button ,AL("
A_Channel_
Edit_Comm
ands_Overv
iew")} 
Overview

1 Copy a channel from a sprite you have selected.
2 Select a sprite into which you will paste the copied channel. This can be the same sprite or a 

different one.
3 On the Edit menu, click Paste Channel.
4 On the Paste Channel submenu, click the channel into which you want to paste the copied 

channel.



To Broadcast a Channel
{button ,AL("color 
ovr;A_Intro_Sprites
_and_Opacity;")} 
Related Topics

{button ,AL("
A_Channel_
Edit_Comm
ands_Overv
iew")} 
Overview

1 Select the sprite you want to affect.
2 On the Edit menu, click Broadcast Channel.
3 On the Broadcast Channel submenu, click the channel that you want to fill the other channels.



Overview of Printing a Composition
{button ,AL("A_To_P
rint_A_Composition"
)} Related Topics

{button ,AL("
A_To_Print_
A_Composit
ion")} How

You can print all or part of a composition. The Print dialog box contains the following composition-
specific controls:

· Composition      Click this button to print the portion of your composition that is contained within the
composition guide.

· Current View      Click this button to print only the portion of your composition that is contained 
within the active workspace view window.

· Best Fit      Click this button to retain the current aspect ratio of the composition at the largest size 
possible on the printed page.

· Stretch to Page      Click this button to change the aspect ratio of the composition so that the 
printed image fills the entire printed page.

· Scale      Click this button to choose a percentage by which to scale the composition. The X% and 
Y% controls are independent, so by entering different values in each, you can change the aspect 
ratio of a composition.

When you print a composition, the resolution of the printed image is based on the common monitor 
resolution of 96 DPI (dots per inch). This means that when you print a composition scaled at 100%, 
the printed image looks the same size as the image on the monitor regardless of the dpi setting of the
printer.



To print a composition
{button ,AL("A_Printi
ng_A_Composition"
)} Overview

1 On the File menu, click Print.
2 In the Print dialog box, click a printer in the Name box.
3 In the Print Selection group, click Composition or Current View.
4 In the Print Options group, click Best Fit, Stretch to Page, or Scale. If you click Scale, enter a 

percentage for both X% and Y%.
5 From the Copies box, click the number of copies you want.
6 Click OK.



Introduction to the Tutorial
{button ,AL("A_Intro_
What_Is_Image_Co
mposer;tutorial 
section overview")} 
Related Topics

Welcome to Microsoft Image Composer. This tutorial provides you with the basic skills to work 
successfully with Image Composer by having you create a logo for use on the Web. The logo you will 
create is for an imaginary flower shop. The company, name, and/or data used in screen and sample 
outputs are fictitious.

The finished logo

To benefit the most from this tutorial, you should be familiar with the ideas discussed in Welcome to 
Image Composer. This tutorial was designed to be worked on in the order each topic appears in the 
Help table of contents. Click the browse arrows on the button bar to move through the topics in order. 
You will work through the following parts while creating the Web logo:

Part 1: Organizing and Modifying Sprites

Part 2: Creating the Logo Background and Name

Part 3: Preparing the Logo for the Web

The next topic is Preparing for the Tutorial.



Preparing for the Tutorial
{button ,AL("A_Welc
ome_Using_Image_
Composer_Docume
ntation;tool 
palettes;")} Related 
Topics

You can use the tutorial topics as you would a regular Help topic, including printing topics. You might 
want to set your options in the Help window so that the Help window stays on top of all other 
windows while you work with the tutorial. Image Composer must be running for you to work with the 
tutorial.

To customize Help window behavior
1 On the button bar in the Help window, click Options.
2 Click Keep Help on Top.
3 Click On Top.

The tutorial is self-paced, so you proceed to new topics only when you are ready. Use the browse 
buttons to navigate, or click on the title of the next topic at the bottom each topic to proceed.

You can stop the tutorial at any time simply by closing the Help window. If you want to stop before 
completing the tutorial, you should save your composition. For more information, see Saving a 
Composition.

Please note the Related Topics button found under each topic title. Click this button to get a list of 
related topics found in the online Help, in addition to the three tutorial parts.

When you start Image Composer, the Arrange tool palette is in view. The default behavior for tool 
palettes includes the following:

· The Show New Tool Palette on Change option is checked. New tool palettes are displayed each 
time you click a tool on the toolbox or on the Tools menu.

· The AutoHide Tool Palette is not checked. Tool palettes remain in view until you select a different 
tool palette or close the palette by clicking X on the palette's title bar. When checked, the AutoHide
Tool Palette option makes a tool palette follow the pointer movement. A tool palette slides out of 
view when you move the pointer off the palette and slides up into view when you move the pointer 
onto the status bar.

You can customize tool palette behavior by setting options in the Tools Options dialog box. The 
options you choose take effect as soon as you click OK.

To customize tool palettes to follow pointer movement
1 On the Tools menu, click Options.
2 In the Options dialog box, click the Tool Palettes tab.
3 Click AutoHide Option Palette.
4 Click OK.

The next topic is Part 1:    Organizing and Modifying the Logo Flowers.



Part 1: Adding and Modifying Sprites
{button ,AL("tutorial 
section overview")} 
Related Topics

In this portion of the tutorial, you will work with images in the Microsoft Image Composer workspace. 
This part of the tutorial teaches the basics of selecting, moving, and resizing images, and introduces 
several of the tools you use to adjust the color of the image or add a specific artistic look.



Inserting Images
{button ,AL("A_MAN
AGING_Overview;A
_Intro_What_Is_A_S
prite")} Related 
Topics

A basic task you perform in Image Composer is inserting an image from a file. You can insert an 
image from a file stored on your hard disk, from a compact disc, or from a photo compact disc. For 
the first step in creating this logo, you will insert images from your hard disk. Inserting files from other 
media is similar.

To insert the logo images from a file on your hard disk
1 On the Insert menu, click From File.
2 In the Insert From File dialog box, navigate to the directory into which you installed Image 

Composer, \Program Files\Microsoft Image Composer by default.
3 In the list of folders, double-click Tutorial.
4 In the Files of type list box, click TIFF (*.tif,*.tiff).
5 Hold down the CTRL key, and click Tulip.tif, Hibiscus.tif and Daisy.tif.
6 Click OK.

You now have three different types of flowers on your Composition Guide. The flower sprites are 
stacked on top of one another in the upper left corner of the workspace window in the order in which 
you inserted them into the composition. This order is the order of each sprite in the Image Composer 
stack.

To work with the flower sprites, you must separate them. To separate them, you first must select them.

The next topic is Selecting Sprites. If you want to take a break, save your composition now.



Selecting Sprites
{button ,AL("ARRAN
GE_Working_with_th
e_Selection_Model;
A_ARRANGE_To_ch
ange_the_stack_ord
er;A_ARRANGE_Arr
ange_Overview")} 
Related Topics

When you inserted the last flower sprite (the tulip) into your Image Composer composition, it 
automatically became the selected sprite. The bounding box surrounding the tulip indicates that it is 
the selected, or current, sprite. Nearly everything you do in Image Composer affects the current 
sprite.

To select a flower sprite
1 Move the pointer over the sprite you want to select, in this case the hibiscus, and click the end of 

one of the petals.
The bounding box now extends to the ends of the hibiscus petals. The hibiscus is still partially 
hidden by the tulip sprite because the tulip sprite is above the hibiscus sprite in the stack.

2 Select the tulip sprite by clicking in the middle of the tulip.
Because the tulip sprite is at the top of the stack of sprites, clicking the middle of it makes the tulip 
the selected sprite.

You might find that you want to select a sprite that is hidden from view behind another sprite. To select
a hidden sprite, you can cycle through the stack.

To cycle through the stack
· Press the TAB key.
Each time you press the key, a new sprite is selected relative to its position in the stack. By pressing 
the key repeatedly, the selection moves through the entire stack in order, so you can stop when you 
see the bounding box of the sprite you want to select.

The bounding box has resize handles at three of the four corners and on each side. The upper right 
corner contains a handle for rotating a sprite. Because Image Composer inserts new sprites into the 
corner of the workspace window, some of the handles of the sprites you have inserted are not visible. 
You must move the sprite to see all the handles.

The next topic is Moving Sprites. If you want to take a break, save your composition now.



Moving Sprites
{button ,AL("A_ARR
ANGE_Arrange_Ov
erview;A_Exploring_
Image_Composer_
Workspace")} 
Related Topics

One of Image Composer’s most important features is the ease of moving a sprite. Because sprites 
are objects, you can move an image of a flower as easily as you can pick up and move a real flower. 
To demonstrate the extent of Image Composer’s workspace as you move sprites, you will move the 
Composition Guide to the lower right corner of the workspace window and move the sprites, as 
shown in the following figure. Use the following procedures to become familiar with manipulating 
sprites.

Using the workspace

To adjust the view in the workspace window
· Click the horizontal scroll bar once to the left of the slider and click the vertical scroll bar once 

above the slider.

When you moved the Composition Guide, you saw that it is surrounded by a gray area known as 
the workspace. The Composition Guide simply provides a reference for your composition. You can 
move sprites off the Composition Guide and back onto it as you experiment with your composition.

To move the sample sprites
1 Drag the tulip sprite off the Composition Guide to another part of the view window.
2 Drag the hibiscus sprite off the Composition Guide.

Now, move the sprites back onto the Composition Guide and use the scroll bars to return the 
Composition Guide to the original location. You currently have three flower sprites to work with. You 
can easily add more sprites to your composition by duplicating the sprites you have inserted.

The next topic is Duplicating Sprites. If you want to take a break, save your composition now.



Duplicating Sprites
{button ,AL("geometr
y misc how")} 
Related Topics

Image Composer was designed to make it easy for you to experiment with every aspect of a 
composition. Duplicating sprites is a basic task that provides you with copies of sprites on which to 
experiment. Duplicating a sprite makes an exact copy, as shown in the following figure.

Duplicated sprites in the workspace

To duplicate the sample sprites
1 Click the daisy.
2 Click Duplicate on the Edit menu.
3 Make one more duplicate of the daisy sprite and make two duplicates of each of the other flower 

sprites.

To make the sprites easier to work with, drag each of the duplicates to form a column of each type of 
flower on the Composition Guide.

You now have several sprites to use in the logo. You can change the size of the sprites to create a 
more interesting composition.

Tip      You can also duplicate a sprite by pressing CTRL and dragging the bounding box.

The next topic in this tutorial is Resizing Sprites. If you want to take a break, save your composition 
now.



Resizing Sprites
{button ,AL("A_ARR
ANGE_Arrange_Ove
rview")} Related 
Topics

The design of the logo will provide more visual interest if each set of flowers were a different size. 
Image Composer offers a couple of ways to resize sprites. One way to change the size of a sprite is 
to enter values for height and width using the Arrange tool palette.

To resize a sample sprite
1 Click a daisy.

Look in the status bar at the numbers for width (W) and height (H). You see that the daisy is 148 
pixels high by 134 pixels wide.

2 In the toolbox, click Arrange.
3 In the Width box on the left side of the tool palette, select the current value and type 123.
4 In the Height box on the left side of the tool palette, select the current value and type 111.
5 Click Apply.

Tip      You can resize a sprite interactively by dragging the resize handle at the corner of the bounding
box.

You now have two larger daisy sprites and one smaller daisy sprite. You can also change the size of a
sprite by a specific percentage.

The next topic in this tutorial is Resizing Sprites by a Specific Percentage. If you want to take a break,
save your composition now.



Resizing Sprites by a Specific Percentage
{button ,AL("A_ARR
ANGE_Arrange_Ove
rview")} Related 
Topics

Image Composer provides alternative ways to accomplish many tasks. For example, you also can 
use the Arrange tool palette to resize a sprite by a specific percentage, as shown in the following 
figure.

Daisy sprites after resizing

To resize sample sprites by a specific percentage
1 Click one of the larger daisies.
2 On the toolbox, click Arrange.
3 In the Units drop-down box, click Percent.
4 In the Width edit box, enter 57.

The Keep Aspect Ratio box is checked by default so that you have to enter only width or height 
and the corresponding value is computed automatically.

5 Click Apply. The sprite is now 84 pixels wide and 76 pixels high.
When you clicked Apply, the Units box returned to Pixels display.

6 Resize one of the remaining hibiscus sprites to 58% of its original size, and resize the remaining 
hibiscus to 76% of original size.

7 Resize one tulip to 84% of the original size, and resize another tulip to 67% of the original size.

You might want to experiment with making sprites other sizes, larger and smaller. After each 
experiment, you can click Undo on the Edit menu to return the sprite to its original size.

Now you have three different sizes of sprites for each type of flower sprite. The following figures show
the hibiscus and tulips sprites after resizing.

Hibiscus sprites after resizing

Tulip sprites after resizing

You now have one of each type of flower sprite in small, medium, and large sizes. Now you can 



modify the colors of the sample sprites to add variety to the composition.

The next topic in is Adjusting Color Intensity. If you want to take a break, save your composition now.



Adjusting Color Intensity
{button ,AL("saturati
on")} Related Topics

You can adjust the color of a sprite by using the Color Shifting tools on the Color Tuning tool 
palette. You adjust color intensity by setting the saturation level, as shown in the following figure.

To adjust the intensity of the sample sprites
1 Click the largest tulip.
2 On the toolbox, click Color Tuning.
3 On the Color Tuning tool palette, click Color Shifting.
4 In the Saturation box, select the current value and type 30.

Note      You also can adjust the saturation by adjusting the slider.
5 Click Apply.

Notice that the tulip sprite now is a more intense red and the bounding box handles now have 
color-striped boxes, indicating that Image Composer is now in Color Tuning mode.

6 Adjust the color of the largest hibiscus sprite to a saturation of 100 and the largest daisy sprite to a 
saturation of 50.

The following figures show the large hibiscus and daisy sprites after adjusting saturation.

Large hibiscus sprite after Saturation adjustment

Large daisy sprite after Saturation adjustment

Now you can change the colors of the medium-size flower sprites by adjusting their hues.

The next topic in this tutorial is Adjusting Hue. If you want to take a break, save your composition 
now.



Adjusting Hue
{button ,AL("hue")} 
Related Topics

In Image Composer, you can set the color of a sprite by adjusting its hue, as shown in the following 
figure.

To adjust the hue of the sample sprites
1 Click the medium-size tulip sprite.
2 On the toolbox, click Color Tuning.
3 On the Color Tuning palette, click Color Shifting.
4 In the Hue box, select the current value and type -100.
5 Increase the intensity of the tulip sprite by setting the saturation to 30.

Note      Click the back browse button on the tutorial toolbar to view instructions for setting 
saturation.

6 Click Apply.
The tulip sprite is now bluish-purple, as shown in the preceding figure.

7 For the medium-size hibiscus sprite, set the hue to -100 and the saturation to 30, and click Apply.
8 For the medium-size daisy sprite, set the hue to -60 and the saturation to 10, and click Apply.

The following figures show the results of your modifications.

Medium-size hibiscus sprite after hue and saturation adjustment

Medium-size daisy sprite after hue and saturation adjustment

Drag the tulips off the composition guide into the workspace area. Don’t worry if the they seem to 
overlap one another.

You can adjust the colors of the remaining flowers by setting and applying the current color on the 
Color Swatch.

The next topic in this tutorial is Defining the Current Color. If you want to take a break, save your 
composition now.





Defining the Current Color
{button ,AL("A_howT
o_adjust_the_current
_color_in_the_Color
_Swatch")} Related 
Topics

The Color Swatch on the toolbox displays the current color, which is the color used for all new sprites
and for many effects.

To define the current color
1 Click the Color Swatch.
2 In the Color Picker dialog box, select the True Color tab.
3 In Color Space, select RGB if it is not already selected.
4 In the Color ramp box, drag the pointer to a light purple. Move the point until the edit boxes for 

each color contain the following values: Red = 232, Green = 10, and Blue = 158.
Note      You can also enter the values in the boxes for Red, Green, and Blue.

5 Click OK.

Notice that the Color Swatch below the toolbox now is light purple. This indicates that light purple is 
the current color. Now you're ready to alter the colors of the flower sprites in a variety of ways using 
Image Composer.

The next topic in this tutorial is Enhancing Colors. If you want to take a break, save your composition 
now.



Enhancing Colors
{button ,AL("colorize"
)} Related Topics

You can change the colors of sprites by using the Color Enhancement tools on the Warps and 
Filters tool palette. These tools apply the current color to the selected sprite, shown in the following 
figure.

To colorize the sample sprites
1 Click the smallest daisy sprite.
2 On the toolbox, click Warps and Filters.
3 In the drop-down list, click Color Enhancement.
4 In the list box, click Colorize.
5 In the Color Opacity box, select the current value and type 60.
6 Click Apply. The figure below shows the result.
7 Repeat this procedure to make the smallest hibiscus a rich red but set the current color as follows: 

Red = 255, Green = 10, Blue = 14.

The smallest hibiscus sprite after being colorized

Before you enhance the smallest tulip sprite, set the current color to a bright yellow with the following 
settings: Red = 255, Green = 179, Blue = 0.

To tint the sample sprites
1 Click the smallest tulip sprite.
2 On the toolbox, click Warps and Filters.
3 In the drop-down list, click Color Enhancement.
4 In the list box, click Tint.
5 In the Color Opacity box, select the current value and type 50.
6 Click Apply. The following figure shows the result.

The smallest tulip sprite after being tinted

Experiment with different colors and different opacities to see the wide variety of colors you can add 
to a sprite.

Now you have a bunch of flowers of different sizes and colors, but they all still look like photographs. 
You can use the Art Effects provided by Image Composer to change this look. Before continuing, 
however, move the sprites away from the center of the Composition Guide.



The next topic is Using Art Effects. If you want to take a break, save your composition now.



Using Art Effects
{button ,AL("Art 
effects palette ovr")} 
Related Topics

The flower sprites that you have created and modified are all versions of the original photograph of 
each flower. Image Composer’s Art Effects can change all this with the click of a mouse button, as 
shown in the following figure.

You might want to consider showing some of the flower sprites in a different, more creative and 
artistic way. This portion of the tutorial illustrates how to apply three different effects using the Art 
Effects tool palette.

Note      If you are attempting to create a logo in the shortest possible time, you might want to skip this
frame of the tutorial and go on to the next topic, Creating a New Sprite.

To add Accented Edges to the sample sprites
1 Click the largest tulip sprite.
2 On the toolbox, click Art Effects.
3 On the Art Effects tool palette, in the drop-down list box, click Paint.
4 In the list box, click Accented Edges.
5 Click Apply.

Notice how the tulip sprite now looks like an artist’s rendering rather than a photograph.
6 Repeat this procedure for the large hibiscus sprite and the large daisy sprite.

The large hibiscus sprite with Accented Edges

The large daisy sprite with Accented Edges

Now you can apply additional art effects to the other flower sprites. You can create a temporary set of 
selected sprites, called a selection set, and apply the same effect to each of the sprites in one action. 
Before moving to the next procedure, click on a blank area in the Composition Guide to clear the 



selection.

To apply Crosshatch to a set of sprites
1 Press and hold SHIFT and click each of the medium-size flower sprites. This creates a selection set 

of sprites.
2 On the Art Effects tool palette, in the drop-down list, click Sketch.
3 In the list box, click Crosshatch.
4 Click Apply.
5 On the Edit menu, click Clear Selection to prepare to apply the next set of effects.

The following figures show the effects of Crosshatch on each of the medium-size flower sprites.

To apply Ink Outlines to a set of sprites
1 Press and hold SHIFT and click each of the small flowers. This creates a selection set of sprites.
2 On the Art Effects tool palette, in the drop-down list, click Sketch.
3 In the list box, click Ink Outlines.
4 Click Apply.
5 On the Edit menu, click Clear Selection to prepare to apply the next set of effects.

The following figures show the sprites before and after applying the effects.



Experiment by applying different Art Effects to each of the sprites until you are satisfied with the 
results. You will find a remarkable variety of effects to apply.

You now have created an interesting group of flower sprites. At this point, you need to create an 
organizing element for your logo.

The next topic is Part 2:    Creating the Logo Background and Name. If you want to take a break, save
your composition now.



Part 2: Creating the Logo Background and Name
{button ,AL("tutorial 
section overview")} 
Related Topics

In this portion of the tutorial, you will creating new sprites in Microsoft Image Composer. The topics in 
this part of the tutorial take you through the basics of creating a geometric shape, transferring a 
pattern to that shape, and then rotating and arranging that shape.



Creating a New Sprite
{button ,AL("geometr
y ovr")} Related 
Topics

Image Composer offers many ways to create sprites. For this topic, you need a solid shape as an 
organizing element. Later, you can texture it with a pattern from another sprite.

A background shape that is more horizontal than vertical will serve the greatest variety of uses. A 
curved shape will work well with the flowers, so here you will create an oval.

To begin this phase of the tutorial, move all the flowers off the Composition Guide.

To create an oval
1 On the toolbox, click Shapes.
2 On the Shapes tool palette, click Oval.
3 In the Opacity box, select the current value and type 100.
4 In the Composition Guide, drag to create an oval of 400 by 250 pixels. Monitor the size of the 

oval as you create it by watching the numbers in the right side of the status bar.
5 Click Render.

The next step is to add a texture to provide depth and visual interest to the background.

The next topic is Transferring Patterns from One Sprite to Another. If you want to take a break, save 
your composition now.



Transferring Patterns from One Sprite to Another
{button ,AL("sprite to
sprite how")} Related
Topics

One of Image Composer’s most powerful features is the ability to transfer patterns from one sprite to 
another. The Patterns and Fills tool palette can be used transfer pixel values from one sprite to 
another. Pattern operations require a source sprite to supply the values and a destination sprite to 
accept the values. The following figure illustrates how your oval will look after transferring a pattern 
from sprite supplied by Image Composer.

Before continuing, make sure that all flower sprites are off the composition guide. You will use a sprite
of clouds to add texture the oval sprite, but first you must insert the image, CLOUDS.TIF. For 
information on inserting a sprite, see Inserting Images.

When you insert the clouds, you see they are purple and small. Before moving to the next step, 
enlarge the cloud sprite.

To enlarge the clouds sprite
1 Click the cloud sprite.
2 Drag the lower right corner of the bounding box of the cloud sprite, extending it to cover the oval 

completely and extend well beyond it.

Now you can texture the oval, which is the destination sprite, with pixels from the cloud sprite, which 
is the source sprite. In order to perform this operation, the two sprites must overlap one another. 
Check to be sure that no part of the oval sprite is visible at the edges of the cloud sprite. Move the 
cloud sprite if necessary.

To transfer texture from the cloud sprite to the oval sprite
1 Click the oval.

Note      To select the oval, you may need to cycle through the stack. For information on cycling 
through the stack, see Selecting Sprites.

2 On the tool box, click Patterns and Fills.
3 On the Patterns and Fills tool palette, in the list, click Sprite to Sprite.
4 On the Sprite Texture Type drop-down list, click Transfer Full.
5 Click Apply.

A message box instructs you to select a source sprite.
6 Click the cloud sprite in a place outside the bounding box of the oval sprite.
7 Move the cloud sprite off the Composition Guide and delete it.
Now the oval is textured with purple clouds. Move the flower sprites onto the Composition Guide just
below the oval to begin the next step. You might create a row for each type of flower.

The next topic is Flipping Sprites. If you want to take a break, save your composition now.





Flipping Sprites
{button ,AL("A_ARR
ANGE_Arrange_Ove
rview")} Related 
Topics

Flipping sprites can provide more creative control over the balance of a composition. For example, if 
you have scanned in a sprite of a man facing one direction and you want him to face the other 
direction, you can flip the sprite to achieve this.

You can flip sprites horizontally, vertically, or both directions at once.

To flip the medium-size hibiscus sprite
1 Click the medium-size hibiscus.
2 On the Arrange menu, click Flip Horizontal.

The selected hibiscus in now facing the opposite direction, as shown in the following figure.

Experiment with flipping the daisies and the tulips.

The next topic is Rotating Sprites. If you want to take a break, save your composition now.



Rotating Sprites
{button ,AL("A_ARR
ANGE_Arrange_Ove
rview")} Related 
Topics

Now, all the sprites are facing straight up and down. To accentuate the shape of the background 
sprite, you can rotate several of the sprites.

Rotated tulip sprites

To rotate a tulip sprite interactively
1 Click the largest tulip sprite.
2 Move the pointer to the rotation handle in the upper right corner of the bounding box. The pointer 

changes from an arrow to an arrow with a circle.
3 Drag the rotation handle until the status bar reads 29 Deg (29 Deg from base).

In addition to rotating sprites interactively, you can also rotate a sprite by a specified angle.

To rotate the medium-size tulip sprite by a specified angle
1 Click the medium-size tulip sprite.
2 On the toolbox, click Arrange.
3 In the Rotation box, select the current value and type -30.
4 Click Apply.
5 Click the smallest tulip sprite and repeat the procedure, but type -55 in the Rotation box.

The next topic is Arranging Sprites. If you want to take a break, save your composition now.



Arranging Sprites
{button ,AL("A_ARR
ANGE_Arrange_Ove
rview")} Related 
Topics

Experimenting with arrangements is a pleasure in Image Composer. An important concept for 
arranging sprites is the stack. The stack is the order in which you created or added the sprites. The 
stack order is independent of the positions that sprites occupy. A sprite might be next to another sprite
on the composition guide, but not next to that sprite on the stack.

You can reorder the positions of sprites in the stack by using tools on the Arrange tool palette. You 
can arrange sprites independently or according to their relative positions in a composition.

To move the purple tulip in front of the oval sprite, relative to stack order
1 Click the purple tulip sprite and move it to the top of the oval sprite, just to the left of center. Notice 

that the tulip s[rote is behind the oval sprite.
2 On the toolbox, click Arrange.
3 On the Arrange tool palette, in the Order section, click the lower left question mark to reorder the 

sprite either ahead of the cloud sprite.
A hint message instructs you to move the pointer to the sprite behind which the current sprite is to 
be place.

4 Click the oval sprite.
The tulip sprite is now in front of the cloud sprite.

You can follow a similar procedure to arrange the rest of the flower sprites. You can move the oval 
sprite to the back of the stack by using the Send to Back command on the Arrange menu.

The current state of the logo

In order to arrange the flower sprites to resemble the finished logo design, you will need to alter the 
positions of several of the flower sprites. Arrange the flower sprites by moving them until the 
arrangement resembles the final version of the logo, or choose your own arrangement. When you 
have an arrangement that satisfies you, you can add the finishing touch to the logo: the business 
name.

The next topic is Creating Text Sprites. If you want to take a break, save your composition now.



Creating Text Sprites
{button ,AL("A_Over
view_of_Text_Sprite
s")} Related Topics

Text sprites are like any other sprites: you can move them, shape them, color them, texture them, and
apply any of Image Composer’s effects, tools, and filters.

To make the logo text to stand out against the brightly colored background, change the current color 
to white by setting the values for Red, Green, and Blue to 255. For information on setting the current 
color, see Defining the Current Color. The following figure shows grouped text sprites against the rest 
of the composition.

To select a font for the text sprite
1 On the toolbox, click Text.
2 On the Text tool palette, click Select Font.
3 In the Font list, select Times New Roman.
4 In the Font style list, click Bold Italic.
5 In the Size list, click 36.
6 Click OK.

Now that you have selected a font for your text sprites, you can enter the text.

To create the logo text sprites
1 In the Text entry box, type La Fleur and click Apply.

The first text sprite is now finished.
2 Move the text sprite to the top part of the flowered oval sprite.
3 Change the font size to 48.
4 In the Text entry box, delete the existing text and type d’Internet.
5 Click Apply.

Arrange the two text sprites against the background until you are satisfied. Because the text sprites 
are the same color as the composition guide, you need to click in the upper right corner of the 
Composition Guide to select them. Now, you will need to create a group that includes the two text 
sprites so you can apply the same changes to both sprites at the same time.

You can group sprites to apply effects to more than one sprite at a time. In addition, grouping sprites 
makes their relative positions permanent. You can ungroup the sprites later if you choose. When you 
are satisfied with the grouping, you can flatten the group, so that it becomes a single sprite. When a 
group has been flattened, you can continue to modify the grouped sprite as if it were any sprite, but 



you cannot reverse the Flatten command.

To group the text sprites
1 Click the first sprite.
2 Press and hold SHIFT and click the next sprite.
3 On the Arrange menu, click Group.

Be sure you are satisfied with the grouping before proceeding.
4 On the Arrange menu, click Flatten Selection.

To add crispness to the text, you can add a light outline.

The next topic is Adding Outlines to Sprites. If you want to take a break, save your composition now.



Adding Outlines to Sprites
{button ,AL("edge 
effect;outlines ovr")} 
Related Topics

An outline makes a sprite more distinct against a background.

To add an outline to the text sprite
1 Click the text sprite.
2 In the toolbox, click Warps and Filters.
3 In the effects drop-down list, click Outlines.
4 In the list box, click Edge.
5 In the Thickness box, select the current value and type 1.
6 In Edge Options, click the Color Swatch.
7 In the True Color tab, move the pointer to a deep bluish purple (Red = 29, Green = 1, and Blue = 

87), and click OK.
8 Adjust Opacity slider to 100.
9 In the Warps and Effects palette, click Apply.

To help the text stand out against the brightly colored background, you can add a drop shadow.

The next topic is Adding Drop Shadows to Sprites. If you want to take a break, save your composition
now.



Adding Drop Shadows to Sprites
{button ,AL("shadow 
effect;outlines ovr")} 
Related Topics

A shadow on a sprite adds depth to a composition.

The finished logo, including the drop shadows

To add a drop shadow to the text sprite
1 Click the text sprite.
2 On the Warps and Filters tool palette, click Outlines.
3 In the list box, click Shadow.
4 In the Shadow Options set the Offset x to 3 and the Offset y to 3.
5 In the Shadow Options group, click the Color Swatch.
6 Click the Eyedropper, move the eyedropper pointer to a purple flower and click.

This sets the color for the drop shadow, in this case a color from one of the flowers.
7 Click OK.
8 On the Warps and Filters tool palette, click Apply.

The logo is now complete.

Step back from your monitor and look at the logo with a critical eye. Now is the time to make any 
changes you feel are appropriate. Because this logo will be seen on Web sites, you might want to see
how it will look when viewed in 8-bit color.

The next topic is Part 3:    Preparing Your Logo for the Web. If you want to take a break, save your 
composition now.



Part 3: Preparing Your Logo for the Web
{button ,AL("tutorial 
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In this section of the tutorial, you will work with a custom color palette. Part 3 takes you through the 
basics of creating a custom color palette for your logo, viewing the logo in the custom color palette, 
and saving the logo in a web-ready file format. Part 3 contains three topics.

To begin Part 3, click Creating a Custom Color Palette.



Creating a Custom Color Palette
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You composed your finished logo in True Color, but it can be displayed in any of a wide variety of 
deliveries. For instance, Image Composer allows you to view your logo as it will look when displayed 
on a Web page. For best results, the logo should be saved to an 8-bit GIF file.

To view a composition in 8-bit color, you must create a custom palette.

To create a custom color palette for the logo
1 On the toolbox, click the Color Swatch.
2 Select the Custom Palette tab.
3 Click New.

The New Color Palette dialog box appears.
4 In the Palette name box, type Fleur8b as a name for your palette.
5 In the Palette Size drop-down box, click 236.
6 In the Dither by drop-down box, click Error Diffusion.
7 Click OK.
8 Click Generate Colors.
9 In the Number of colors drop-down box, click 236.
10 In the Generate from drop-down box, click Balanced Ramp.
11  Click Add.
12 In the Generate from drop-down box, click System Colors and click Add.

This added the system colors to include the 20 colors that Windows 95 works with.
13 Click Close.
14 On the Custom Palette tab, click OK.

Now that you have created an 8-bit palette, you can view your composition in the colors it will display 
on the Web. Your 8-bit palette has 256 colors, including the 236 colors you generated from your 
composition plus the 20 system colors.

The next topic is Viewing a Composition in a Custom Palette. If you want to take a break, save your 
composition now.



Viewing a Composition in a Custom Palette
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Now that you have created a custom palette, it is time to view the composition using that custom 
palette.

To view the logo in a custom palette
1 On the Window menu, click New Window.
2 In the Palette Type drop-down box on the toolbar, click Fleur8bt.

You now have two views of your logo, original True Color and 8-bit.
3 On the Window menu, click Tile.

Move one of the flowers. Notice that when you move an sprite in one window, it also moves in the 
other window. Click the title bar in each workspace window to choose a view. Notice that the palette 
type changes as you click each window.

You can make any adjustments you need to ensure that your logo appears on the Web exactly as you
want it to appear.

When you are satisfied with the logo, you should save it.

The next topic is Saving a Composition.



Saving a Composition
{button ,AL("A_MAN
AGING_Overview")} 
Related Topics

Saving an Image Composer composition is the same as saving any file in Microsoft Windows 95 and 
Windows NT.

To save the logo as an Image Composer composition
1 Click the original composition, not the custom palette version, in the first window.
2 On the File menu, click Save As.
3 In the Save As dialog box, choose the drive and folder into which you want to save your work.
4 In the Save as type drop-down box, click Image Composer Composition (*.MIC).
5 In the File name box, enter a unique name for the composition, such as fleurlog.mic.
6 Click Save.

You have saved the True Color version of your logo; now you can save the custom palette version.

To save the logo with the custom color palette
1 Click the window containing the 8-bit version of the composition.
2 On the File menu, click Save As.
3 In the Save As dialog box, choose the drive and folder into which you want to save your work.
4 In the Save as type drop-down box, click Compuserve GIF (*.gif).

Note      This format flattens the composition so that the sprites may no longer be manipulated as 
separate objects.

5 In the Color format drop-down box, click fleur8bt.
6 In the File name box, enter a unique name for the composition, such as flurlog8.gif.
7 Click Save.

Congratulations! You now have saved two versions of your logo. The first is an Image Composer 
composition in 24-bit color. You can use this version as a starting point for sending your composition 
to many different types of output. The second, 8-bit, version is suitable for posting to a Web site.



Edit Points
Allows you to reshape the last spline or polygon by moving control points. To move control points, 
click Edit Points, and then drag a point to a new location.



Recall Spline
Displays the outline of the last spline or polygon that was created and makes it editable.



Close
Specifies whether a spline curve is open or closed. If Close is selected, a spline curve is closed.



Fill
Specifies that the current spline or polygon is filled with the current color and opacity setting. Fill can 
be active only when Close is selected.



Spline Line Width slider
Adjusts the width of a spline.



Spline Line Width box
Specifies the width, in pixels, of the spline.



Opacity for Render, Extract, and Erase slider
Adjusts the level of opacity applied to the current sprite.



Opacity for Render, Extract, and Erase box
Specifies the percentage of opacity of a spline.



Hue slider
Adjusts the hue tolerance of the current sprite.



Whiteness slider
Adjusts the whiteness of the current sprite.



Blackness slider
Adjusts the blackness of the current sprite.



Hue box
Displays the percentage of hue that can be applied to the colors of the current sprite.



Whiteness box
Displays the percentage of whiteness that can be applied to the colors of the current sprite.



Blackness box
Displays the percentage of blackness that can be applied to the colors of the current sprite.



Add
Adds more pixels of the current pixel color to the generated sprite.



Delete
Subtracts new pixels that were added to the current sprite.



Local
Specifies that only the neighboring, connecting pixels to the point pixel are affected by changes to 
Color Lift.



Global 
Specifies that all the pixels in the current sprite are affected by Color Lift.



Feather box
Specifies the smoothing, or blurring, effect of the added pixels.



Redo Last button
Erases the last generated pixels, and then reselects the same point pixel using the current Color Lift 
settings.



Sticky
Maintains the current custom settings during multiple operations for the Rectangle, Oval, Spline, and
Polygon tools.



Rectangle
Creates a rectangular sprite on the Composition Guide.



Oval
Creates a round sprite on the Composition Guide.



Spline
Creates shapes with curved lines on the Composition Guide.



Polygon
Creates shapes with multiple straight lines on the Composition Guide.



Color Lift
Creates a new sprite by selecting a specified range of pixel color in an existing sprite and duplicating 
the shape of the selected pixels.




